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Introduction

SJSE Linux is an increasingly popular Linux distribution that competes head-
on with Red Hat’s Linux versions. SUSE Linux’s fortunes have been on the
rise following Novell’s acquisition of Germany’s SUSE Linux AG and the recent
initiation of the openSUSE project (www . opensuse. org) — an open source
project, sponsored by Novell, in which a community of developers, end users,
and other open source enthusiasts can participate and continue to evolve SUSE
Linux. The recent migration to the openSUSE community-based development
model has generated a distinct “buzz” around SUSE Linux as the up-and-coming
Linux distribution for everyone from home users to enterprise servers.

A significant factor in SUSE Linux’s increasing popularity is that unlike its
competitor Red Hat’s singular focus on the enterprise market, Novell contin-
ues to address both the enterprise market and Linux enthusiasts. Specifically,
the SUSE Linux open source software (OSS) is aimed at small-office/home-office
users as well as those wishing to experiment with the SUSE Linux as their
desktop system. The commercial version of SUSE Linux is sold as a boxed set
through distributors as well as online stores. SUSE Linux is a complete Linux
distribution, suitable for small office/home office or even an enterprise. This
book includes a DVD with SUSE Linux 10 OSS, with everything you need to
use it as a personal desktop system.

If you are starting out with SUSE Linux, you need a beginner’s guide that not
only gets you going with the installation and setup of SUSE Linux, but also
shows you how to use all the tools that come with your desktop. That’s why [
wrote SUSFE Linux 10 For Dummies in plain English, using a breezy style, that
quickly gets to the step-by-step instructions for accomplishing a task, be it
installing a printer or crafting a memo with OpenOffice.org Writer. My goal is to
minimize confusion and keep things as simple as possible. I present the essen-
tial steps for specific tasks, but avoid inundating you with too many details.

About This Book

SUSE Linux 10 For Dummies is a beginner’s guide for the upcoming SUSE Linux
distribution. The approach to the subject matter and the writing style is that
of the successful For Dummies series. The focus is on introducing you to the
SUSE Linux desktop with all the GUI tools, including the office productivity
suite (OpenOffice.org) and multimedia applications (audio player, digital
camera, CD burning, image editing, and so on). [ include a chapter on con-
necting to the Internet using cable/DSL modems and setting up a basic home
network because these have become necessities for anyone who has more
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than one PC and, especially, for those who plan to run SUSE Linux on a PC. I
also include a part that introduces the basics of routine system administra-
tion, how to add and update software, and how to tighten up the system’s
security.

Here are some of the things that this book shows you how to do:
v Install and configure SUSE Linux from the DVD-ROM included with

the book.

v Connect the SUSE Linux system to the Internet through a DSL or cable
modem.

v Set up dialup networking.
v Add a wireless Ethernet to your existing network.

v Get tips, techniques, and shortcuts for various uses of SUSE Linux,
such as

¢ Using the OpenOffice.org office suite
¢ Browsing the Linux file system
¢ Using Linux commands
¢ Using multimedia applications
v Understand the basics of system and network security.

v Perform system administration tasks.

Conventions Used in This Book

[ use a simple notational style in this book. All listings, filenames, commands,
and keywords are typeset in a monospace font for ease of reading. I italicize
the first occurrences of new terms and concepts, and then provide a defini-
tion right there. I show typed commands in boldface. The output of com-
mands and any listing of files are shown in a monospace font.

What Vou Don’t Have to Read

Each chapter zeros in on a specific task area — such as using the Internet or
preparing documents with OpenOffice.org — and then provides hands-on
instructions on how to perform a series of related tasks. You can jump right to
a section and read about a specific task. You don’t have to read anything but
the few paragraphs or the list of steps that relate to your question. Use the
Table of Contents or the index to locate the pages relevant to your question.
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You can safely ignore text next to the Technical Stuff icons as well as the side-
bars. However, if you are the kind who likes to know some of the hidden details
of how Linux works, by all means, dig in to the Technical Stuff and the sidebars.

Who Are Vou?

[ assume that you are somewhat familiar with a PC — you know how to turn it
on and off and you have dabbled a bit with Windows. Considering that most
new PCs come preloaded with Windows, this assumption is safe, right? And I
assume that you know how to use some of the Windows applications such as
Microsoft Office. Most of all, you want to either experiment with or switch to
SUSE Linux as your desktop of choice.

When installing SUSE Linux on your PC, you may want to retain your
Windows 2000 or Windows XP installations. | assume that you are willing to
accept the risk that when you try to install SUSE Linux, some things may not
quite work. Problems can happen if you have some uncommon types of hard-
ware. If you are afraid of ruining your system, try finding a slightly older
spare Pentium PC that you can sacrifice and then install Linux on that PC.

How This Book Is Organized

SUSE Linux 10 For Dummies contains 23 chapters organized into five parts. The
book’s organization is that of a typical For Dummies title that covers an operating
system such as SUSE Linux where the reader is expected to install the software
and then learn to use it. The five parts cover installation and setup, test driving
the system to learn the ropes, using the system to do productive work, learning
to be a budding system administrator, and the mandatory “Part of Tens.” Here’s a
quick overview of the five parts and the appendix:

v~ Part I: Getting to Know SUSE introduces the reader to SUSE Linux, pro-
vides step-by-step installation instructions, and explains what happens
when you start the system for the first time.

v~ Part II: Test-Driving SUSE is about getting started with SUSE Linux —
how to use the desktop and the file manager, how to connect to the
Internet (and set up a home network) — and figuring out what else is
there to play with.

v Part III: Doing Stuff with SUSE turns to doing day-to-day things with the
SUSE Linux system such as browsing the Web, reading e-mail and news-
groups and making IP phone calls, using the OpenOffice.org office suite
and some multimedia applications, and, finally, working with the com-
mand line shell.
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v Part IV: Becoming a SUSE Wizard includes chapters on the basic
system administration and security. In particular, Part IV explains how
to add new software and keep the SUSE system up to date with the YaST
(Yet another Setup Tool) installation/configuration tool and YaST Online
Update (YOU).

v Part V: The Part of Tens is the standard Part of Tens with chapters that
present ten frequently asked questions about SUSE, ten best things
about SUSE, ten great SUSE-related Web sites, and ten most commonly
used SUSE Linux commands.

v Appendix: About the DVD-ROM summarizes the contents of the book’s
companion DVD-ROM.

What's on the DUD?

The DVD contains SUSE Linux 10 from the openSUSE project. You may use the
DVD in accordance with the license agreements accompanying the software. To
find out more about the contents of the DVD, please consult the appendix.

Icons Used in This Book

Following the time-honored tradition of the For Dummies series, | use icons to
help you quickly pinpoint useful information. The icons include the following:
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The Remember icon marks a general interesting fact — something that I think
you might want to know and remember.

The Tip icon indicates things that you can do to make your job easier.

The Warning icon highlights potential pitfalls. With this icon, I'm telling you:
“Watch out! This could hurt your system!”

The Technical Stuff icon marks technical information that could be of interest
to an advanced user (or those of us aspiring to be advanced users).
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Sidebars

Sometimes | use sidebars to highlight inter-  before or give a little insight into a related topic.
esting, but not critical, information. Sidebars If you're in a hurry, you can safely skip the
explain concepts you may not have encountered  sidebars.

Where to Go from Here

It’s time to get started on your SUSE Linux adventure. Take out the DVD and
install SUSE Linux, following the instructions in Chapter 2. Then, turn to a rel-
evant chapter and let the fun begin. Use the Table of Contents and the Index
to figure out where you want to go. Before you know it, you’ll become an
expert at SUSE Linux!

[ hope you enjoy reading this book as much as I enjoyed writing it!
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In this part . . .

Fis part is all about getting you started on your way to
a lasting relationship with SUSE Linux. Before you can
begin your SUSE Linux experience, | spend a chapter
explaining what SUSE Linux is and what you can do with
SUSE Linux (pretty much anything you can do with a PC
that runs Windows).

To start using SUSE Linux, first you must install SUSE
Linux on your PC’s hard drive. SUSE Linux installation is
quite simple, and I explain everything in Chapter 2. In
Chapter 3 of this part, [ guide you through a quick tour of
SUSE Linux, primarily focusing on the key steps: booting
the system, logging in, using the KDE and GNOME desk-
tops, and shutting down the system.

The final chapter in this part gives you an overview of all
the applications in SUSE Linux — as a precursor to using
these applications to get some productive work out of
your SUSE Linux system.




Chapter 1

What Is SUSE Linux?

In This Chapter

Explaining what Linux is

Going over what SUSE Linux includes
Introducing you to what SUSE Linux helps you do
Getting started with SUSE Linux

Ibet you’ve heard about Linux, even if you may not know much about SUSE
(pronounced soo-za) Linux. Even if you haven’t, don’t worry: I'll explain
everything about Linux, what the different names like SUSE and Red Hat
mean, what SUSE Linux includes, and how to get started with SUSE Linux.

By the way, SUSE Linux runs on computers with Intel 80x86 and Pentium
processors (basically any PC that can run any flavor of Windows). If you have
a PC, you can install SUSE Linux on it and experience firsthand what the fuss
is all about.

Getting a Handle on Linux

You know that your PC is a bunch of hardware — things you can touch, like
the system box, monitor, keyboard, and mouse, as shown in Figure 1-1. The
system box contains the most important hardware of all — the central pro-
cessing unit (CPU), the microchip that runs the software (any program that
tells the computer how to do your bidding), which you actually can’t touch.
In a typical Pentium 4 PC, the Pentium 4 microprocessor is the CPU. Other
important hardware in the system box includes the memory (RAM chips) and
the hard drive — and one program has to run all this stuff and get it to play
nice: the operating system.
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|
Figure 1-1:
A simplified
view of a
computer
and how

it runs
computer
programs.
|

Memory

Transient storage where programs are loaded
and executed by the CPU

Output
Central Processing Unit (CPU)
The computer's brain—the microprocessor—that ——
executes the instructions contained in the program Input =0 —— @
loaded into memory - | — -

Disk
Permanent storage where programs are loaded
and data are stored in files

The operating system is software that manages all the hardware and runs other
software at your command. You, the user, communicate those commands by
clicking menus and icons or by typing some cryptic text. Linux is an operating
system — as are UNIX, Windows 98, Windows 2000, and Windows XP. The Linux
operating system — also called the Linux kernel — is modeled after UNIX.

The operating system is what gives a computer — any computer — its person-
ality. For example, you can run Windows 98 or Windows XP on a PC — and on
that same PC, you can also install and run Linux. That means, depending on
which operating system is installed and running at any particular time, the
same PC can be a Windows 98, Windows XP, or Linux system.

The primary job of an operating system is to load software (computer pro-
grams) from the hard drive (or other permanent storage) into the memory
and get the CPU to run those programs. Everything you do with your com-
puter is possible because of the operating system — so if the operating
system somehow messes up, the whole system freezes up. You know how
infuriating it is when your favorite operating system — maybe even the one
that came with your PC — suddenly calls it quits just as you were about to
click the Send button after composing that long e-mail to your friend. You try
the three-finger salute (pressing Ctrl+Alt+Del), but nothing happens. Then it’s
time to try the Reset button (provided your computer’s builders were wise
enough to include one). Luckily, that sort of thing almost never happens with
Linux — it has a reputation for being a very reliable operating system.

In technical mumbo jumbo, Linux is a multiuser, multitasking operating system.
This means that Linux enables multiple users to log in, and Linux can run
more than one program at the same time. Nearly all operating systems are
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Well, it runs on almost any computer. Let's family; Alpha AXPs; Sun SPARCs and
see. . . . Nowadays, you can get versions of UltraSPARCs; Hewlett-Packard’s HP PA-RISC;
Linux for systems based on Intel 80x86, Pentium, the PowerPC and PowerPC64 processors; the
and other Intel compatible processors; AMD’s  MIPS R4x00 and R5x00; even IBM mainframes.
64-bit AMDG64 processors; the Motorola 68000

Does Linux really run on any computer?
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multiuser and multitasking these days, but when Linux first started in 1994,
multiuser and multitasking were big selling points.

All the different names that you hear for Linux — SUSE, Red Hat, Debian,
Fedora, Knoppix, MEPIS, Ubuntu, Xandros, you name it — are actually the
names of different Linux distributions.

A Linux distribution is basically the Linux kernel (the operating system)
together with a huge collection of applications, along with an easy-to-use
installation program. By the way, most people just say Linux to refer to a spe-
cific Linux distribution.

Many different Linux distributions exist, and each includes the standard
Linux operating system and the following major packages:

v The X Window System: The graphical user interface.

1 One or more graphical desktops: Among the most popular are GNOME
and KDE.

v A collection of applications: Linux programs come in the form of ready-
to-run software, but the source code (the commands humans use to tell
the computer what to do) is included (or easily available), as is its
documentation.

Current Linux distributions include a huge selection of software — so
much that it usually requires multiple CD-ROMs or a single DVD-ROM
(which this book includes).

The development and maintenance of the Linux kernel, software packages in
a Linux distribution, and the Linux distributions themselves are organized as
open source projects. In a nutshell, open source means you have access to

the source code and the right to freely redistribute the software without any
restrictions. My succinct definition is pretty basic, so to find out more details
of what open source means and to see some acceptable open source licenses,
please visit the Open Source Initiative Web site at www . opensource. org.

11
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Discovering SUSE Linux

SUSE Linux is a commercial distribution that focuses on the desktop and
includes some proprietary components that prevent its redistribution. You
can buy SUSE Linux online or in computer stores and bookstores. If you have
heard about open source and the GNU (GNU’s not UNIX) license, you may
think that no one can sell Linux for a profit. Luckily for companies that sell
Linux distributions, the GNU (pronounced gah-nu) license — also called the
GNU General Public License (GPL) — does allow commercial, for-profit distri-
bution, but requires that the software be distributed in source-code form, and
stipulates that anyone may copy and distribute the software in source-code
form to anyone else. Several Linux distributions are available free of charge
under the GPL.

In August 2005, Novell sponsored and established the openSUSE project — a
worldwide community program for promoting the use of Linux everywhere.
Specifically, at www. openSUSE. org developers, end users, and other open
source enthusiasts can collaborate to evolve a freely available SUSE Linux
Open Source Software (OSS). Novell’s commercial SUSE Linux retail product
is based on SUSE Linux OSS. The retail SUSE Linux is similar to SUSE Linux
OSS except that the commercial version includes some packages that are not
open source or cannot be distributed freely. This book includes SUSE Linux
10.0 OSS from the openSUSE project.

[ tell you a lot more about SUSE in this book, but you can also visit www. suse.
com for more information (especially the latest news) about SUSE Linux.

Making sense of Linux version numbers

Both the Linux kernel and a Linux distribution such as SUSE Linux have their
own version numbers, not to mention the many other software programs
(such as GNOME and KDE) that come with the Linux distribution. The ver-
sion numbers for the Linux kernel and the Linux distribution are unrelated,
but each has particular significance.

Linux kernel version numbers

After Linux kernel version 1.0 was released on March 14, 1994, the loose-knit
Linux development community adopted a version-numbering scheme. Version
numbers such as 1.X.Y and 2.X.Y, where X is an even number, are considered
the stable versions. The last number, Y, is the patch level, which is incremented
as problems are fixed. For example, 2.6.13 is a typical, stable version of the
Linux kernel. Notice that these version numbers are in the form of three inte-
gers separated by periods — Major.Minor.Patch — where Major and Minor are
numbers denoting the major and minor version numbers, and Patch is another
number representing the patch level.
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Version numbers of the form 2.X.Y with an odd X number are beta releases
for developers only; they may be unstable, so you should not adopt such ver-
sions for day-to-day use. For example, when you look at version 2.7.5 of the
Linux kernel, the 7 in the minor version number tells you it’s a beta release.
Developers add new features to these odd-numbered versions of Linux.

You can find out about the latest version of the Linux kernel online at
www . kernel . org.

SUSE Linux version numbers

Each Linux distribution has a version number as well, and SUSE Linux is no
exception. These version numbers are usually of the form X. Y, where X is the
major version and Y the minor version. Unlike with the Linux kernel version
numbers, no special meaning is associated with odd and even minor versions.
Each version of a SUSE Linux includes specific versions of the Linux kernel
and other major components, such as GNOME, KDE, and various applications.

SUSE usually releases new versions of SUSE Linux on a regular basis — every
six months or so. For example, SUSE Linux 9.0 was released in October 2003,
9.1 was released in April 2004, 9.2 came out in October 2004, and 9.3 in April
2005. The current version of SUSE Linux is 10.0. Typically, each new major
version of SUSE Linux provides significant new features.

What's in SUSE Linux?
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A Linux distribution comes with the Linux kernel and a whole lot of software.
These software packages include everything from the graphical desktops to
Internet servers to programming tools to create new software. In this section,
[ briefly describe some major software packages that come bundled with
SUSE Linux. Without this bundled software, SUSE Linux wouldn’t be as popu-
lar as it is today.

When you install SUSE Linux, not all software packages are installed by
default. This book’s companion DVD, however, includes most of the packages
[ describe in the following sections.

GNU software

At the heart of SUSE Linux is a collection of software that came from the GNU
Project. You get to know these GNU utilities only if you use your Linux system
through a text terminal (or a graphical window that mimics one) — a basic
command line interface that puts nothing much on-screen but a prompt that
enables you to type in your commands. The GNU software is one of the basic
parts of any Linux distribution.

13
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The GNU Project

GNU is a recursive acronym that stands for
GNU’s not UNIX. The GNU Project was
launched in 1984 by Richard Stallman to develop
a complete UNIX-like operating system. The
GNU Project developed nearly everything
needed for a complete operating system except
for the operating system kernel. All GNU soft-
ware was distributed under the GNU General
Public License (GPL). GPL essentially requires
that the software is distributed in source-code

else in source-code form. Users may, however,
have to pay for their individual copies of GNU
software.

The Free Software Foundation (FSF) is a tax-
exempt charity that raises funds for work on the
GNU Project. To find out more about the GNU
Project, visit its home page atwww . gnu . org.
You can find information about how to contact
the Free Software Foundation and how to help

form and stipulates that any user may copy, i FLO et

modify, and distribute the software to anyone

As a Linux user, you may not realize the extent to which all Linux distributions
rely on GNU software. Nearly all the tasks you perform in a Linux system
involve one or more GNU software packages. For example, the GNOME graphi-
cal user interface (GUI) and the command interpreter (that is, the bash shell)
are both GNU software programs. By the way, the shell is the command-
interpreter application that accepts the commands you type and then runs
programs in response to those commands. If you rebuild the kernel or develop
software, you do so with the GNU C and C++ compiler (which is part of the
GNU software that accompanies Linux). If you edit text files with the ed or
emacs editor, you again use a GNU software package. The list goes on and on.

GUIs and applications

Face it — typing cryptic Linux commands on a terminal is boring. For average
users, using the system through a graphical user interface (GUI, pronounced
“gooey”) — one that gives you pictures to click and windows (with a small w)
to open — is much easier. This is where the X Window System, or X, comes to
the rescue.

X is kind of like Microsoft Windows, but the underlying details of how X works
are completely different from Windows. Unlike Windows, X provides the basic
features of displaying windows on-screen, but it does not come with any spe-
cific look or feel for graphical applications. That look and feel comes from
GUIs, such as GNOME and KDE, which make use of the X Window System.
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SUSE Linux comes with the X Window System in the form of X.Org X11 — an
implementation of the X Window System for 80x86 systems. X.Org X11 works
with a wide variety of video cards used in today’s PCs.

As for the GUI, SUSE Linux includes a choice of two powerful GUI desktops:
KDE (K Desktop Environment) and GNOME (GNU Network Model Environment).
You can choose to install either KDE or GNOME on your system. KDE and
GNOME provide desktops similar to those of Microsoft Windows and Apple
Mac OS. With GNOME or KDE, you can begin using your SUSE Linux system
without having to know cryptic Linux commands. However, if you ever need
to use those commands directly (or when you become a Linux expert and
want to use commands), all you have to do is open a terminal window and
type them at the prompt.

SUSE Linux also comes with many graphical applications. The most notewor-
thy program is The GIMP (GNU Image Manipulation Program), a program for
working with photos and other images. The GIMP’s capabilities are on a par
with Adobe Photoshop.

Providing common productivity software — such as word processing, spread-
sheet, and database applications — is an area in which Linux used to be
lacking. This situation has changed, however. SUSE Linux comes with the
OpenOffice.org office productivity applications. In addition, you may want to
check out these prominent, commercially available office productivity appli-
cations for Linux that are not included on the companion DVD-ROM:

v Applixware Office: This office package is a good example of productiv-
ity software for Linux. You can find it at www.vistasource. com.

v~ StarOffice: From Sun Microsystems (www.sun.com/staroffice),
StarOffice is another well-known productivity software package.

v CrossOver Office: From CodeWeavers (www.codeweavers.com/site/
products), you can use CrossOver Office to install your Microsoft
Office applications (Office 97, Office 2000, and Office XP) in Linux.

As you can see, plenty of Linux office applications are compatible with
Microsoft Office.

Networks

SUSE Linux comes with everything you need to use the system on a network
so that the system can exchange data with other systems. On networks, com-
puters that exchange data have to follow well-defined rules or protocols. A
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network protocol is a method that the sender and receiver agree upon for
exchanging data across a network. Such a protocol is similar to the rules you
might follow when you’re having a polite conversation with someone at a
party. You typically start by saying hello, exchanging names, and then taking
turns talking. That’s about the same way network protocols work. The two
computers use the protocol to send bits and bytes back and forth across the
network.

One of the most well-known and popular network protocols is Transmission
Control Protocol/Internet Protocol (TCP/IP). TCP/IP is the protocol of choice
on the Internet — the “network of networks” that now spans the globe. Linux
supports the TCP/IP protocol and any network applications that make use of
TCP/IP.

Internet servers

Some popular network applications are specifically designed to deliver infor-
mation from one system to another. When you send electronic mail (e-mail)
or visit Web sites using a Web browser, you use these network applications
(also called Internet services). Here are some common Internet services:

v Electronic mail (e-mail) that you use to send messages to any other
person on the Internet using addresses like joe@someplace. com.

v World Wide Web (or simply, Web) that you browse using a Web browser.

v News services, where you can read newsgroups and post news items to
newsgroups with names such as comp.os.linux.networking or
comp.os.linux.setup.

v File-transfer utilities that you can use to upload and download files.

v+ Remote login that you can use to connect to and work with another com-
puter (the remote computer) on the Internet — assuming you have the
required username and password to access that remote computer.

A SUSE Linux PC can offer these Internet services. To do so, the PC must be
connected to the Internet, and it must run special server software called
Internet servers. Each of the servers uses a specific protocol for transferring
information. For example, here are some common Internet servers that you
find in SUSE Linux:

v Sendmail: Mail server for exchanging e-mail messages between systems
using SMTP (Simple Mail Transfer Protocol).

v Apache Web server: For sending documents from one system to another
using HTTP (Hypertext Transfer Protocol).
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v vsftpd: FTP server for transferring files between computers on the
Internet using FTP (File Transfer Protocol).

v innd: News server for distribution of news articles in a store-and-forward
fashion across the Internet using NNTP (Network News Transfer Protocol).

v sshd: For securely logging in to the system using the SSH (Secure Shell)
protocol.

Software development

SUSE Linux is particularly well-suited to software development. Straight out of
the box, it’s not configured for software development, but you can easily install
all the necessary software-development tools such as the compiler and libraries
of code needed to build programs. If you happen to know UNIX and the C pro-
gramming language, you will feel right at home programming in Linux.

As far as the development environment in SUSE Linux goes, you can use the
same basic tools (such as an editor, a compiler, and a debugger) that you
might use on other UNIX workstations, such as those from IBM, Sun
Microsystems, and Hewlett-Packard (HP). What this means is that if you work
by day on one of these UNIX workstations, you can use a Linux PC in the
evening at home to duplicate that development environment at a fraction of
the cost. Then you can either complete work projects at home or devote your
time to writing software for fun and to share on the Internet.

Online documentation

As you become more adept at using Linux, you may want to look up informa-
tion quickly — without having to turn the pages of (ahem) this great book, for
example. Luckily, Linux comes with enough online information to jog your
memory in those situations when you vaguely recall a command’s name, but
can’t remember the exact syntax of what you're supposed to type.

If you use Linux commands, you can view the manual page — commonly
referred to as the man page — for a command by using the man command.
(You do have to remember that command in order to access online help.)

You can also get help from the GUI desktops. Both GNOME and KDE desktops
come with Help viewers to view online help information. In KDE, choose Main
Menu=>SUSE Help Center and in GNOME choose Help>User’s Manual from
the top panel (you learn the details in Chapter 3). You can then browse the
help information by clicking the links on the initial Help window. Figure 1-2
shows a typical Help window — this one from the KDE desktop.
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Figuring Out What You Can Do
with SUSE Linux

As an operating system, SUSE Linux acts as the intermediary through which
you, the “lord of the system,” control all the hardware and software in your
PC. The hardware includes the system box, the monitor, the keyboard, the
mouse, and anything else connected to the system box. The catchall term
peripheral refers to any equipment attached to the system. If you use a laptop
computer, all your hardware is packaged into the laptop.

Inside that system box is the system’s brain — the microprocessor (Intel
Pentium 4, for example) or the central processing unit (CPU) — that performs
the instructions contained in a computer program. When the microprocessor
is running a computer program, that program’s instructions are stored in the
memory or RAM. RAM stands for Random Access Memory (that means any
part of the memory can be accessed randomly — in arbitrary order).

The system box has another crucial component — the hard drive (or hard
disk, as it is sometimes called). The hard drive is the permanent storage
space for computer programs and data. It’s permanent in the sense that the
contents don’t disappear when you power off the PC. The hard drive is orga-
nized into files, which are in turn organized in a hierarchical fashion into
directories and subdirectories (somewhat like organizing papers in folders
inside the drawers of a file cabinet).

To keep a Linux system running properly, you or someone else has to make sure
that the hardware is working properly and that the files are backed up regularly.
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There is also the matter of security — making sure that only legitimate people
can access and use the system. These tasks are called system administration.

If you are using SUSE Linux at a big facility with many computers, a full-time
system administrator probably takes care of all system administration tasks.
On the other hand, if you are running SUSE Linux on a home PC, you are the
system administrator. Don’t let the thought frighten you. You don’t have to
know any magic incantations or prepare cryptic configuration files to be a
system administrator.

SUSE Linux includes a graphical configuration and setup tool called YaST that
makes system administration a “point-and-click” job, just like running any
other application. Incidentally, you first encounter YaST when you install
SUSE Linux following the directions in Chapter 2.

Disks, CD-ROMs, and DUD-ROMs

SUSE Linux typically comes on a single DVD-ROM or several CD-ROMs. After
installation, the Linux kernel and all the applications are stored on your hard
drive — which is where your PC looks first when you tell it to do something.

Typically, the hard drive is prepared to use SUSE Linux during the installation
process. After that, you usually leave the hard drive alone except to back up
the data stored there or (occasionally) to install new applications.

Using CD-ROMs or DVD-ROM s in SUSE Linux is easy. While you are logged in
at the GNOME or KDE desktop, just pop a CD or DVD in the drive, and the
system should automatically detect the DVD/CD-ROM. A graphical file man-
ager automatically opens and displays the contents of the DVD/CD-ROM. If all
else fails, you can type a simple mount command in a terminal window and
associate the DVD/CD-ROM with a directory on your system. This whole
process of accessing the files on a CD or a DVD from Linux is called mounting
the CD or the DVD.

Besides the hard drive and DVD/CD-ROM drive, of course, your PC may have
other drives, such as a floppy disk or Zip drive, and using those disks in
Linux is also simple: You insert a disk and double-click the icon that repre-
sents the disk drive on the GUI desktop. Doing so mounts the disk so that you
can begin using it.

Peripheral devices

Anything connected to your PC is a peripheral device, and so are some com-
ponents like sound cards that are installed inside the system box. You can
configure and manage these peripheral devices in SUSE Linux with YaST.

19
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One of the common peripherals is a printer, typically hooked up to the paral-
lel port of your PC. YaST includes a graphical printer configuration tool that
you can use to configure the printer.

Another peripheral device that needs configuration is the sound card. SUSE
Linux can detect and configure the sound card during installation, just as
Windows does. However, if SUSE Linux cannot detect the sound card cor-
rectly, you can use YaST to configure the sound card.

SUSE Linux configures other peripheral devices such as the mouse and key-
board at the time of installation. You can pretty much leave them alone after
installation.

Nowadays, PCs come with the USB (Universal Serial Bus) interface; many
devices, including printers and scanners, plug into a PC’s USB port. One nice
feature of USB devices is that you can plug them into the USB port and unplug
them at any time — the device does not have to be connected when you power
up the system. These devices are called hot plugs because you can plug in a
device when the system is hot, meaning while it’s running. SUSE Linux supports
many hot plug USB devices. When you plug a device into the USB port, SUSE
Linux loads the correct driver and makes the device available to applications.

SUSE Linux also supports Bluetooth, which is a low-power, short-range wire-
less technology for connecting devices to your PC. Devices that use Bluetooth
can usually connect when they are within 10 meters of one another. (To find
out more about Bluetooth, visit www.bluetooth.com.) If your PC includes
Bluetooth capability, you could use a wireless keyboard and mouse that con-
nect to the PC using Bluetooth. SUSE Linux supports such Bluetooth devices.

File systems and sharing

The whole organization of directories and files is called the file system. You can,
of course, manage the file system using Linux. When you browse the files from
the GNOME or KDE graphical desktop, you work with the familiar folder icons.

A key task in caring for a file system is to back up important files. In SUSE
Linux, you can use the tar program to archive one or more directories on a
floppy or a Zip drive. You can even back up files on a tape (if you have a tape
drive). If you have a CD/DVD burner, you can also burn a CD or a DVD with
the files you want to back up or save for posterity.

SUSE Linux can also share parts of the file system with other systems on a
network. For example, you can use the Network File System (NFS) to share
files with other systems on the network. To a user on the system, the remote
system’s files appear to be in a directory on the local system.

SUSE Linux also comes with the Samba package, which supports file sharing
with Microsoft Windows systems. Samba makes a Linux system work just like
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a Windows file or print server. You can also access shared folders on other
Windows systems on your network.

Networking

Now that most PCs are either in a local area network or connected to the
Internet, you need to manage the network as well. You set up the local area
network when you install SUSE Linux. For connecting to the Internet using a
modem, you can use YaST.

If you connect to the Internet using DSL (that’s the fast Internet connection
from the phone company) or a cable modem, you need a PC with an Ethernet
card that connects to the cable or DSL modem. It also means that you have to
set up a local area network and configure the Ethernet card. But fortunately,
these steps are typically a part of the SUSE Linux installation. If you want to
do the configurations later, you can — by using a GUI network configuration
tool accessible from YaST.

SUSE Linux also includes tools for configuring a firewall, a protective buffer
that helps keep your system relatively secure from anyone trying to snoop
over your Internet connection. You can configure the firewall by running a
GUI firewall configuration tool accessible from YaST.

Getting Started with SUSE Linux

Based on my personal experience in learning new subjects, | recommend a
three-step process to get started with SUSE Linux:

1. Install and configure SUSE Linux on your PC.
2. Explore SUSE Linux — the GUI desktop and the applications.
3. Use SUSE Linux for your day-to-day work.

In the following sections, I explain this prescription a bit more.

Install and configure SUSE Linux

Your PC probably came with some flavor of Microsoft Windows. So the first
step is to get SUSE Linux onto your PC. This book comes with SUSE Linux —
all you have to do is follow the instructions in Chapter 2 to install it.

Just to pique your curiosity, you can keep both Windows and SUSE Linux on
the PC; the SUSE Linux installer can split up the space on the hard drive into
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two parts — one part for Windows and the other for installing SUSE Linux.
During the SUSE Linux installation, you configure many items — from the net-
work card (if any) to the X Window System.

As you’ll find out for yourself, SUSE Linux installation is very easy, especially
with the graphical YaST installer.

After you install SUSE Linux, you can configure individual system compo-
nents (for example, the printer) and tweak any needed settings that aren’t
configured during installation.

You also can configure your GUI desktop of choice — GNOME or KDE. Each has
configuration tools. You can use these tools to adjust the look and feel of the
desktop (background, fonts, screen saver, and even the entire color scheme).

After you're through with the configuration step, all the hardware on your
system and the applications should run to your liking.

Explore SUSE Linux

With a properly configured SUSE Linux PC at your disposal, you can start
exploring SUSE Linux. You can begin the exploration from the GUI desktop
that you get after logging in.

Explore the GUI desktops — GNOME and KDE — and the folders and files that
make up the Linux file system. You can also try out the applications from the
desktop. SUSE Linux comes with office and multimedia applications and data-
bases that you can begin using.

Also try out the shell — open up a terminal window and type some Linux
commands in that window. You can also explore the text editors that work in
text mode. Knowing how to edit text files without the GUl is a good idea. At
least you won'’t be helpless if the GUI is unavailable for some reason.

Use SUSE Linux

After you explore the SUSE Linux landscape and know what is what, you can
then start using SUSE Linux for your day-to-day work — browsing the Web,
using Office applications such as a word processor and spreadsheet, listen to
music, burn a music CD, and anything else you want.

Of course, you can expect to become increasingly proficient in SUSE Linux as
time goes on. After all, learning is a lifelong journey:.

Bon voyage!



Chapter 2
Installing SUSE Linux

In This Chapter

Understanding the installation steps

Checking your PC’s hardware
Installing SUSE Linux
Configuring SUSE Linux

M ost PCs come with Microsoft Windows preinstalled, so you typically
never have to go through the Windows installation (except when
something goes wrong, of course). To run SUSE Linux, however, you first have
to install it on your PC. All you have to do to install SUSE Linux is take out the
DVD that comes with this book and follow the steps in this chapter.

You can install SUSE Linux in addition to Microsoft Windows and simply select
one or the other operating system after you power up the PC. The SUSE Linux
installer can shrink the disk space used by Windows and create a new disk
partition — basically set aside a part of the hard drive for SUSE Linux.

Before you get started, just take a deep breath and exhale slooowwwly. You
have nothing to worry about because I explain everything in this chapter.

Introducing the Installation Steps

Before getting started with the installation, I find it helpful to go over the
entire sequence of installation steps, without the gory details. In this section,
I show you the road map for the installation process. Then you can follow the
detailed steps and install SUSE Linux from this book’s companion DVD.
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Here are the general steps for installing SUSE Linux:

1

. Check your PC’s hardware to make sure everything works with

SUSE Linux.

. Make sure that your PC can boot from the DVD/CD-ROM drive.

You may have to get into SETUP and change the order of boot devices.

. Boot your PC from the DVD.

At the initial boot screen, use the arrow keys to select Installation and
press Enter. This starts SUSE’s graphical installer — YaST — that you
use to complete the installation.

. Select the installation language and then select New Installation.

YaST then gathers information about your PC and displays a set of instal-
lation settings.

. If you are going to add SUSE Linux to a PC that already has any ver-

sion of Microsoft Windows on the hard drive, edit the Partitioning set-
ting and select the hard drive as the location where you want to
install SUSE Linux.

Then YaST gives you the option to shrink the Windows partition. In par-
ticular, YaST can resize Windows XP partitions that use the NTFS file
system. When you resize the Windows partition, everything is safe until
you confirm that installation should begin.

. Edit any other installation settings.

In particular, you probably have to edit the time zone to suit your geo-
graphic location. You have to edit the software selection if you want a
GNOME desktop instead of the default KDE desktop.

. After you have finished editing the installation settings, accept the

selections and confirm that YaST should begin installing.

This is the point of no return. YaST formats the selected disk partition
and begins copying files from the DVD onto the hard drive.

. After installing a minimal SUSE Linux system, YaST reboots the PC.

After the initial version of SUSE Linux starts again, YaST guides you
through a number of configuration steps that include setting the root
(superuser) password; configuring the network and firewall; setting up
online updates of SUSE Linux; creating a normal user account; and con-
figuring hardware such as a graphics card, printer, and sound card.

. At the end of the installation, YaST reboots the PC. When SUSE Linux

runs again, you should get the GUI desktop.



Chapter 2: Installing SUSE Linux 25

Checking Your PC’s Hardware

If you are concerned that your PC may not be able to run SUSE Linux, here
are some of the key components in your PC that you need to consider before
you start the SUSE Linux installation:

v Processor: A 400 MHz Pentium II or better is best. The processor speed,
expressed in MHz (megahertz) or GHz (gigahertz), is not that important as
long as it’s over 400 MHz, but the faster the better. Linux can run on other
Intel-compatible processors such as AMD, Cyrix, and VIA processors.

v RAM: RAM is the amount of memory your system has. As with process-
ing speed, the more RAM, the better. You need 256MB to install both
SUSE Linux and to comfortably run a GUI desktop.

v DVD/CD-ROM: You must have a DVD/CD-ROM drive, and the PC must be
able to boot from that drive. The exact model doesn’t matter. What mat-
ters is how the DVD/CD-ROM drive connects to the PC. Most new PCs
have DVD/CD-ROM drives that connect to the hard drive controller
(called IDE for Integrated Drive Electronics or ATA for AT Attachment). If
you add an external DVD/CD drive, it most likely connects to the USB
port. Any IDE/ATA or USB DVD/CD-ROM works in SUSE Linux.

v Hard drives: Any IDE disk drive works in SUSE Linux. Another type of
hard drive controller is SCSI (Small Computer System Interface), which
SUSE Linux also supports. To comfortably install and play with SUSE
Linux, you need about 5GB of hard drive space.

1 Keyboard: All keyboards work with SUSE Linux and the X Window
System.

v Mouse: The installation program can detect the mouse. All types of mice
(such as PS/2 or USB) work with SUSE Linux and the X Window System.

v Video card: SUSE Linux works fine with all video cards (also known as
display adapters) in text mode, but if you want the GUI desktop, you
need a video card that works with the X Window System. The installer
can detect a supported video card and configure the X Window System
correctly. However, if the installer cannot detect the video card, it helps
if you know the make and model of your video card.

1 Monitor: The kind of monitor is not particularly critical except that it
must be capable of displaying the screen resolutions that the video card
uses. The screen resolution is expressed in terms of the number of pic-
ture elements (pixels), horizontally and vertically (for example, 1024 x
768). The installer can detect most modern monitors. If it does not detect
your monitor, you can select a generic monitor type with a specific
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resolution such as 1024 x 768. You can also specify the monitor by its
make and model (which you can find on the back of the monitor).

1 Network interface card (NIC): Not all PCs have network interface cards,
but if yours does, the installer can probably detect and use it. If you
have problems, try to find the make and model (such as Linksys
LNE100TX Fast Ethernet Adapter) so that you can search for information
on whether SUSE Linux supports that card or not.

v SCSI controller: Some high-performance PCs have SCSI controllers that
connect disk drives and other peripherals to a PC. If your PC happens to
have a SCSI controller, you might want to find out the make and model of
the controller.

v Sound card: If your PC has a sound card and you want to have sound in
SUSE Linux, you have to make sure it’s compatible. You can configure
the sound card after successfully installing SUSE Linux.

v Modem: If you plan to dial out to the Internet, you need a modem that
Linux supports. For software-based modems, called soft modems or win-
modems, you may have to download a driver from the manufacturer (it
may or may not be freely available).

In addition to this hardware, you also need to find out the make and model of
any printer you plan to use in SUSE Linux.

To check whether your PC’s hardware is compatible with SUSE Linux, visit
the SUSE Linux Hardware Database at hardwaredb. suse.de.

Installing SUSE Linux

The companion DVD includes SUSE Linux 10.0 Open Source Software (OSS)
from the openSUSE project. In this section, I describe the installation process
for the companion DVD, but the steps are similar if you were to install the
commercial version of SUSE Linux.

Booting your PC from the
DUD/CD-ROM drive

Most new PCs can boot directly from the DVD/CD-ROM drive, but some PCs
may require intervention from you. Typically, the PC may be set to boot from
the hard drive before the DVD/CD drive, and you have to get into SETUP to
change the order of boot devices. To set up a PC to boot from the DVD drive,
you have to go into SETUP as the PC powers up. The exact steps for entering
SETUP and setting the boot device vary from one PC to the next, but typically
they involve pressing a key such as F2. As the PC powers up, a brief message
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tells you what key to press to enter SETUP. When you’re in SETUP, you can
designate the DVD/CD drive as the boot device. After your PC is set up to
boot from the DVD/CD drive, simply put the DVD in the DVD/CD drive and
restart your PC.

Installing SUSE Linux from CDs or DUD

To install SUSE Linux from CDs or a DVD, simply insert the first CD or the
DVD into your PC’s CD/DVD drive and restart your PC (in Windows, choose
Start>Shutdown and then select Restart from the dialog box). If you are
using CDs, the installation steps are the same as that for the DVD except that
you have to swap CDs when prompted by the installation program.

After your PC powers up, a boot loader starts and displays an initial boot
screen with a menu of items. Table 2-1 lists these boot menu items and their
meaning. As you can see, you can perform a number of tasks from the boot
screen, including booting an existing installation from the hard drive and
starting a rescue system.

Table 2-1 SUSE Installer Boot Menu Items
Select This Item To Do This
Boot from Hard Disk Boot the PC from a previously installed operating

system from the hard drive.

Installation Automatically detect hardware and then begin
installing SUSE Linux.

Installation — ACPI Disabled Disable support for ACPI (Advanced Configuration
and Power Interface), but otherwise detect hard-
ware and start SUSE installation.

Installation — Safe Settings  Disable potentially troublesome features such as
ACPI, APM (Advanced Power Management), and
DMA (direct memory access) for IDE interface and
start installing SUSE. Select this option if the instal-
lation hangs with any of the other options.

Rescue System Start a small Linux system in memory so that you
can troubleshoot by logging in as root.

Memory Test Check to see if the PC’s memory has any problems.

Along the bottom of the SUSE installer boot screen, you see some information
about using the function keys F1 through F5. Table 2-2 explains what each of
these functions does.
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Initially the installer boot screen shows only F1, F2, and F3 as options along the
bottom of the screen. Press F3 to view all the function key shortcuts from F1
through F5. A Boot Options text box also appears after you press F3. After you
press a function key, a menu pops up; use arrow keys and press Enter to select
an option. Press Escape to get rid of the menu without selecting anything.

\\3

You can also provide other installer options — as well as Linux kernel options —
at the Boot Options text box below the boot menu. The installer options con-
trol some aspects of the installer’s behavior, whereas the kernel options are
passed to the Linux kernel that starts when you start the installation. Typically
you don’t have to provide any of these options to install SUSE Linux.

Table 2-2 Using Function Keys at the SUSE Installer Boot Screen
Press This Function Key To Do This

F1 Get context-sensitive help — help information
that depends on the currently selected item. Use
the up- and down-arrow keys to read the Help
screen and the left- and right-arrow keys to
jump between topics. You can dismiss the Help
screen by pressing Escape.

F2 Select the language and keyboard mapping to
be used by the boot loader.

F3 Select a screen resolution that you want the
YaST installer to use for its GUI. If the GUI
screen fails to appear, you can select Text Mode
for a text mode interface.

F4 Select the source from where you want to
install. The choices are CD or DVD, network
sources with different protocols such as FTP,
HTTP, NFS, and SLP (Service Location Protocol).
Typically you can leave this at its default choice
of CD or DVD.

F5 Update a driver module for new hardware for
which drivers may not be on the CD or DVD. You
will be prompted to insert the updated driver
module on a floppy or CD-ROM after you start
the installation.

P The installer initially picks a rather high screen resolution for the GUI screen
(typically, 1280 x 1024 pixels). To change the resolution, press F3, which
brings up a menu from which you can select other screen resolutions, such
as 1024 x 768 pixels.
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After setting the screen resolution by pressing F2, select Installation from the
boot menu and press Enter. This loads the Linux kernel from the DVD or CD.
The Linux kernel starts running the YaST installation program. For the rest of
the installation, you work with YaST’s GUI screens.

Starting the SUSE install in YaST

YaST — the SUSE installer — displays a GUI screen (see Figure 2-1) from
which you install SUSE Linux on your PC’s hard drive and configure it.
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LR
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The left-hand side of the YaST screen shows the list of installation steps, orga-
nized into three broad categories of tasks — Preparation, Installation, and
Configuration. An arrow marks the current step. For example, in Figure 2-1,
the arrow marks the language selection step. After the step is complete, YaST
displays a check mark next to the step.

On the right-hand side of the YaST screen (see Figure 2-1), you see the options
for the current step. You have to select options and then click Next to pro-
ceed to the next installation step. Click Back to return to the previous step.
You can abort the installation at any time by pressing the Abort key, up until
you confirm that you want to really proceed with the installation.
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") At any installation step, click Help at the lower-left corner of the YaST screen
(refer to Figure 2-1) to view context-sensitive help information for the current
step. The help appears on the left-hand side of the YaST screen. Press the
button again to return to view the list of installation steps.

Follow these steps to complete the initial installation steps in the YaST
installer:

1. Select the language to be used in the installed SUSE Linux system.
Then click Next.

YaST probes the hardware and loads driver modules. YaST may prompt
you to confirm that it should load some driver modules. Then YaST dis-
plays a Media Check screen that gives you a chance to check the instal-
lation media. Click Start Check to perform the check and click Next
when done. YaST displays the license agreement.

2. Read the license agreement and click the Yes button if you agree.
Then click Next to continue.

YaST prompts you to indicate if this is a new installation or an update.

3. Assuming that you are installing SUSE for the first time, select New
Installation and click Next.

YaST prompts you for the timezone (see Figure 2-2).
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|
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4.

Select your time zone and click Next.

You can also click Change to change the current time and date, but these
are usually correct. After this step, YaST prompts you (see Figure 2-3) to
select a GUI desktop environment — GNOME or KDE, or some other
options such as a minimal graphics environment or a text-mode system
that does not use GUI desktop. Your selection of the desktop environ-
ment determines what software packages YaST installs.

. Select the desktop you want and click Next.

YaST gathers information about the system and prepares a list of all the
installation settings, organized by category, and displays it in the
Installation Settings screen, initially in an Overview tab. Click the Expert
tab to see a complete listing of the settings (see Figure 2-2). Table 2-3
summarizes the installation settings categories as they appear in the
Expert tab. Remember to scroll down to see all the installation settings
in the screen shown in Figure 2-4. Note that YaST also displays a disk
partitioning setting.

v
v
v
v
-

-
.

LI ]

e Y] Desktop Selection
Language .
License Agreement
System Analysis
Tima Zone
Desktop Selection
Installation
Installation Summary
Perform Installation
Configuration
Root Password @ KDE
Netwaork KDE Is & powertul and infwultive desktop
Gnline Update anuironment that uses Kontact as Its maser
and Kongueror as Its browser and file manager.
- GNOME
Hardware Configuration
g GHOME |= & powerful and Intultive desktop K (X4
anuironment that uses Evolution as its maller,
Firefox as Its browser, and Nautius as Its
file manager
Other
Help Back Abort | Hext |




32 Part I: Getting to Know SUSE

Preparation

¥ language

License Agreement
System Analysis
Time Zone

LR S

Desktop Selection

Installation
=% Installation Summary
®  Perform Installation

Configuration

Root Password
Network

Online Update

Users

Clean Up

Relzase Nowes
Hardware Configuration

LR

(5 Installation Settings

Click any headiine to make changes or use the “Change..” menu below.

Cwerview |I:xpert |

System

* System: Compag Presario 061 - PC129A-ABA SA1L10NX NA4 30 (Ond1411RELOLGIOVALD)
* Processor. Intel{R] Celeron(R) CPU 2.53GHz
* Main Memory. TG0 MB

Keyboard Layout

* English [US]

Partitioning

* Format partition /dev/hdis (LO1%.7 MB) for swap

* Format partition /dev/hdiG (26.9 GE) for { with reiserts
* Set mount point of /devihdal to fwindows/C

* Set mount point of /devihdaZ to fwindows/D

* Use (devindaB a5 swap

* Set mount paint of /devihdil to fwindows/E

Software

* Standard Syster with KDE

* - KDF Desktop Environment

* 4 Help and Support Decumentation
* Size of Packages to Instal: 1.8 GB

Booting
* Boot Loader Type: GRUB

# Location: L. IDE, 37.2 GB, fdev/hda, WOC-WD400ES-11)EFO (MBR)

Change... =

Back Aboct

Installation Settings Categories

What These Settings Specify

|
Figure 2-4:
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Table 2-3
Category
System

Information about the PC’s hardware, including the
processor type and amount of memory.

Keyboard Layout

Language and layout of the keyboard.

Mouse

Type of mouse (for example, PS/2 mouse).

Partitioning

Information about the hard drive partitions that will be for-
matted and any partitions that would be mounted on the
Linux file system. If your hard drive has only Microsoft
Windows installed, YaST offers to shrink the Windows
partition and create other required partitions to install
SUSE Linux. If you already have other partitions besides
the Windows partition, YaST selects appropriate partitions
to use for SUSE Linux. You can then click the Partitioning
heading and from subsequent steps accept the proposal
or create a custom partition setup.

Software

What software YaST will install. This depends on what GUI
desktop — KDE or GNOME — you select at an earlier
installation step.
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|
Figure 2-5:
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Category

What These Settings Specify

Booting

Information about the boot loader that takes care of start-
ing Linux (as well as other operating systems, such as
Windows XP, that may be on the hard drive) when you
reboot the PC. The default is the GRUB boot loader,
installed on the hard drive’s master boot record (MBR).

Time Zone

Current time zone and date and time based on the selec-
tion you made at an earlier installation step.

Language

The language to be used by the installed SUSE Linux
system.

Default Runlevel

What processes Linux starts after booting. The default
runlevel is 5, which gives you a full multiuser system with
networks enabled and a graphical login screen.

6. Scroll down the list of installation settings and click a heading to view
the settings and make any changes.

If you are installing on a PC that had only Windows installed, the
Partitioning settings would suggest shrinking the Windows partition and
creating other partitions for SUSE Linux. You can usually accept the sug-
gested partitioning setup as is. To create your custom setup, click the
Partitioning section heading. YaST then displays the suggested partition-
ing, as shown in Figure 2-5.
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To create your own partition setup or modify the proposed partitions,
click the Create Custom Partition Setup radio button and click Next.
YaST displays a screen where you can select a hard drive to use for SUSE
Linux or select Custom Partitioning for complete freedom in specifying
the partitions. After you select Custom Partitioning and click Next, YaST
displays the Expert Partitioner screen (see Figure 2-6) where you can
edit the existing disk partitions any way you want. As the help text
emphasizes, this type of partitioning is intended for experts who know
what they are doing. There is, however, no harm in looking at the parti-
tioning information with the Expert Partitioner because nothing hap-
pens to the hard drive partitions until you confirm that you really want
YaST to proceed with the SUSE Linux installation.

Fartition your hard disks... = Expert Partitioner
This is intended for experts.
If you are familiar with the Dew =i r = " it start | E Used B Labal
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idevhdas 4.2 MB Linux native 2604 2690 fooat
Rsasa nogy Bkt mothing fewhdat 447 MR L native 2700 2705 foootl
:'“::I“':“f_:' a 7°"': ) /devhdaT 442 MB Linus native 2706 2711 Jonst
e entire toas SR devihdas  ABT2ZMB  Linux swap swep 2712 2777
e = Ideuhdad 55 GR Linux native 2778 3552 J
last installation dialeg. Until
B /deuhaalo 55 GB Linux native 3553 4327
that point, you can safely X K i PR .
abort the instaliation /devhaall 6.0 GB Linu native 4328 5168 i
fdehidt 1490 GB WOC-WO1E00|8-00GYCO 0 19456
For LVM setup, using a fdevhdnl 1024 GB HPFS/NTFS 013373
non-LyM root device and a fdevhan2 27968 Extended 13374 17020
non-LVM swap device is ddevhdnd 186 GB Linux native 17022 19456
recommended. Uther than Jdewhabs 10197 MB Linux swap swap 13374 13503
the raot and swap devices Jdewhaoé 269 GH  Lnuxnative 13504 17020
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7. After you have checked all installation settings, click Next.

YaST displays a warning dialog box that tells you that this is the point of
no return and you can commit to the installation by clicking Install or
return to the installation settings by clicking Back.

8. If you are certain that you want to continue with the installation, click

the Install button.

YaST then begins the installation, which includes formatting and preparing
the hard drive partitions and copying SUSE Linux files to the hard drive.
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|
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As YaST installs the software packages, it displays a slide show that intro-
duces various features of SUSE Linux. After the base installation is complete,
YaST installs the boot loader and reboots the system.

Completing the SUSE Linux configuration

After the initial SUSE Linux system boots, YaST starts again and guides you
through the remaining SUSE Linux installation and configuration steps, as
follows:

1.

Enter the password for the root user and click Next.

The root user is the administrator account that you can use to do any-
thing on the SUSE Linux system — from installing software to adding
new user accounts.

. Accept or change the network configuration.

YaST displays the current network settings (see the example in Figure 2-7).
If the settings are correct (usually it’s safe to assume that they are cor-
rect), you can simply click Next to continue.

. Test the Internet connection and update the system with the YaST

Online Update (YOU) service. Then click Next.
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4.

Select the user authentication method and click Next.

You can select local authentication based on passwords or network
authentication. For network authentication methods, you have to select
one of three network authentication methods — NIS (Network Informa-
tion System), LDAP (Lightweight Directory Access Protocol), or Samba
(Windows network). Typically, most PCs use local authentication method.
(Using this method simply means that the user accounts are authenti-
cated on the PC and not by checking with another server on the network.)

. Add a new local user by entering the username, password, and other

settings (Figure 2-8). Click Next to continue.

The Automatic Login check box is active if you are the only user on the
system and if you use KDE as the default desktop. If you mark the
Automatic Login check box (when it’s not grayed out), SUSE Linux auto-
matically logs in this user when it starts. Also, if you are the only user of
this system, mark the Receive System Mail check box. That way mail
intended for the root user would be delivered to your user account.
Some programs send mail to root with information about any errors or
problems. By receiving the system mail, you will be in the loop when it
comes to any important system messages.
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6.

Read the release notes and click Next.

The release notes contain last-minute information about the SUSE Linux
distribution, including any known problems and workarounds. It’s worth
glancing through so that you know about anything that might apply to
your PC’s hardware configuration. When you click Next, YaST detects all
of your PC’s hardware and displays a summary (Figure 2-9).

. Accept or change the displayed hardware configuration for your PC

(Figure 2-9) and click Next.

The hardware configuration includes information about specific hard-
ware such as your graphics card, monitor, sound card, printing system,
and so on. Typically, the displayed configuration should be acceptable,
but you should check each of the items. In particular, check the graphics
card configuration to see if YaST correctly detected the monitor and
graphics card. If not, you can make changes by clicking Graphics Cards
(see Figure 2-9) and changing the information in a subsequent window.
After the configuration steps are complete, YaST informs you that the
installation is complete, as shown in Figure 2-10.
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8. Click Finish to complete the installation.

The installer then reboots the system. If you are using the KDE desktop,
the system automatically logs you in using the local user account you
defined during installation. Otherwise, you see the graphical login
screen where you can log in to the system and start using it.

Congratulations! You can now start using SUSE Linux.



Chapter 3
Starting SUSE for the First Time

In This Chapter
Powering up SUSE Linux

Logging in

Checking out the GUI desktops
Playing with the shell

Shutting down

ou’re sitting in front of your PC about to turn it on. You know that the PC

has SUSE Linux installed. You’re wondering what to expect when you turn
it on and what you do afterward. Not to worry. If you’re using SUSE Linux for
the first time, this chapter shows you how to log in, check out the graphical
desktops, try out some cryptic Linux commands, and finally, shut down the PC.

If this quick tour of SUSE Linux seems hurried, don’t worry; I cover every-
thing at a slower pace and with more details in later chapters.

For those of you who already know something about SUSE Linux, flip through
this chapter to see if anything looks new. You never know what you may not
know!

Powering Up SUSE Linux

When you power up the PC, it goes through the normal power-up sequence
and loads the boot loader — called GRUB. The boot loader is a tiny computer
program that loads the rest of the operating system from the hard drive into
the computer’s memory. The whole process of starting up a computer is
called booting.

The GRUB boot loader displays a graphical screen with the names of the
operating systems that the boot loader can load. For example, if your PC has
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both Microsoft Windows and SUSE Linux installed on the hard drive, you see
both names listed. Use the up- and down-arrow keys to select the operating
system you want to use and press Enter. If the PC is set up to load SUSE Linux
by default, you don’t have to do anything — after a few seconds the boot
loader starts SUSE Linux.

You see a graphical boot screen that shows information about the progress of
the system startup. If you selected KDE as your desktop and enabled automatic
login during installation, you are automatically logged in and you get a KDE
desktop similar to the one shown in Figure 3-1. By the way, SUSE Linux logs you
in using the normal user account that you set up during installation. If you
selected GNOME as your desktop, then you are logged in to a GNOME desktop.

If Automatic Login is not enabled for any user, you get a graphical login
screen. You can log in using the account you defined during the installation.
Type the username and press Enter. When prompted for it, type the pass-
word and press Enter. You then see the initial GNOME graphical user inter-
face (GUI — pronounced gooey for short) appear.

You should not normally log in as root. When you log in as root, you could
accidentally damage your system because you can do anything when you’re
root. Always log in as a normal user. When you need to perform any task as
root, type su - in a terminal window and enter the root password. Graphical
system administration tools such as YaST prompt for the root password
when needed.

Getting GUI

When you install SUSE Linux, you can install one of two GUI desktops —
GNOME or KDE. I provide a quick look at both KDE and GNOME desktops in
this section.

Figures 3-1 and 3-2 provide a snapshot of KDE and GNOME desktops, respec-
tively. In these figures, I point out the major components of each desktop.
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v Panel: The panel is like the Windows taskbar. KDE has one at the bottom
of the screen, and GNOME has one at the top and one at the bottom. The
KDE panel and GNOME'’s top panel are the places where you can access
the main menu of applications and launch programs by clicking icons on
the panel. The panel also shows information such as the date and time
and what applications are currently running.

v Main Menu: This is the leftmost button on the KDE panel and GNOME'’s
top panel. It brings up the Main menu (see Figure 3-3), from which you
can start applications and perform other tasks such as lock the screen,
get help, switch users, or log out. In GNOME, the Main Menu is labeled
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Applications menu, and some of these options are in separate menus —
the Places menu and the Desktop menu.

v Desktop Icons: The desktops display the usual desktop icons — a My
Computer icon for browsing the contents of the computer, a Trash icon,
and icons for accessing devices such as a floppy drive and a CD/DVD
drive or CD writer. The KDE desktop also has an icon for browsing the
local Windows network, as well as icons for support, Print Manager, and
the OpenOffice.org office suite.

+ Home Folder: Opens your home directory in a graphical file manager.

+ Terminal Program: Runs a program that provides a terminal window
where you can type Linux commands.

v~ SUSE Help Center: Starts the SUSE Help Center, where you can get help
on various aspects of SUSE Linux.

1 Web Browser: Runs the Web browser.

v Personal Information Manager: Starts a mail, calendar, and contact
manager. GNOME desktop provides Evolution as the personal informa-
tion manager.

1 Desktop Pager or Workspace Switcher: Click on a square to bring up a
different desktop.

v Clipboard Tool: Click to see what has been cut and what you can paste
elsewhere.

v Power Management Tool: Right-click to view a menu that you can use to
start the YaST Power Management module that enables you to edit pow-
ersaver settings.

v Volume Control: Click to change the sound volume.

v SUSE Hardware Tool: Click to view information about devices in the PC
and configure them.

v SUSE Watcher: Click to open a window you can use to both check for
online updates as well as start online updates.

v Clock: Displays the current time. Clicking it brings up a calendar show-
ing the current date.

v Hide Panel: Available in KDE, the end-point of the panel serves as a
“hide panel” button, which means that if you click this icon, the panel
slides to the right and disappears. Click again, and the panel reappears.
You can hide the panel to create more room for other windows.

In addition to what you see on the KDE and GNOME desktops, you have many
more choices in the main menu that appears when you click Main Menu on
the panel. (See Figure 3-3.) Similar to the Windows Start button, the Main
Menu is where you start when you want to run an application.
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By the way, I refer to the menu selection shown in Figure 3-3 as Main Menu=>
Office>Document Viewer~>KGhostView. If you take a moment to compare the
notation with Figure 3-3, I hope you’d agree that it’s quite logical.

When you’re done exploring KDE or GNOME, log out. To log out of KDE,
choose Main Menu=Logout. In GNOME, choose Desktopr>Log Out. Select Log
Out from the subsequent dialog box and click OK to really log out.

Setting Up Printers

During SUSE Linux installation, the installer — YaST — can detect any printer
connected to your PC and provide you with the opportunity to configure the
printer. If you did not configure your printer during installation, you can do
so using YaST by following these steps:

1. Make sure that your printer is connected to the PC and powered on.

This step is necessary so that YaST can automatically detect the printer.

2. Choose Main Menu~>System=>Control Center (YaST) and enter the
root password when prompted to do so; then, click Hardware on the
left side of the YaST Control Center window.



Chapter 3: Starting SUSE for the First Time 45

The YaST Control Center displays information about various hardware
devices, as shown in Figure 3-4. As you can see, you can configure vari-
ous hardware devices, including printers, from YaST.
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Configure printers

3. Click Printer on the right-hand side of the window.

YaST opens the Printer Configuration window and displays information
about any printers that it detects, as shown in Figure 3-5.
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In this case, YaST has detected an Epson Stylus printer. If YaST has cor-
rectly detected your printer, click Next, and you're all done.

. If your printer is not detected, click Add.

YaST displays a list of printer connection types (see Figure 3-6) from
which you can select how your printer is connected to your PC (through
parallel, serial, USB, or network).

7+

Parallel, USB, Serial, =
IrDA, or Bluetooth
Printer

To configure a printer

connected locally, select the

ype of the local part to which
your printer is connected

CUPS Network
Server

Ta prinzwia a CUPS network
server, select PANE via CUPS

HNetwork Server.

LPD-Style Network
server

Ta print wia an LPD-style
nenwark server, select Print
win LPD-Style Network
Server.

SMB Network Server

Ta prins via @ Samba server or

— Printer Type

Srinter Type:
#) Parallel Frinter

USH Arinter
Serial Printer

IrD Printer
Bluetooth Frinter

Print via CUPS Network Server

Print via LPD-Styl= Network Server

Print yia SMB Network Server
Print via |PX Network Server

Frint Dirsctly to s Metwork Printer
Dther Setup

Windows, select Print via
SMB Network Server.

IPX Network Server
Ta print via a Navell Hetware [~

Back Aport Nest |

. Select your printer type and click Next.

YaST prompts for more information, depending on the printer type you
selected. For example, for a parallel printer, you have to identify the par-
allel port to which the printer is attached.

. Provide information about the printer connection and click Next.

YaST prompts for the printer queue’s name and other related information.

. Enter the name of the print queue as well as some descriptive infor-

mation about the printer and click Next.

YaST displays a list of printer makes and models.

. Select your printer’s make and model. Then click Next.

YaST displays the current configuration information so that you can test
the configuration or edit it.

. Review the configuration information and click OK.
10.

Click OK to save the settings and finish adding the printer.
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Managing DUDs and CD-ROMs

The KDE and GNOME GUI desktops make using DVDs and CD-ROMs in SUSE
Linux easy. Just place a DVD or a CD-ROM in the drive (I am assuming it’s a
data disc), click the My Computer icon on your desktop, and then click the
icon for the DVD/CD drive. The contents of the CD or DVD data disc then
appear in a GUI file manager window. If you insert a DVD movie into the DVD
drive, an appropriate multimedia program opens the DVD.

If you see a DVD/CD-ROM icon on the desktop, right-click that icon for a con-
text menu. From that menu, you can eject the CD or DVD when you are done.

Playing with the Shell

Linux is basically UNIX, and UNIX just doesn’t feel like UNIX unless you can
type cryptic commands in a text terminal. Although GNOME and KDE have

done a lot to bring us into the world of windows, icons, mouse, and pointer
(affectionately known as WIMP), sometimes you're stuck with nothing but a
plain text screen with a prompt that looks something like this (when I log in
with the username naba):

naba@linux:~>

You see the text screen most often when something is wrong with the X
Window System, which is essentially the machinery that runs the windows
and menus that you normally see. In those cases, your first reaction might be,
“What do I do now?” And the answer is that you have to work with the shell
and know some of the cryptic Linux commands.

You can prepare for unexpected encounters with the shell by trying out some

Linux commands in a terminal window while you're in the GNOME or KDE GUI.
After you get the hang of it, you might even keep a terminal window open, just
so you can use one of those cryptic commands simply because it’s faster than
pointing and clicking. (Those two-letter commands do pack some punch!)

Starting the bash shell

Simply put, the shell is the Linux command interpreter — a program that reads
what you type, interprets that text as a command, and does what the com-
mand is supposed to do.

Before you start playing with the shell, open a terminal window. In KDE, the
panel includes an icon that looks like a monitor covered by a sea shell (for a
shell, get it?). When you click that icon, a window with a prompt appears, like
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Figure 3-7:
You can
type Linux
commands
at the shell
promptina
terminal
window.
|

the one shown in Figure 3-7. That’s a terminal window, and it works just like
an old-fashioned terminal. A shell program is running and ready to accept
any text that you type. You type text, press Enter, and something happens
(depending on what you typed).

In GNOME, choose Applications=>System=>Terminal=>Gnome Terminal. That
should then open up a terminal window.

ession  Edit  View Bookmarks Settngs  Help

naba® ] inux: "> | -

B E

The prompt that you see depends on the shell that runs in that terminal
window. The default Linux shell is called bash.

Bash understands a whole host of standard Linux commands, which you can
use to look at files, go from one directory to another, see what programs are
running (and who else is logged in), and a whole lot more.

In addition to the Linux commands, bash can run any program stored in an

executable file. Bash can also execute shell scripts — text files that contain
Linux commands.

Understanding shell commands

Because a shell interprets what you type, knowing how the shell figures out the
text that you enter is important. All shell commands have this general format:

command optionl option2 ... optionN

Such a single line of commands is commonly called a command line. On a com-
mand line, you enter a command followed by one or more optional parameters
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(or arguments). Such command line options (or command line arguments)
help you specify what you want the command to do.

One basic rule is that you have to use a space or a tab to separate the com-
mand from the options. You also must separate options with a space or a tab.
If you want to use an option that contains embedded spaces, you have to put
that option inside quotation marks. For example, to search for two words of
text in the password file, I enter the following grep command (grep is one of
those cryptic commands used to search for text in files):

grep "SSH daemon" /etc/passwd
When grep prints the line with those words, it looks like this:
sshd:x:71:65:SSH daemon: /var/lib/sshd: /bin/false
If you created a user account in your name, go ahead and type the grep com-
mand with your name as an argument, but remember to enclose the name in
quotes. For example, here is how [ search for my name in the /etc/passwd

file:

grep "Naba Barkakati" /etc/passwd

Trying a few Linux commands

While you have the terminal window open, try a few Linux commands just for
fun. I guide you through some random examples to give you a feel for what
you can do at the shell prompt.

To see how long the Linux PC has been up since you last powered it up, type
the following (Vote: I show the typed command in bold, followed by the
output from that command.):

uptime

3:52am up 29 days 55:53, 5 users, load average: 0.04,
0.32, 0.38

The part up 29 days, 55:53 tells you that this particular PC has been up
for nearly a month. Hmmm . . . can Windows do that?

To see what version of Linux kernel your system is running, use the uname
command like this:

uname -srv
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This runs the uname command with three options -s, -r, and -v (these can
be combined as -srv, as this example shows). The -s option causes uname
to print the name of the kernel, -r prints the kernel release number, and -v
prints the kernel version number. The command generates the following
output on one of my Linux systems:

Linux 2.6.13-8-default #1 Tue Sep 6 12:59:22 UTC 2005
In this case, the system is running Linux kernel version 2.6.13.

To read a file, use the more command. Here’s an example that displays the
contents of the /etc/passwd file:

more /etc/passwd

root:x:0:0:root:/root:/bin/bash

bin:x:1:1:bin:/bin:/bin/bash

daemon:x:2:2:Daemon: /sbin: /bin/bash

lp:x:4:7:Printing daemon:/var/spool/lpd:/bin/bash
lines deleted ...

To see a list of all the programs currently running on the system, use the ps
command, like this:

ps ax

The ps command takes many options, and you can provide these options
without the usual dash (-) prefix. This example uses the a and x options —
the a option lists all processes that you are running, and the x option dis-
plays all the rest of the processes. The net result is that ps ax prints a list of
all processes running on the system, as shown in the following sample
output:

PID TTY STAT TIME COMMAND
12 S 0:01 init [5]
2 ? SN 0:10 [ksoftirgd/0]
32 S< 0:00 [events/O0]
4 ? S< 0:00 [Kkhelper]
9 2 S< 0:00 [kthread]
19 ? S< 0:00 [kacpid]
75 2 S< 0:02 [kblockd/0]
lines deleted ...

Amazing how many programs can run on a system even when only you are
logged in as a user, isn’t it?

As you can guess, you can do everything from a shell prompt, but it does take
some getting used to.
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Shutting Down

When you’re ready to shut down Linux, you must do so in an orderly manner.
Even if you're the sole user of a SUSE Linux PC, several other programs are
usually running in the background. Also, operating systems such as Linux try
to optimize the way that they write data to the hard drive. Because hard
drive access is relatively slow (compared with the time needed to access
memory locations), data generally is held in memory and written to the hard
drive in large chunks. Therefore, if you simply turn off the power, you run the
risk that some files aren’t updated properly.

Any user (you don’t even have to be logged in) can shut down the system
from the desktop or from the graphical login screen. In KDE, choose Main
Menur>Log Out. In GNOME, choose DesktopLog Out. A dialog box appears
(Figure 3-8 shows the example from the KDE desktop), providing the options
for restarting or turning off the system, or simply logging out. To shut down
the system, simply select Turn Off Computer (or Shut Down in GNOME), and
click OK. The system then shuts down in an orderly manner.

End Session for "naba"

|
Figure 3-8:
Shutting §
down your
SUSE Linux
system from

CL e AusEo 20,
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If you are at the graphical login screen, you can shut down the system by
selecting the shutdown option from the menus available at the login screen.

As the system shuts down, you see text messages about processes being shut
down. You may be surprised at how many processes exist, even when no one
is explicitly running any programs on the system. If your system does not
automatically power off on shutdown, you can manually turn off the power.

Note that shutting down or rebooting the system may not require root
access or even the need to log in to the system. This is why it’s important to
make sure that physical access to the console is protected adequately so that
anyone who wants to cannot simply walk up to the console and shut down
your system.
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Taking Stock of What's New

in SUSE

In This Chapter

Discovering the Internet applications

Introducing the office applications

Exploring the multimedia applications

Reviewing the images and graphics applications
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SUSE Linux comes with a whole lot of applications. All you have to do is
look at the menus on the GUI desktops to see what I mean. Often you find
more than one application of the same type. For example, in the KDE desktop,
you can take your pick from two Web browsers — Firefox and Konqueror.

Depending on the desktop — KDE or GNOME — that you installed by follow-
ing the steps outlined in Chapter 2, you get a different set of applications.
Both desktops include the OpenOffice.org office application suite with a word
processor, spreadsheet, presentation software, and more. You find many
choices for CD players and multimedia players, not to mention the games,
utility programs, and useful tools, such as a digital camera and image-editing
applications.

In this chapter, I provide a quick listing of some common SUSE Linux applica-
tions. After you get familiar with these applications, you can explore them
further and use them when you need them. I cover many of these applica-
tions in greater detail in Chapters 8 through 14.

[ mention only the default applications installed with each GUI desktop —
GNOME and KDE. You can, however, use YaST to find and install many more
applications. Chapter 17 provides an overview of YaST.



54 Part I: Getting to Know SUSE

Discovering the Internet Applications

Internet applications are for doing tasks such as browsing the Web, reading
and sending e-mail, reading newsgroups, and downloading files. From your
SUSE desktop — both KDE and GNOME — you can get to these applications
by selecting the Internet menu from the Main menu.

You get different sets of default Internet applications depending on whether
you installed the KDE or the GNOME desktop. Table 4-1 lists the default
Internet applications for GNOME and KDE desktops.

[ describe the Internet applications in detail in Chapters 8 through 11.

Table 4-1 Typical Internet Applications on
GNOME and KDE Desktops
Application Category GNOME Desktop KDE Desktop

Chat (instant messaging)  GAIM, Gnome Jabber, Xchat  Kopete

Web browser Firefox, Mozilla, Epiphany Konqueror

E-mail Novell Evolution KMail

News reader Pan KNode

RSS feed reader Blam Akregator
Videoconference GnomeMeeting, Linphone KPhone, Linphone

and IP telephone

Here’s what you can do with these applications:

v+~ Chat (instant messaging) applications enable you to communicate with
other people on the Internet — it’s like a phone call with many people at
the same time, only you type your messages instead of speaking.
America Online (AOL) provides a popular instant messaging (IM) service
called AIM. With the chat applications in SUSE, you can talk to people on
many different IM services such as AIM, ICQ, and Microsoft’s MSN. On
the GNOME desktop, you have a choice of several IM applications such
as GAIM, Gnome Jabber, and XChat. On the KDE desktop, use Kopete for
your IM needs.

v Web browsing applications are, well, for browsing the Web. On the
GNOME desktop, you can take your pick from three Web browsers —
Mozilla, Epiphany, and the up-and-coming Firefox with its reputation as
the “faster, better Web browser.”
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v E-mail applications are for sending and receiving electronic mail. You
need an e-mail account with an ISP to use these applications. If you
use the GNOME desktop, your best bet for an e-mail inbox is Novell
Evolution — a multipurpose application that integrates e-mail, calendar-
ing, to-do lists, and contact management in a single application. On the
KDE desktop, your e-mail client is KMail.

+” News readers enable you to read Usenet newsgroups, which are like bul-
letin boards where people post messages. Anyone can read and respond
to the messages. Like e-mail, you need access to your ISP’s server to
read newsgroups. The GNOME desktop provides the Pan news reader;
on KDE, use the KNode application to read newsgroups.

v RSS feed readers enable you to subscribe to the content of Web sites
and blogs that are made available in Really Simple Syndication (RSS)
format. The RSS format, which is a dialect of XML (extensible markup
language), is used for syndicating — gathering and making available —
content of Web sites, primarily news-oriented sites and blogs. RSS-
formatted content is called an RSS feed, and an RSS-aware program
can check the feed periodically for changes, download new items, and
make them available to the user. KDE comes with the Akregator RSS
feed reader. GNOME uses the Blam RSS reader from Imendio AB, a
small European company.

1 Videoconference and IP telephone applications are for making phone
calls and running videoconferences (think of videoconferences as “picture
phones” where you can see and be seen by other participants as you talk).
The GNOME desktop includes the GnomeMeeting videoconferencing
application. GnomeMeeting conforms to a standard called H.323, which
means it can work with other H.323-compliant videoconferencing software
such as Microsoft Netmeeting. Besides GnomeMeeting, the GNOME desk-
top also includes Linphone for making voice calls over the Internet. The
KDE desktop includes both KPhone and Linphone IP telephony applica-
tions.KPhone and Linphone conform to the Session Initiation Protocol
(SIP), which is widely used for voice over IP telephone calls.

Introducing the Office Applications

By office applications, | mean software for word processing, spreadsheets, pre-
sentations (briefing slides), calendars, and managing contacts. You can, of
course, think of the Internet applications — at least e-mail and Web browser —
as office applications as well, but | am differentiating between the applications
that need the Internet to work versus the ones you may use on stand-alone PCs.

Regardless of your desktop — KDE or GNOME — OpenOffice.org is the pri-
mary office application suite in SUSE Linux. OpenOffice.org includes several
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different applications for different tasks such as word processing, working
with spreadsheets, and preparing presentations. Table 4-2 summarizes the
office applications available in GNOME and KDE desktops.

[ describe the office applications in detail in Chapters 12 and 13.

Table 4-2 Typical Office Applications on
GNOME and KDE Desktops

Application Category GNOME Desktop KDE Desktop

Word processing OpenOffice.org Writer, OpenOffice.org Writer
AbiWord

Spreadsheet OpenOffice.org Calc, OpenOffice.org Calc
Gnumeric

Presentation OpenOffice.org Impress  OpenOffice.org Impress

Calendar/organizer Novell Evolution Kontact

Here is what you can do with the office applications:

1 Word processing applications are for preparing letters and reports and
any documents, including something as big as a book like this one. In
both GNOME and KDE desktops, you can use the OpenOffice.org Writer
for word processing. The nice thing about Writer is that it’'s compatible
with the popular Microsoft Word software from the Windows world.

v~ Spreadsheet applications are for creating — what else — spreadsheets.
The OpenOffice.org office suite includes the Calc application for prepar-
ing spreadsheets. Calc is compatible with Microsoft Excel.

v Presentation software enables you to prepare slides for briefing.
Perhaps the best-known presentation software is Microsoft PowerPoint.
The OpenOffice.org office suite comes with the PowerPoint-compatible
Impress presentation software.

v~ Calendar/organizer applications are for keeping track of your appoint-
ments and things to do. On the GNOME desktop, you can use the multipur-
pose Novell Evolution as the organizer, in addition to using it as your e-mail
inbox. The KDE desktop comes with the Kontact application to track your
calendar and to-do list. Kontact also incorporates the KMail mail reader.

Exploring the Multimedia Applications

Multimedia is audio, video, or both — as in a movie. Naturally, multimedia
applications are for listening to or watching music or movies, usually from
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digital files or some media such as CD or DVD. I also include in the multime-
dia category those applications related to creating multimedia, such as video
editors or CD/DVD burners. SUSE Linux comes with a good complement of
multimedia applications.

When it comes to playing multimedia — audio and video in various formats
such as MP3, MPEG, and QuickTime — freely available Linux distributions
(including SUSE Linux on this book’s companion DVD) rarely come with the
appropriate decoders because of licensing restrictions on some of these
decoders. The end result is that the multimedia application runs, but it can’t
play the MP3 file or the DVD movie because it lacks a decoder. Commercial
versions of SUSE Linux usually come with some of these decoders.

Table 4-3 summarizes typical multimedia applications in SUSE. I describe
some of these multimedia applications in detail in Chapter 14.

Table 4-3 Typical Multimedia Applications on
GNOME and KDE Desktops

Application Category GNOME Desktop KDE Desktop

CD player GNOME CD Player KsCD

CD ripper Grip

Audio player Rhythmbox amaroK, jukK

CD/DVD burner Gnome CD/DVD Creator  K3b

Video player (needs Totem Movie Player Kaffeine

separate decoders)

Video editor Kino

TV player (needs kdetv kdetv

TV card)

Here is a summary of what you can do with these multimedia applications:

v CD player applications enable you to play audio CDs on your SUSE
Linux system. All you have to do is pop an audio CD into the CD/DVD
drive and use one of these applications to play songs from the CD.

v CD ripper applications are for ripping (extracting) songs from audio CDs
and converting them to a digital format such as MP3. You can rip songs
from CDs and organize a digitized version of your CD collection. You can
play the MP3 files using an audio player application or by downloading
them into a portable MP3 player such as Apple iPod or other similar
products. To convert ripped songs into MP3 format, you need an MP3
encoder that is not included with SUSE Linux.
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v Audio player applications are used to play digital music stored in files in
various formats such as MP3 or Ogg Vorbis (a patent- and royalty-free
compressed audio file format). You can use amaroK as the audio player
in KDE and Rhythmbox in GNOME.

1+ CD/DVD burner applications enable you to use your CD/DVD-R (record-
able) drive to burn CDs or DVDs. With these applications you can typi-
cally burn audio CDs, data CDs and DVDs, as well as CDs or DVDs from
ISO image files. The GNOME desktop’s Nautilus file manager is capable
of burning CDs and DVDs.

v Video player applications are for playing movies stored in MPEG files as
well as playing DVD movies. Unfortunately, these applications need
decoders to decode the data from DVD movies or different format video
files. Such decoders for DVDs are not available for Linux.

v Video editors enable you to edit digital video files. The GNOME desktop
comes with the kino video editor, which can capture video over a
Firewire interface and provide the ability to edit the video.

v~ TV player applications enable you to watch a TV program on your SUSE
Linux desktop, provided your PC has a TV card (a hardware device capa-
ble of receiving TV signals) installed. Both KDE and GNOME desktops
offer the kdetv application as the TV player.

Cataloging the Image and
Graphics Applications

When I talk about images and graphics, [ mean applications that are meant to
work with photographs or other images and those that enable you to prepare
vector drawings — drawings consisting of lines and shapes — for use in vari-
ous types of documents. SUSE Linux includes a number of such image and
graphics applications. You can find these applications in the Main Menu>
Graphics menu.

Table 4-4 summarizes the image and graphics applications in GNOME and
KDE desktops. I describe these applications in detail in Chapter 15.

Table 4-4 Typical Image and Graphics Applications

on GNOME and KDE Desktops
Application Category GNOME Desktop KDE Desktop
Photo or image editor The GIMP The GIMP

Digital camera interface digikam
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Application Category GNOME Desktop KDE Desktop

Vector drawing Dia, Inkscape, OpenOffice.org Draw
OpenOffice.org Draw

Image viewer Eye of Gnome Gwenview

Fax viewer Kfax

PDF viewer Acrobat Reader, Acrobat Reader,

GNOME PDF Viewer Kghostview

PostScript viewer GGV PostScript Viewer ~ KGhostview

Here’s what the image and graphics applications enable you to do:

v~ Photo or image editor applications are for touching up photos as well
as creating and editing bitmap images in many different formats, includ-
ing popular ones such as JPEG, TIFF, BMP, and PNG. Both KDE and
GNOME desktops offer The GIMP as the photo and image editor applica-
tion. The GIMP can do whatever Adobe Photoshop can do, and it’s free!

v~ Digital camera interface is for connecting a digital camera to the SUSE
Linux system and downloading the photos from the camera. If the digital
camera application does not support your digital camera, you can usu-
ally access it as a USB storage device after you connect the camera to
the PC’s USB port using the cable supplied with the camera.

v Vector drawing applications enable you to draw using shapes such as
lines, curves, rectangles, and circles, and performing operations such as
filling shapes with colors or patterns. For example, if you are drawing the
plan for a room in your house, your best bet is to use a vector drawing
application. OpenOffice.org Draw is a popular vector drawing application.

+~ Image viewers are for viewing image files. The GNOME desktop comes
with the Eye of Gnome image viewer; the KDE desktop provides
Gwenview as the default image viewer.

v Fax viewers enable you to view faxes stored in files. The KDE desktop
offers the KFax application for viewing faxes.

v PDF viewer applications are for opening and reading PDF files. In both
KDE and GNOME desktops, you can use the Acrobat Reader to view PDF
documents.

v PostScript viewers enable you to view and print PostScript files.
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In this part . . .

A fter you have installed SUSE Linux, this part helps
you begin exploring and using SUSE Linux. First, I
take you on a quick tour of the GUI desktops — KDE and
GNOME. I explain the similar features of GNOME and KDE
and then focus primarily on the KDE desktop, which is the
default in SUSE. I devote a chapter to showing you how
you can locate files and applications in your system.

If I am not mistaken, you probably want your Internet
access as soon as possible. You can connect your SUSE
Linux system to the Internet in several different ways —
by using a dial-up modem or by cable or DSL. I explain the
steps in the final chapter of this part.




Chapter 5
Exploring the SUSE Desktops

In This Chapter
Discovering the common features of the GNOME and KDE GUIs
Introducing the KDE desktop
Getting familiar with the GNOME desktop

Wlen you install SUSE Linux following the steps I describe in Chapter 2,
you can choose to install one of two popular graphical desktops —
GNOME or KDE. GNOME and KDE are similar to Microsoft Windows, but they
are unique in one respect. Unlike Microsoft Windows, you can pick your desk-
top in SUSE Linux.

You can best figure out the KDE and GNOME desktops by simply starting to
use them. In this chapter, [ help you get familiar with key features of the desk-
tops. I start by introducing the common features of the two desktops and
then I briefly describe each desktop individually.

Discovering the Common Features
of the Desktops

From your perspective as a user, both KDE and GNOME probably seem simi-
lar because many features work similarly. Becoming familiar with these
common features is helpful so that you can rely on them no matter which
desktop you choose to use for your daily work.

For starters, the initial desktop for both KDE and GNOME looks like any other
popular GUI desktop, such as Microsoft Windows or Apple’s Mac OS desktop.
For example, Figure 5-1 and Figure 5-2, respectively, show typical KDE and
GNOME desktops.
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Both desktops (Figures 5-1 and 5-2) show icons for your computer, your
home folder, and the trash can for deleted files. Both desktops have some-
thing similar to the Windows taskbar. On the KDE desktop, the taskbar, called
the panel, appears along the bottom of the screen. GNOME has two such
panels — one on the top and the other on the bottom of the screen. Even
though the appearance may look slightly different, the panels serve the same
purpose on both KDE and GNOME desktops — they provide buttons for
accessing menus and starting applications, and they show buttons for any
applications you've started (or were automatically started for you).

In the case of the KDE desktop, both the menu buttons and information about
running applications appear on the same panel. On the GNOME desktop, the
top panel provides menus and buttons for starting applications, whereas the
bottom panel displays information about running applications.

Move the mouse over any icon on a panel, and a small pop-up window gives a
helpful hint about what you can do with that icon.

Desktop context menus

Both GNOME and KDE desktops display a context menu when you right-click
a clear area on the desktop. The exact contents of that menu depends on the
desktop, but it typically offers menu options that enable you to perform the
following types of tasks:

v Run a command

v Create a new folder

v Create a new document

v Configure the desktop background

1~ Rearrange the icons on the desktop

v Lock the screen (enter your password to unlock)

v Log out

The last two options are only available on the KDE desktop’s context menu.

For example, Figures 5-3 and 5-4, respectively, show the desktop context
menus in typical KDE and GNOME desktops. Desktop menu options with a
right-pointing arrow have other menus that appear when you put the mouse
pointer over the arrow.
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Icon context menus

Right-clicking any desktop icon in KDE or GNOME causes another menu to
appear. (See Figures 5-5 and 5-6.) Many items on this context menu are the
same no matter what icon you click — but right-clicking certain icons (for
example, the Trash icon) produces a somewhat different menu. You can per-
form the following typical tasks from icon context menus:

v Open a folder in a file manager

v Open a file with an application that you choose

v Rename the icon

v Move the icon to trash

v View the properties of that icon

O
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For the Trash icon, the icon context menu typically provides an option to per-
manently delete the items in the trash. (You get a chance to choose Yes or No.)

\P
) [ bet you see a pattern here. It’s the right-click. No matter where you are on a

GUI desktop, always right-click before you pick. You're bound to find some-
thing useful when you right-click!

The panels

The panel is the long bar that stretches across the bottom of the KDE desk-
top and both the top and bottom of the GNOME desktop. Figures 5-7 and 5-8
show typical views of the KDE and GNOME panels, respectively.
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The panel is a parking place for icons. Some icons open up menus from which
you can select applications to run and some icons start applications when
you click them. Some show the status (such as what programs are currently
running) as well as other useful information such as the date and time.

Starting at the left, the first icon (regardless of what it shows) in the KDE panel
and GNOME top panel is the Main Menu button — it’s like the Start button in
Microsoft Windows. Then come a few icons that start various programs. In
GNOME, you have more menu buttons — System Menu for system tasks such
as configuring the system or logging out and Help Menu for accessing online
help. The date and time icon appears at the far-right edge of the panel.

By the way, if you move the mouse pointer on top of an icon, a small Help bal-
loon pops up and gives you a helpful hint about the icon.

Now for a little bit of technical detail about these icons on the panel. The
panel itself is a separate application; each icon is a button or a program
called an applet. The applets are little applications (also called plugins).
These panel applets can do things such as launch other programs or display
the date and time. To add an applet to the panel, right-click an empty area of
the panel and select the appropriate menu item to add an applet to the panel.
After adding the applet, you can right-click the applet’s icon to configure it or
perform some task that the applet supports.

If you right-click any icon — or right-click anywhere on the panel — you get a
context menu where you can do something relevant to that icon (such as
move it or remove it entirely). You can also set some preferences and add
more buttons and applets to the panel.

The Main Menu or Applications Menu

The leftmost icon on the KDE panel and the GNOME desktop’s top panel is
the Main Menu button. On the GNOME top panel, the button is labeled
Applications.

The Main Menu is where you typically find all the applications, organized into
submenus. I provide an overview of the Main Menu and point out some inter-
esting items. You can then further explore the menus yourself.

Click the Main Menu button to bring up the first-level menu. Then mouse
over any menu item with an arrow to bring up the next level’s menu and so
on. You can go through a menu hierarchy and make selections from the final
menu. Figures 5-9 and 5-10, respectively, show the Main Menu hierarchies in
typical KDE and GNOME desktops.
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A word about the way I refer to a menu selection: I use the notation Main
Menu=Utilities=>Desktop=KSnapshot to refer to the menu selection shown
in Figure 5-9. Similarly, I say choose Main Menu=>Internet>Web Browser>
Firefox Web Browser to refer to the menu sequence highlighted in Figure 5-10.
You get the idea.

By the way, you could refer to the menu selection in Figure 5-10 as
Applications Menu=Internet=>Web Browser=>Firefox Web Browser — by
using the Applications Menu instead of the generic Main Menu as the name of
the top-level menu. I use the generic Main Menu because it helps discuss the
menu options in either the KDE or GNOME desktop. I don’t think you’ll ever
get confused once you have used either desktop for any length of time.

Notice in Figure 5-10 that when you point to a menu selection, a help balloon
pops up with information about that selection. That’s another helpful hint
from the GNOME desktop. These GUI desktops do try to make it easy on us
poor souls to navigate through the huge selection of menu choices!

The KDE Main Menu (refer to Figure 5-9) has three broad categories: Most
Used Applications shows the icons for applications you have used recently,
All Applications organizes the applications that you can access, and Actions
shows buttons for some common daily tasks such as locking the screen, run-
ning a command, or logging out. You should browse the All Applications cate-
gory to familiarize yourself with what SUSE has to offer as a desktop
operating system.

The GNOME desktop arranges the menus a bit differently. GNOME’s top panel
(see Figure 5-10) provides three separate menus — the Applications Menu (or
Main Menu) lists the applications by category; the Places Menu has options
for opening your home folder, viewing the desktop, browsing the computer,
connecting to various servers such as FTP and Windows shares, and search-
ing for files; and the Desktop Menu is for editing desktop preferences, config-
uring system settings, getting online help, locking the screen, and logging out.

On both KDE and GNOME desktops, the applications listed in the top-level
Main Menu are arranged in the following types of menu categories:

v Games: A menu of, what else, games (and quite a few of them at that —
such as card games, board games, puzzles, and arcade games).

v Graphics: Programs such as The GIMP (an Adobe Photoshop-like pro-
gram), a digital camera interface, and an Adobe Acrobat PDF file viewer.

v~ Internet: Internet applications, such as the Web browser, e-mail reader,
Usenet news reader, and Instant Messenger.

v Multimedia or Sound & Video: Multimedia applications such as CD
player, MP3 player, CD/DVD burner, video player, sound recorder, and
volume control.
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v Office: Office applications such as the OpenOffice.org office suite
(includes Writer word processor, Calc spreadsheet, Impress slide pre-
sentation program, Draw drawing program, and much more).

v Preferences or Settings: Options to configure many aspects of the
system, including the appearance and the behavior of the desktop.

v System: System administration tools such as YaST for configuring your
SUSE Linux system.

v~ Utilities: Lots of utility programs, such as a scientific calculator, text
editor, print manager, screen capture, file upload via Bluetooth connec-
tion, Palm Pilot or Handspring sync, and so on.

KDE’s Main Menu and the Places and Desktop menus in GNOME's top panel
typically also have a few menu items for some commonly performed tasks
such as the following:

v SUSE help-center displays online help.

+* Run Command displays a dialog box where you can enter the name of a
program to run and then click Run to start that program.

v Find Files (or Find Files) runs a search tool from which you can search
for files.

v Lock Screen starts the screen saver and locks the screen. When you want
to return to the desktop, the system prompts you for your password.

v Logout logs you out. (You get a chance to confirm whether you really
want to log out or not.)

The menus in KDE and GNOME are somewhat different, but the menu organi-
zation is logical enough that you can usually find what you need.

Okay. That’s all I'm telling you about the Main Menu. You’ll use the Main
Menu a lot as you use KDE or GNOME desktops. Even if it seems too much ini-
tially, it’ll all become very familiar as you spend more time with SUSE Linux.

Exploving KDE

KDE (pronounced Kay-dee-ee) is the default GUI for SUSE Linux. KDE stands for
the K Desktop Environment. From your perspective as a user, KDE provides a
graphical desktop environment that includes the Konqueror Web browser and
file manager, a panel with menus for starting applications, a help system, con-
figuration tools, and many applications, including the OpenOffice.org office
suite, image viewer, PostScript viewer, and mail and news reader programs.
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If you want to keep up with KDE news, you can always find out the latest
information about KDE by visiting the KDE home page at www.kde.org.

If you installed the KDE desktop, you see an initial KDE desktop similar to the
one shown in Figure 5-1. The initial KDE session includes a window showing a
helpful tip.

You will find that KDE is very easy to use and is similar in many ways to the
Microsoft Windows GUI. You can start applications from a menu that’s similar
to the Start menu in Windows. As in Windows, you can place folders and
applications directly on the KDE desktop.

You can move and resize the windows just as you do in Microsoft Windows.
Also, as in the window frames in Microsoft Windows, the right-hand corner of
the window’s title bar includes three buttons. The leftmost button reduces
the window to an icon, the middle button maximizes the window to fill up the
entire screen, and the rightmost button closes the window.

KDE panel

The KDE panel (refer to Figure 5-7) appearing along the bottom edge of the
screen is meant for starting applications. The most important component of
the panel is the Main Menu button — the one with the cute gecko logo — on
the left side of the panel. That button is like the Start button in Windows.
When you click the Main Menu button, a menu appears. From this menu, you
can get to other menus by moving the mouse pointer over items that display
a right-pointing arrow.

You can start applications from the Main Menu. That’s why the KDE docu-
mentation calls the Main Menu button the Application Starter (the KDE docu-
mentation refers to the button itself as the K button).

Next to the Main Menu button, the panel includes several other buttons. If
you don’t know what a button does, simply move the mouse pointer over the
button; a small pop-up window displays a brief message about that button.

Customizing the KDE desktop

KDE makes customizing the look and feel of the KDE desktop easy. Everything
you have to decorate the desktop is in one place: the KDE Control Center. To
start the KDE Control Center, choose Main Menu=>Control Center.

When the KDE Control Center starts, it displays the main window with a list
of items on the left side and some summary information about your system in
the workspace to the right, as shown in Figure 5-11.
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The KDE Control Center’s left-hand side shows the items that you can cus-
tomize with this program. The list is organized into categories such as
Appearance & Themes, Desktop, Internet & Network, KDE Components,
Peripherals, Security & Privacy, Sound & Multimedia, System Administration,
and so on. Click an item to view the subcategories for that item. Click one of
the subcategory items to change it. That item’s configuration options then
appear on the right side of the Control Center window.

To change the desktop’s background, click Appearance & Themes, and then
click Background. The right side of the Control Center (see Figure 5-12)
shows the options for customizing the desktop’s background.
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If you want to change the background of a specific desktop, click the Setting
for Desktop drop-down list. From the list of desktops, you can select the
desktop whose background you want to change.

For a colored background, select the No Picture radio button. From the
Colors drop-down list, you can select either a single color background or a
variety of color gradients (meaning the color changes gradually from one
color to another) or a picture (an image used as a background). You can then
pick the two colors by clicking the color buttons that appear under the
Colors drop-down list. After making your selections, click Apply to try out the
background. (If you don’t like what you get, click Reset to revert back to the
previous background.)

The default KDE desktop uses a picture as the background. If you want to use
a different picture as background, select the Picture radio button and then
click the folder icon next to that radio button. A dialog box comes up, show-
ing the JPEG images in the /usr/share/wallpapers directory. You can
select any one of these images or pick an image from another directory and
click OK. Then click the Apply button in the KDE Control Center to apply this
wallpaper to the desktop. If you don’t like the appearance, click Reset.

Getting to Know GNOME

GNOME (pronounced Guh-NOME) is another GUI for SUSE Linux. The
acronym GNOME stands for GNU Network Object Model Environment (and
GNU, as you probably know, stands for GNU’s not UNIX). GNOME is a graphi-
cal user interface (GUI) and a programming environment. From the user’s
perspective, GNOME is like Microsoft Windows. Behind the scenes, GNOME
has many features that allow programmers to write graphical applications
that can work together well. In this chapter, [ point out only some key fea-
tures of the GNOME GUI, leaving the details for you to explore on your own at
your leisure.

If you're curious, you can always find out the latest information about
GNOME by visiting the GNOME home page at www . gnome . org.

If you installed GNOME as your desktop, you see the GNOME GUI desktop
(refer to Figure 5-2) after you log in. The GNOME desktop is very similar to
the Windows desktop albeit with two taskbars — one at the top and the other
at the bottom of the screen, and icons for folders and applications appear
directly on the desktop.
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The GNOME panels

The GNOME panels are key features of the GNOME desktop. In the default
configuration, the desktop has one panel at the top and the other along the
bottom of the screen. You can simply drag and move the panels to any edge
of the screen, but it’s best to leave them alone. When you drag the panel to a
side, the panel’s size changes, and the icons can get enlarged. That makes it
hard to access the menus.

Think of the top GNOME panel as your gateway to the things you can do.
From the menus and buttons on that panel you can start applications. Think
of the bottom panel as information about the things you have done so far. For
example, the bottom panel shows buttons corresponding to applications that
you have started so far.

Figure 5-8, earlier in this chapter, shows a typical top panel that shows
menus, application launcher buttons, and small panel applets. Each panel
applet is a small program designed to work inside the panel. For example, the
Clock applet on the panel’s far right displays the current date and time.

The GNOME desktop’s top panel (refer to Figure 5-8) has three menu buttons —
Applications, Places, and Desktop — at the left edge:

v Applications Menu has the menu of applications, organized by category.
I refer to the Applications Menu as the Main Menu because this is the
primary menu for starting applications.

v Places Menu has options for opening your home folder, viewing the
desktop, browsing the computer, connecting to various servers such as
FTP and Windows shares, and searching for files.

v Desktop Menu has the menu for system configuration and performing
tasks such as getting online help and logging out or locking the screen.

The buttons to the right of the menu buttons are launcher applets. Each of
these applets displays a button with the icon of an application. Clicking a
button starts (launches) that application. Try clicking each of these buttons
to see what happens. Move the mouse over a button and a small Help mes-
sage appears with information about that button. That’s how you can easily
tell what each button does.

Customizing the GNOME desktop

By now, you may be itching to do a bit of decorating. After all, it’s your desk-
top. You can set it up any way you want it. To change the GNOME desktop’s
background, right-click on an empty area of the desktop and select Change

75
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Desktop Background from the menu that appears. The Desktop Background
Preferences dialog box appears, as shown in Figure 5-13.
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From this dialog box, you can select a background of a solid color, a color
gradient, or a wallpaper (an image used as the background). A color gradient
background starts with one color and gradually changes to another color.
The gradient can be in the vertical direction (top to bottom) or horizontal
(left to right).

Just for the fun of it, if you want to try out a horizontal color gradient, follow
these steps:

1. Scroll up the Desktop Wallpaper list (refer to Figure 5-13) and select
No Wallpaper from the very top.

2. Click the Desktop Colors item, and from the drop-down list, choose
the Horizontal Gradient option.

3. Click the Left Color button next to the drop-down list.

The Pick a Color dialog box comes up (shown in Figure 5-14) from which
you can select a color.
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4. Repeat the same process to select the right color.
After you complete these steps, the desktop shows the new background color.

To revert back to the original wallpaper, scroll down in the Desktop Wallpaper
list (refer to Figure 5-13) and select the previous wallpaper image (or pick a
different wallpaper, if that’s what you want).

Click Close to get rid of the Desktop Background Preferences dialog box.
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Chapter 6
Finding and Organizing Files

In This Chapter

Understanding how Linux organizes files

Navigating the file system with Linux commands
Understanding file permissions

Manipulating files and directories with Linux commands

T) use files and directories well, you need to understand the concept of a
hierarchical file system. Even if you use the GUI file managers to access
files and folders (folders are also called directories), you can benefit from a

file system that gives you the lay of the land.

In this chapter, I introduce you to the Linux file system, and you discover
how to work with files and directories with several Linux commands.

Figuring Out the Linux File System

As with any other operating system, Linux organizes information in files and
directories. Directories, in turn, hold the files. A directory is a special file that
can contain other files and directories. Because a directory can contain other
directories, this method of organizing files gives rise to a hierarchical struc-
ture. This hierarchical organization of files is called the file system.

The Linux file system gives you a unified view of all storage in your PC. The
file system has a single root directory, indicated by a forward slash (/).
Within the root directory is a hierarchy of files and directories. Parts of the
file system can reside in different physical media, such as a hard drive, floppy
disk, and CD-ROM. Figure 6-1 illustrates the concept of the Linux file system
(which is the same in any Linux system whether it’s SUSE, Red Hat, or what
have you) and how it spans multiple physical devices.
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If you're familiar with MS-DOS or Windows, you may find something missing
in the Linux file system: You don’t find drive letters such as C: and D: in
Linux. All disk drives and CD-ROM drives are part of a single file system.

In Linux, filenames can be long (up to 256 characters) and are case-sensitive.
Often these filenames have multiple extensions, such as sample.tar.?Z.
UNIX filenames can take many forms, such as the following: index.html,
Makefile, XF86Config.install.old, vsftpd-2.0.1-2.1386.rpm,
.bash_profile, and apache2_src.tar.gz.

To locate a file, you need more than just the filename. You also need informa-
tion about the directory hierarchy. The extended filename, showing the full
hierarchy of directories leading to the file, is called the pathname. As the
name implies, it’s the path to the file through the maze of the file system.
Figure 6-2 shows a typical pathname for a file in Linux.
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As Figure 6-2 shows, the pathname has the following parts:

v The root directory, indicated by a forward slash (/) character.

v The directory hierarchy, with each directory name separated from the
previous one by a forward slash (/) character. A / appears after the last
directory name.

v The filename, with a name and one or more optional extensions.
(A period appears before each extension.)

The Linux file system has a well-defined set of top-level directories, and

some of these directories have specific purposes. Finding your way around
the file system is easier if you know the purpose of these directories. You also
become adept at guessing where to look for specific types of files when you
face a new situation. Consult Table 6-1 for a brief description of the top-level
directories in the Linux file system.

Table 6-1 Top-Level Directories in the SUSE Linux File System

Directory Description

/ This root directory forms the base of the file system. All files and
directories are contained logically in the root directory, regard-
less of their physical locations.

/bin Contains the executable programs that are part of the Linux oper-
ating system. Many Linux commands, such as cat, cp, 1s,
more, and tar, are located in /bin.

/boot Contains the Linux kernel and other files that the GRUB boot man-
ager needs. (The kernel and other files can be anywhere, but plac-
ing them in the /boot directory is customary.)

/dev Contains special files that represent devices attached to the

system.

(continued)
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Table 6-1 (continued)

Directory

Description

/etc

Contains most system configuration files and the initialization
scripts (in the /etc/rc.d subdirectory).

/home

Conventional location of the home directories of all users. User
naba’s home directory, for example, is /home /naba.

/1ib

Contains library files for all programs stored in /sbin and /bin
directories (including the loadable driver modules) needed to start
Linux.

/media

A directory for mounting file systems on removable media, such as
CD-ROM drives, floppy disks, and Zip drives. Contains the /media/
f1loppy directory for mounting floppy disks and the /media/
cdrom directory for mounting the CD-ROM drive. If you have a CD
recorder, you'll find a /media/cdrecorder directory instead
of /media/cdrom.

/mnt

A directory for temporarily mounted file systems.

/opt

Provides a storage area for large application software packages.
For example, GNOME and KDE applications are installed in the
/opt directory.

/proc

A special memory-resident directory that contains various infor-
mation about the processes running in the Linux system.

/root

The home directory for the root user.

/sbin

Contains executable files representing commands typically used
for system-administration tasks and used by the root user.
Commands such as halt and shutdown reside in the /sbin
directory.

/srv

Contains data for services (such as Web and FTP) offered by this
system.

/sys

A special directory that contains information about the devices, as
seen by the Linux kernel.

/ tmp

A temporary directory that any user can use as a scratch direc-
tory, meaning that the contents of this directory are considered
unimportant and usually are deleted every time the system boots.

/usr

Contains the subdirectories for many important programs, such as
the X Window System (in the /usr/X11R6 directory) and the
online manual.

/var

Contains various system files (such as logs), as well as directories
for holding other information, such as files for printers and mail
messages.
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Using GUI File Managers

|
Figure 6-3:
You can
view files
and folders
in
Konqueror.
|

Both GNOME and KDE desktops come with GUI file managers that enable you
to easily browse the file system and perform tasks such as copying or moving
files. The GNOME file manager is called Nautilus, and the KDE file manager is

Konqueror. I briefly introduce these GUI file managers in the following sections.

Conquering the file system with Konqueror

Konqueror is a file manager and Web browser that comes with KDE. It’s intu-
itive to use — somewhat similar to the Windows Active Desktop. You can
manage files and folders (and also view Web pages) with Konqueror.

Viewing files and folders

When you double-click a folder icon on the desktop, Konqueror starts automat-
ically. For example, click the Home Folder icon on the KDE panel. Konqueror
runs and displays the contents of your home directory (think of a directory as a
folder that can contain other files and folders). Figure 6-3 shows a typical user’s
home directory in Konqueror.

If you've used Windows Explorer, you can use Konqueror in a similar manner.
The Konqueror window is vertically divided into two panes:

v A narrow left pane shows icons you can click to perform various tasks as
well as navigate through directories in Konqueror.

v A wide right pane uses icons to show the files and folders in the cur-
rently selected folder.
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Konqueror uses different types of icons for different files and shows a pre-
view of each file’s contents. For image files, the preview is a thumbnail ver-
sion of the image.

The Konqueror window’s title bar shows the name of the currently selected
directory. The Location text box (along the top of the window) shows the full
name of the directory — in this case, Figure 6-3 shows the contents of the
/home/naba directory.

Use the leftmost vertical row of buttons to select other things to browse.
When you click one of these buttons, a middle pane appears with a tree menu
of items that you can browse. For example, to browse other parts of the file
system, do the following:

1. From the icons in the Konqueror window’s left pane toolbar (refer to
Figure 6-3), click the Root Folder icon (the second icon from the
bottom, the one that looks like a folder).

A tree menu of directories appears in a left pane.

2. In the tree view of directories in the left pane, locate the folder that
you want to browse and click the plus sign next to that folder to view
any other folders inside that folder.

For example, to look inside the etc folder, click the plus sign next to the
etc folder. Konqueror displays the other folders inside etc and changes
the plus sign to a minus sign.

3. To view the contents of the X11 subdirectory inside the etc folder,
scroll down the left pane and click x11.

The pane on the right now shows the contents of the /etc/x11
directory.

Konqueror displays the contents of a folder using different types of icons.
Each directory appears as a folder, with the name of the directory shown
underneath the folder icon. Ordinary files appear as a sheet of paper.

The Konqueror window has the usual menu bar and a toolbar. You can view
the files and folders in other formats as well. For example, from the menu,
choose View>View ModerDetailed List View to see the folder’s contents
with smaller icons in a list format (see Figure 6-4), along with detailed infor-
mation (such as the size of each file or directory, and at what time each was
last modified).

If you click any of the column headings — Name, Size, File Type, or Modified,
to name a few — along the top of the list view, Konqueror sorts the list
according to that column. For example, if you click the Modified column
heading, Konqueror displays the list of files and folders sorted according to
the time of last modification. Clicking the Name column heading sorts the
files and directories alphabetically by name.
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Manipulating files and directories in Konqueror

Not only can you move around different folders by using Konqueror, but you
can also do things such as move a file from one folder to another or delete a
file. I don’t outline each step here because the steps are intuitive and similar
to what you do in any GUI (such as Windows or the Mac interface). Here are
some things you can do in Konqueror:

v View a text file: Click the filename, and Konqueror displays the contents
of the file in the right pane.

v Copy or move a file to a different folder: Drag and drop the file’s icon
on the folder where you want the file to go. A menu pops up and asks
you whether you want to copy or simply link the file to that directory.

v Delete a file or directory: Right-click the icon and choose Move to
Trash from the context menu. To permanently delete the file, right-click
the Trash icon on the desktop and choose Empty Trash from the context
menu. Of course, do this only if you really want to delete the file. When
you choose Empty Trash, the deleted files are really gone forever. If you
want to recover a file from the trash, double-click the Trash icon on the
desktop. From that window, drag and drop the file icon into the folder
where you want to save the file. When asked whether you want to copy
or move, select Move. You can recover files from the trash until the
moment you empty the trash.

+* Rename a file or a directory: Right-click the icon and choose Rename
from the context menu. Then you can type the new name (or edit the old
name) in the text box that appears.

v Create a new folder: Choose View=>View Mode=Icon View. Then right-
click an empty area of the rightmost pane and choose Create Newr>
Folder from the context menu. Then type the name of the new directory
and click OK. (If you don’t have permission to create a directory, you get
an error message.)
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|
Figure 6-5:
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Viewing Web pages

Konqueror is much more than a file manager. With it, you can view a Web
page as easily as you can view a folder. Just type a Web address in the
Location text box and see what happens. For example, Figure 6-5 shows the

Konqueror window after [ type www. irs.gov in the Location text box on the
toolbar and press Enter.

Konqueror displays the Web site in the pane on the right. The left pane still
shows whatever it was displaying earlier.
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Roaming the file system with Nautilus

The Nautilus file manager — more accurately called a graphical shell —
comes with GNOME. You can manage files and folders and even your system
with Nautilus. In fact, you can even burn a data CD from Nautilus (I describe
the CD-burning steps in Chapter 14).

You can browse the file system in Nautilus in two ways. By default, when you
double-click any object on the desktop, Nautilus opens a new window that
shows that object’s contents. If you want a more Windows-like navigation
window with a Web browser-like user interface, right-click a folder and
choose Open=>Browse Folder from the pop-up menu.
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Viewing files and folders in object windows

When you double-click a file or a folder, Nautilus opens that object in what it
calls an object window. The object window doesn’t have any Back and Forward
buttons, toolbars, or side panes. For example, double-click the Home Folder
icon on the GNOME desktop, and Nautilus opens an object window where it
displays the contents of your home directory. (Think of a directory as a folder
that can contain other files and folders.) If you then double-click an object
inside that window, Nautilus opens another object window where that object’s
contents appear. Figure 6-6 shows the result of double-clicking some objects in
Nautilus.

The Nautilus object window has a sparse user interface that has just the
menu bar. You can perform various operations from the menu bar such as
open an object using an application, create folders and documents, and close
the object window.

Browsing folders in a navigation window

If you prefer to use the familiar navigation window for browsing folders with
Nautilus, you have to do a bit of extra work. Instead of double-clicking an
icon, right-click the icon and choose Browse Folder from the context menu.
Nautilus then opens a navigation window with the contents of the object rep-
resented by the icon. For example, right-click the Home Folder icon on the
GNOME desktop and select Browse Folder from the context menu. Nautilus
opens a navigation window where it displays the contents of your home
directory. Figure 6-7 shows my home directory in a Nautilus navigation
window. Nautilus displays icons for files and folders. For image files, it shows
a thumbnail of the image.

If you double-click any object in the window, Nautilus displays the contents
of that object. If you double-click a folder, Nautilus displays the contents of
that folder. On the other hand, if you double-click a document or an image or
an MP3 file, Nautilus opens it with an appropriate application.

The Nautilus window’s user interface is similar to that of a Web browser. The
window'’s title bar shows the name of the currently selected folder. The
Location text box along the top of the window shows the full name of the
directory in Linuxspeak — for example, Figure 6-7 shows the contents of the
/home/naba directory.

You can use the Nautilus navigation window in the same way you would use

Windows Explorer. To view the contents of another directory, do the following:

1. Press F9 to open the side pane in the Nautilus window.

This action causes the Nautilus window to vertically divide into two
parts. The left pane shows different views of the file system and other
objects that you can browse with Nautilus. The right pane shows the
files and folders in the currently selected folder in the left pane.
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2. Select Tree from the Information drop-down menu (located in the left

window).

A tree menu of directories appears in that window. Initially the tree shows
your home folder, and the file system appears as a FileSystem folder.
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3. Click the right arrow that appears to the left of the FileSystem
folder; in the resulting tree view, locate the directory you want to
browse.

For example, to look at the /etc directory, click the right arrow next to
the etc directory. Nautilus displays the subdirectories in /etc and
changes the right arrow to a down arrow. X11 is one of the subdirecto-
ries in /etc that you view in the next step. Scroll down the contents of
the left pane to locate the x11 folder.

4. To view the contents of the X11 subdirectory, click x11.

The window on the right now shows the contents of the /etc/X11
directory, as shown in Figure 6-8. Notice that /etc/X11 appears in the
Location text box in the Nautilus window.
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Nautilus displays the contents of the selected directory by using different
types of icons. Each directory appears as a folder with the name of the direc-
tory shown underneath the folder icon. Ordinary files, such as XF86Config,
appear as a sheet of paper.

The Nautilus navigation window has the usual menu bar and a toolbar. Notice
the View as Icons button in Figure 6-8 on the right side of the toolbar. This
button shows that Nautilus is displaying the directory contents with large
icons. Click the button, and a drop-down list appears. Select View as List from
the list, and Nautilus displays the contents by using smaller icons in a list
format, along with detailed information, such as the size of each file or direc-
tory and the time when each was last modified, as shown in Figure 6-9.
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If you click any of the column headings — Name, Size, Type, or Date Modified —
along the top of the list view, Nautilus sorts the list according to that column.
For example, go ahead and click the Date Modified column heading. Nautilus
now displays the list of files and directories sorted according to the time of
their last modification. Clicking the Name column heading sorts the files and
folders alphabetically.

Manipulating files and directories in Nautilus

Not only can you move around different folders by using the Nautilus naviga-
tion window, you can also do things such as move a file from one folder to
another or delete a file. I don’t outline each step — the steps are intuitive and
similar to what you do in any GUI, such as Windows or Mac. Here are some of
the things you can do in Nautilus:

v To move a file to a different folder, drag and drop the file’s icon on the
folder where you want the file.

v To copy a file to a new location, select the file’s icon and choose
Edit=>Copy File from the Nautilus menu. You can also right-click the file’s
icon and choose Copy File from the context menu. Then move to the
folder where you want to copy the file and choose Edit=>Paste Files.

v To delete a file or directory, right-click the icon, and choose Move to
Trash from the context menu. (You can do this only if you have permis-
sion to delete the file.) To permanently delete the file, right-click the
Trash icon on the desktop and choose Empty Trash from the context
menu. Of course, do this only if you really want to delete the file. Once
you choose Empty Trash, you are never going to see the file again. If you
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have to retrieve a file from the trash, double-click the Trash icon and
then drag the file’s icon back to the folder where you want to save it. You
can retrieve a file from the trash until you empty it.

v To rename a file or a directory, right-click the icon and choose Rename
from the context menu. Then you can type the new name (or edit the
name) in the text box that appears.

v To create a new folder, right-click an empty area of the window on the
right and choose Create Folder from the context menu. After the new
folder icon appears, you can rename it by right-clicking the icon and
choosing Rename from the context menu. If you don’t have permission
to create a folder, that menu item is grayed out.

Using Linux Commands to Manipulate
Files and Directories

\\3

Although GUI file managers such as Konqueror (in KDE) and Nautilus (in
GNOME) are easy to use, you can use them only if you have a working GUI
desktop. Sometimes, you may not have a graphical environment to run a
graphical file manager. For example, you may be logged in through a text ter-
minal, or the X Window System may not be working on your system. In those
situations, you have to rely on Linux commands to work with files and direc-
tories. Of course, you can always use Linux commands, even in the graphical
environment — all you have to do is open a terminal window and type the
Linux commands.

To open a terminal window in KDE, click the terminal icon on the panel. In
GNOME, choose Applications=System=>Terminal=>Gnome Terminal.

In the sections that follow, I briefly show some Linux commands for working
with the files and directories.

Commands for directory navigation

In Linux, when you log in as root, your home directory is /root. For other
users, the home directory is usually in the /home directory. My home direc-
tory (whenIlog in as naba) is /home/naba. This information is stored in the
/etc/passwd file. By default, only you have permission to save files in your
home directory, and only you can create subdirectories in your home direc-
tory to further organize your files.
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\\J

Linux supports the concept of a current directory, which is the directory on
which all file and directory commands operate. After you log in, for example,
your current directory is the home directory. To see the current directory,
type the pwd command.

To change the current directory, use the cd command. To change the current
directory to /usr/1ib, type the following:

cd /usr/lib

Then, to change the directory to the cups subdirectory in /usr/1ib, type
this command:

cd cups

Now, if you use the pwd command, that command shows /usr/1ib/cups as
the current directory.

These two examples show that you can refer to a directory’s name in
two ways:

»~ An absolute pathname (such as /usr/1ib) that specifies the exact
directory in the directory tree

v A relative directory name (such as cups, which represents the cups
subdirectory of the current directory, whatever that may be)

If you type cd cups in /usr/1ib, the current directory changes to /usr/
lib/cups. However, if you type the same command in /home /naba, the
shell tries to change the current directory to /home/naba/cups.

Use the cd command without any arguments to change the current directory
back to your home directory. No matter where you are, typing cd at the shell
prompt brings you back home!

By the way, the tilde character (~) refers to your home directory. Thus the
command cd ~ also changes the current directory to your home directory.
You can also refer to another user’s home directory by appending that user’s
name to the tilde. Thus, cd ~spiderman changes the current directory to
the home directory of spiderman.

Wait, there’s more. A single dot (.) and two dots (. .) — often referred to as
dot-dot — (clever, huh!) also have special meanings. A single dot (.) indi-
cates the current directory, whereas two dots (. .) indicate the parent direc-
tory. For example, if the current directory is /usr/share, you go one level
up to /usr by typing

cd ..
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Commands for directory listings
and permissions

You can get a directory listing by using the 1s command. By default, the 1s
command — without any options — displays the contents of the current
directory in a compact, multicolumn format. For example, type the next two
commands to see the contents of the /etc/X11 directory:

cd /etc/X11
1s

The output looks like this (on the console, you see some items in different
colors):

fs gt_gtk_fnt2fntrc WindowMaker xkb xorg.conf.md5
fvwm2 gt_plugins_3.3rc xdm Xmodmap xorg.conf.saxsave
kstylerc gtrc xim Xmodmap.remote Xresources
lbxproxy  rstart xim.d xorg.conf xserver
proxymngr twm xinit xorg.conf.install xsm

From this listing (without the colors), you cannot tell whether an entry is a
file or a directory. To tell the directories and files apart, use the -F option
with 1s like this:

ls -F

This time, the output gives you some more clues about the file types:

fs/ gtrc xinit/ xorg.conf.saxsave
fvwm2 / rstart/ xkb/ Xresources
kstylerc twm/ Xmodmap xserver/
lbxproxy/ WindowMaker/ Xmodmap.remote xsm/

proxymngr/ xdm/ xorg.conf

gt_gtk_fnt2fntrc xim xorg.conf.install

gt_plugins_3.3rc xim.d/ xorg.conf.md5

The output from 1s -F shows the directory names with a slash (/) appended
to them. Plain filenames appear as is. The at sign (@) appended to a file’s name
(for example, notice the file named xorg. conf) indicates that this file is a link
to another file. (In other words, this filename simply refers to another file; it’s
a shortcut.) An asterisk (*) is appended to executable files. (xim, for example,
is an executable file.) The shell can run any executable file.

You can see even more detailed information about the files and directories
with the -1 option:

1ls -1
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For the /etc/X11 directory, a typical output from 1s -1 looks like the
following:

total 73

drwxr-xr-x root root 72 2005-08-10 17:47 fs

drwxr-xr-x root root 80 2005-08-10 17:48 fvwm2

-IrW-r--r-- root root 33 2004-03-17 18:10 kstylerc
drwxr-xr-x root root 80 2005-08-10 17:47 lbxproxy
drwxr-xr-x root root 72 2005-08-10 17:47 proxymngr
-YW-Y--r-- root root 117 2003-03-03 05:08 gt_gtk_fnt2fntrc
-IW-r--r-- root root 766 2005-08-10 18:02 gt_plugins_3.3rc
—EW-T1—=1== root root 5286 2005-08-06 13:40 gtrc

root root 120 2005-08-10 17:47 rstart

root root 80 2005-08-10 17:47 twm

root root 232 2005-08-10 18:06 WindowMaker

root root 552 2005-08-14 15:44 xdm

root root 4515 2005-08-06 12:56 xim

drwxr-xr-x root root 72 2005-08-10 17:46 xim.d

drwxr-xr-x 3 root root 136 2005-08-10 17:47 xinittotal 77
. lines deleted ...

drwxr-xr-x
drwxr-xr-x
drwxr-xr-x
drwxr-xr-x
-rw-r--r--

NP WD DS R RN R DN

This listing shows considerable information about every directory entry —
each of which can be a file or another directory. Looking at a line from the
right column to the left, you see that the rightmost column shows the name
of the directory entry. The date and time before the name show when the last
modifications to that file were made. To the left of the date and time is the
size of the file in bytes.

The file’s group and owner appear to the left of the column that shows the
file size. The next number to the left indicates the number of links to the file.
(A link is like a shortcut in Windows.) Finally, the leftmost column shows the
file’s permission settings, which determine who can read, write, or execute
the file.

The first letter of the leftmost column has a special meaning, as the following
list shows:

v~ If the first letter is 1, the file is a symbolic link (a shortcut) to another
file.

v~ If the first letter is d, the file is a directory.

v~ If the first letter is a dash (-), the file is normal.

v~ If the first letter is b, the file represents a block device, such as a disk
drive.

v~ If the first letter is c, the file represents a character device, such as a
serial port or a terminal.
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After that first letter, the leftmost column shows a sequence of nine charac-
ters, which appear as rwxrwxrwx when each letter is present. Each letter
indicates a specific permission. A hyphen (-) in place of a letter indicates no
permission for a specific operation on the file. Think of these nine letters as
three groups of three letters (rwx), interpreted as follows:

v The leftmost group of rwx controls the read, write, and execute permis-
sions of the file’s owner. In other words, if you see rwx in this position,
the file’s owner can read (r), write (w), and execute (x) the file. A
hyphen in the place of a letter indicates no permission. Thus the string
rw- means the owner has read and write permissions but no execute
permission. Although executable programs (including shell programs)
typically have execute permission, directories treat execute permission
as equivalent to use permission — a user must have execute permission
on a directory before he or she can open and read the contents of the
directory.

v The middle three rwx letters control the read, write, and execute per-
missions of any user belonging to that file’s group.

v The rightmost group of rwx letters controls the read, write, and execute
permissions of all other users (collectively referred to as the world).

Thus, a file with the permission setting rwx------ is accessible only to the
file’s owner, whereas the permission setting rwxr--r-- makes the file read-
able by the world.

An interesting feature of the 1s command is that it doesn’t list any file whose
name begins with a period. To see these files, you must use the 1s command
with the -a option, as follows:

1ls -a

Try this command in your home directory (and then compare the result with
what you see when you don’t use the -a option):

1. Type cd to change to your home directory.

2. Type Is -F to see the files and directories in your home directory.

3. Type Is -aF to see everything, including the hidden files.
Most Linux commands take single-character options, each with a minus
sign (think of this sign as a hyphen) as a prefix. When you want to use
several options, type a hyphen and concatenate (string together) the option

letters, one after another. Thus, 1s -al is equivalent to 1s -a -1 as well
asls -1 -a.
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Commands for working with files

To copy files from one directory to another, use the cp command. For exam-
ple, to copy the file /usr/X11R6/1ib/X11/xinit/Xclients to the
Xclients.sample file in the current directory (such as your home direc-
tory), type the following:

cp /usr/X11R6/1ib/X1l/xinit/xinitrc xinitrc.sample

If you want to copy a file to the current directory but retain the original
name, use a period (.) as the second argument of the cp command. Thus, the
following command copies the Xresources file from the /etc/X11 direc-
tory to the current directory (denoted by a single period):

cp /etc/X1ll/Xresources
The cp command makes a new copy of a file and leaves the original intact.

If you want to copy the entire contents of a directory — including all subdi-
rectories and their contents — to another directory, use the command cp -
ar sourcedir destdir. (This command copies everything in the
sourcedir directory to destdir.) For example, to copy all files from the
/etc/X11 directory to the current directory, type the following command:

cp -ar /etc/X11
To move a file to a new location, use the mv command. The original copy is
gone, and a new copy appears at the destination. You can use mv to rename a
file. If you want to change the name of today.list to o1d.1list, use the mv
command, as follows:

mv today.list old.list

On the other hand, if you want to move the today.1list file to a subdirec-
tory named saved, use this command:

mv today.list saved
An interesting feature of mv is that you can use it to move entire directories —
with all their subdirectories and files — to a new location. If you have a direc-
tory named data that contains many files and subdirectories, you can move
that entire directory structure to 01d_data by using the following command:

mv data old_data

To delete files, use the rm command. For example, to delete a file named
old.list, type the following command:

rm old.list
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Be careful with the rm command — especially when you log in as root. You
can inadvertently delete important files with rm.

Commands for working with directories

To organize files in your home directory, you have to create new directories.
Use the mkdir command to create a directory. For example, to create a direc-
tory named Photos in the current directory, type the following:

mkdir Photos

After you create the directory, you can use the cd Photos command to
change to that directory.

You can create an entire directory tree by using the -p option with the mkdir
command. For example, suppose your system has a /usr/src directory and
you want to create the directory tree /usr/src/book/java/examples/
applets. To create this directory hierarchy, type the following command:

mkdir -p /usr/src/book/java/examples/applets
When you no longer need a directory, use the rmdir command to delete it.
You can delete a directory only when the directory is empty.
To remove an empty directory tree, you can use the -p option, like this:
rmdir -p /usr/src/book/java/examples/applets

This command removes the empty parent directories of applets. The com-
mand stops when it encounters a directory that’s not empty.

Commands for finding files

The find command is very useful for locating files (and directories) that
meet your search criteria.

When [ began using UNIX many years ago (Berkeley UNIX in the early 1980s),
[ was confounded by the find command. I stayed with one basic syntax of
find for a long time before graduating to more complex forms. The basic
syntax that I discovered first was for finding a file anywhere in the file
system. Here’s how it goes: Suppose you want to find any file or directory
with a name that starts with gnome. Type the following find command to
find these files:

find / -name "gnome*" -print
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If you're not logged in as root, you may get a bunch of error messages. If
these error messages annoy you, just modify the command as follows and the
error messages are history (or, as UNIX aficionados say, “Send ’em to the bit
bucket”):

find / -name "gnome*" -print 2> /dev/null

This command tells find to start looking at the root directory (/) for file-
names that match gnome*, and to display the full pathname of any matching
file. The last part (2> /dev/null) simply sends the error messages to a
special file that’s the equivalent of simply ignoring them.

You can use variations of this simple form of £ind to locate a file in any
directory (as well as any subdirectories contained in the directory). If you
forget where in your home directory you've stored all files named report*
(names that start with report), you can search for the files by using the fol-
lowing command:

find ~ -name "report*" -print

When you become comfortable with this syntax of £ind, you can use other
options of £ind. For example, to find only specific types of files (such as
directories), use the type option. The following command displays all top-
level directory names in your Linux system:

find / -type d -maxdepth 1 -print

You probably don’t have to use the complex forms of £ind in a typical Linux
system — but if you ever need to, you can look up the rest of the find
options by using the following command:

man find

An easy way to find all files that match a name is to use the locate com-
mand that searches a periodically updated database of files on your system.
For example, here’s a typical output I get when I type locate Xresources on a
SUSE Linux system:

/etc/X11/xdm/Xresources
/etc/X11l/Xresources
/opt/kde3/share/config/kdm/Xresources
/usr/X11R6/1ib/X11/Xresources

The locate command isn’t installed by default in SUSE Linux, but it’s very
easy to install. See Chapter 23 for information on how to use it.
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Commands for mounting and unmounting

Suppose you want to access the files on this book’s companion DVD-ROM
when you are logged in at a text console (with no GUI to help you). To do so,
you have to first mount the DVD-ROM drive’s file system on a specific direc-
tory in the Linux file system.

Type more /etc/fstab in a terminal window to look at the /etc/fstab

file for clues to the names of devices such as a floppy drive and DVD/CD

drive. SUSE Linux distributions uses the device name /dev/cdrom to refer

to DVD/CD-ROM drives, whereas for a DVD/CD-R drive (a CD or DVD burner),
the device name is /dev/cdrecorder. The entry in the /etc/fstab file also
tells you the directory where SUSE Linux mounts the DVD/CD drive. For a read-
only DVD/CD-ROM drive, SUSE Linux uses /media/cdrom as the mount point,
whereas for a DVD/CD-R drive, the mount point is /media/cdrecorder.

Type su - to become root, insert the DVD-ROM in the DVD drive, and then
type the following command in a text console or a terminal window:

mount /dev/cdrom /media/cdrom

This command mounts the file system on the device named /dev/cdrom on
the /media/cdrom directory (which is also called the mount poinf) in the
Linux file system.

After the mount command successfully completes its task, you can access
the files on the DVD-ROM by referring to the /media/cdrom directory as the
top-level directory of the disc. In other words, to see the contents of the DVD-
ROM, type

ls -F /media/cdrom
When you’re done using the DVD-ROM — and before you eject it from the
drive — you have to unmount the disc drive with the following umount
command:

umount /dev/cdrom
You can mount devices on any empty directory on the file system. However,

SUSE Linux has customary locations such as /media/cdrom and /media/
cdrecorder for mounting DVD/CD drives.
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Commands for checking disk-space usage

[ want to tell you about two commands — df and du — that you can use to
check the disk-space usage on your system. These commands are simple to
use. The df command shows you a summary of disk-space usage for all
mounted devices. For example, here’s the result of typing df on one of my
PCs running SUSE Linux:

Filesystem 1K-blocks Used Available Use% Mounted on
/dev/hdall 6357688 1994348 4363340 32% /

tmpfs 124004 36 123968 1% /dev/shm
/dev/hda7 43885 9749 31870 24% /boot

/dev/hdc 664234 664234 0 100% /media/cdrecorder

The output is a table that lists the device, the total kilobytes of storage, how
much is in use, how much is available, the percentage being used, and the
mount point.

To see the output of df in a more human-readable format, type df -h. Here is
the output of the df -h command:

Filesystem Size TUsed Avail Use$% Mounted on
/dev/hdall 6.1G 2.0G 4.2G 32% /

tmpfs 122M 36K 122M 1% /dev/shm
/dev/hda’7 43M 9.6M 32M 24% /boot

/dev/hdc 649M 649M 0 100% /media/cdrecorder

If you compare this output with the output of plain df (see previous listing),
you see that df -h prints the sizes with terms like M for megabytes and G for
gigabytes. These are clearly easier to understand than 1XK-blocks.

The other command — du — is useful for finding out how much space a
directory takes up. For example, type du /etc/X11 to view the contents of
all the directories in the /etc/x11 directory. (This directory contains X
Window System configuration files.) You end up with a list that looks similar
to the following:

4 /etc/X11/fs

4 /etc/X11/twm

84 /etc/X11l/xdm/pixmaps

153 /etc/X11/xdm

372 /etc/X11/xkb/rules

44 /etc/X11/xkb/types
lines deleted ...

40 /etc/X11l/rstart

4 /etc/X11l/proxymngr

2920 /etc/X11
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Each directory name is preceded by a number — which tells you the number
of kilobytes of disk space used by that directory. Thus the /etc/X11 direc-
tory, as a whole, uses 2920KB (or about 2.9MB) of disk space. If you simply
want the total disk space used by a directory (including all the files and sub-
directories contained in that directory), use the -s option and type du -s
/etc/X11. The resulting output is as follows:

2920 /etc/X11

The -s option causes du to print just the summary information for the entire
directory.

Just as df -h prints the disk-space information in megabytes and gigabytes,
you can use the du -h command to view the output of du in a more human-
readable form. For example, to see the space that 'm using in my home direc-
tory (/home/naba), | type du -sh /home/naba. Here’s a sample output from
that command that tells me that [ am using 44GB of space:

44G /home/naba
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Chapter 7
| Want My Internet, Now!

In This Chapter

Understanding the Internet

Deciding how to connect to the Internet
Connecting to the Internet with DSL
Connecting to the Internet with a cable modem
Setting up a dialup link

Having Internet access is almost a necessity nowadays. For example, if you
want to access your e-mail, browse the Web, or get online updates for
SUSE Linux from an Internet server, you need your PC connected to the Internet.

If your PC is not already connected to the Internet, it’s a pretty safe bet for me
to assume that you want to set up the Internet connection as soon as possible.
In this chapter, I show you how to connect to the Internet in several different
ways — depending on whether you have a DSL, cable modem, or dialup net-
work connection.

Two of the options for connecting to the Internet — DSL and cable modem —
involve connecting a special modem to an Ethernet card on your Linux
system. In this chapter, I show you how to set up a DSL or a cable modem
connection. I also show you another option — dialup networking — for con-
necting to the Internet that involves dialing up an Internet service provider
(ISP) from your SUSE Linux system.

You have to turn to Chapter 8 to learn how to connect your PC to an Ethernet
local area network (LAN) and add wireless capability to your LAN.
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What Is the Internet?

How you view the Internet depends on your perspective. Regular folks see
the Internet in terms of the services they use. For example, as a user, you
might think of the Internet as an information-exchange medium with features
such as

v E-mail: Send e-mail to any other user on the Internet, using addresses
such as mom@home . net.

v Web: Download documents and images from millions of servers through-
out the Internet.

v Newsgroups: Read newsgroups and post news items to newsgroups
with names such as comp.os.linux.networking or comp.os.
linux.setup.

v Information sharing: Download software, music files, videos, and so on.
Reciprocally, you may provide files that users on other systems can
download.

v Remote access: Log on to another computer on the Internet, assuming
that you have access to that remote computer.

The techies say that the Internet is a worldwide network of nefworks. The term
internet (without capitalization) is a shortened form of internetworking — the
interconnection of networks. The Internet Protocol (IP) was designed with
the idea of connecting many separate networks.

In terms of physical connections, the Internet is similar to a network of high-
ways and roads. This similarity is what has prompted the popular press to
dub the Internet “the Information Superhighway.” Just as the network of high-
ways and roads includes some interstate highways, many state roads, and
many more residential streets, the Internet has some very high-capacity net-
works (for example, a 10 Gbps backbone can handle 10 billion bits per second)
and a large number of lower-capacity networks ranging from 56 Kbps dialup
connections to 45 Mbps T3 links. (Kbps is thousand-bits-per-second, and
Mbps is million bits per second.) The high-capacity network is the backbone
of the Internet.

In terms of management, the Internet is not run by a single organization, nor
is it managed by any central computer. You can view the physical Internet
as a “network of networks” managed collectively by thousands of cooperat-
ing organizations. Yes, a collection of networks managed by thousands of
organizations — sounds amazing, but it works!



Chapter 7: 1 Want My Internet, Now! ’ 0 5

Deciding How to Connect to the Internet

So you want to connect to the Internet, but you don’t know how? Let me
count the ways. Nowadays you have three popular options for connecting
home offices and small offices to the Internet (of course, huge corporations
and governments have many other ways to connect):

v~ Digital Subscriber Line (DSL): Your local telephone company, as well as
other telecommunications companies, may offer DSL. DSL provides a
way to send high-speed digital data over a regular phone line. Typically,
DSL offers data-transfer rates of between 128 Kbps and 1.5 Mbps. You
can download from the Internet at much higher rates than when you
send data from your PC to the Internet (upload). One caveat with DSL is
that your home must be between 12,000 and 15,000 feet from your local
central office (the phone-company facility where your phone lines end
up). The distance limitation varies from provider to provider. In the
United States, you can check out the distance limits for many providers
at www.dslreports.com/distance.

v Cable modem: If the cable television company in your area offers
Internet access over cable, you can use that service to hook up your
Linux system to the Internet. Typically, cable modems offer higher data-
transfer rates than DSL — for about the same cost. Downloading data
from the Internet via cable modem is much faster than sending data
from your PC to the Internet. You can expect routine download speeds of
1.5 Mbps and upload speeds of around 128 Kbps, but sometimes you
may get even higher speeds than these.

v~ Dialup networking: A dialup connection is what most folks were using
before DSL and cable modems came along. You hook up your PC to a
modem that’s connected to the phone line. Then you dial up an ISP to
connect to the Internet. That’s why it’s called dialup networking —
establishing a network connection between your Linux PC and another
network (the Internet) through a dialup modem. In this case, the maxi-
mum data-transfer rate is 56 Kbps.

DSL and cable modem services connect you to the Internet and also act as
your Internet service provider (ISP); in addition to improved speed, you pay
for an IP address and your e-mail accounts. If you use a dialup modem to con-
nect to the Internet, first you have to connect to the phone line (for which
you pay the phone company) and then select and pay a separate ISP — which
gives you a phone number to dial and all the other necessary goodies (such
as an IP address and e-mail accounts).

Table 7-1 summarizes all these options. You can consult that table and select
the type of connection that’s available to you and that best suits your needs.
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Table 7-1 Comparison of Dialup, DSL, and Cable
Feature Dialup DSL Cable
Equipment Modem DSL modem, Cable modem,
Ethernet card Ethernet card

Also requires Phone service Phone service and Cable TV

and an Internet location within connection

service provider 12,000 to 15,000

(ISP) feet of central office

Connection type

Dial to connect Always on, dedicated

Always on, shared

Typical speed

56 Kbps maximum 640 Kbps download,

1.5 Mbps or higher

128 Kbps upload download, 128
(higher speeds Kbps upload
cost more)

One-time costs  None Install = $100-$200 Install = $100-$200

(estimate)

(none for self install);
Equipment = $50-$100
(may be leased and
may require activa-
tion cost)

(none for self
install); Equipment
= $50-$100 (may
be leased)

Typical monthly
cost (2005)

Phone charges = $40-50/month; may
$20/month; ISP require monthly
charges = modem lease
$15-$30/month

$40-50/month; may
require monthly
modem lease

Note: Costs vary by region and provider. Costs shown are typical ones for U.S. metropolitan areas.

Connecting to the Internet with DSL

DSL (Digital Subscriber Line) uses your existing phone line to send digital
data in addition to the normal analog voice signals (analog means continu-
ously varying, whereas digital data is represented by 1s and 0s). The phone
line goes from your home to a central office where the line connects to the
phone company’s network — by the way, the connection from your home to
the central office is called the local loop. When you sign up for DSL service,
the phone company hooks up your phone line to some special equipment at
the central office. That equipment can separate the digital data from voice.
From then on, your phone line can carry digital data that is then directly sent
to an Internet connection at the central office.
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How DSL works

A special box called a DSL modem takes care of sending digital data from
your PC to the phone company’s central office over your phone line. Your PC
can connect to the Internet with the same phone line that you use for your
normal telephone calls — you can make voice calls even as the line is being
used for DSL. Figure 7-1 shows a typical DSL connection to the Internet.

Your PC talks to the DSL modem through an Ethernet connection, which
means that you need an Ethernet card in your Linux system.

Your PC sends digital data over the Ethernet connection to the DSL modem.
The DSL modem sends the digital data at different frequencies than those
used by the analog voice signals. The voice signals occupy a small portion of
all the frequencies that the phone line can carry. DSL uses the higher frequen-
cies to transfer digital data, so both voice and data can travel on the same
phone line.
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Telephone Network
Interface Device
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The distance between your home and the central office — the loop length — is
a factor in DSL's performance. Unfortunately, the phone line can reliably carry
the DSL signals over only a limited distance — typically 3 miles or less, which
means that you can get DSL service only if your home (or office) is located
within about 3 miles of your phone company’s central office. Your phone com-
pany can tell you whether your location can get DSL or not. Often, it has a Web
site where you can type in your phone number and get a response about DSL
availability. For example, try www.dslavailability.com for U.S. locations.

Stirring the DSL alphabet soup:
ADSL, IDSL, SDSL

[ have been using the term DSL as if there was only one kind of DSL. As you
may imagine, nothing is ever that simple. DSL has in fact three variants, each
with different features. Take a look:

v ADSL: Asymmetric DSL, the most common form of DSL, has much higher
download speeds (from the Internet to your PC) than upload speeds
(from your PC to the Internet). ADSL can have download speeds of up to
8 Mbps and upload speeds of up to 1 Mbps. ADSL works best when your
location is within about 2 f ¥ miles (12,000 feet) of your central office.
ADSL service is priced according to the download and upload speeds
you want. A popular form of ADSL, called G.lite, is specifically designed
to work on the same line you use for voice calls. G.lite has a maximum
download speed of 1.5 Mbps and a maximum upload speed of 512 Kbps.

v~ IDSL: ISDN DSL (ISDN is an older technology called Integrated Services
Digital Network) is a special type of DSL that works at distances of up to
5 miles between your phone and the central office. The downside is that
IDSL only offers downstream (from the Internet to your PC) and
upstream (from your PC to the Internet) speeds of up to 144 Kbps.

v SDSL: Symmetric DSL provides equal download and upload speeds of up
to 1.5 Mbps. SDSL is priced according to the speed you want, with the
higher speeds costing more. The closer your location is to the phone
company’s central office, the faster the connection you can get.

DSL speeds are typically specified by two numbers separated by a slash, like
this: 1500/384. The numbers refer to data-transfer speeds in kilobits per
second (that is, thousands-of-bits per second, abbreviated as Kbps). The first
number is the download speed; the second the upload. Thus 1500/384 means
you can expect to download from the Internet at a maximum rate of 1,500
Kbps (or 1.5 Mbps) and upload to the Internet at 384 Kbps. If your phone
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line’s condition is not perfect, you may not get these maximum rates — both
ADSL and SDSL adjust the speeds to suit existing line conditions.

The price of DSL service depends on which variant — ADSL, IDSL, or SDSL —
you select. For most home users, the primary choice is ADSL (or, more accu-
rately, the G.lite form of ADSL) with transfer speed ratings of 1500/128.

Typical DSL setup

To get DSL for your home or business, you have to contact a DSL provider.
In addition to your phone company, you can find many other DSL providers.
No matter who provides the DSL service, some work has to be done at your
central office — the place where your phone lines connect to the rest of the
phone network. The work involves connecting your phone line to equipment
that can work with the DSL. modem at your home or office. The central office
equipment and the DSL modem at your location can then do whatever magic
is needed to send and receive digital data over your phone line.

Because of the need to set up your line at the central office, it takes some
time after you place an order to get your line ready for DSL.

The first step for you is to check out the DSL providers and see if you can
actually get the service. Because DSL can work only over certain distances —
typically less than 2% miles between your location and the central office —
you have to check to see if you are within that distance limit. Contact your
phone company to verify. You may be able to check this availability on the
Web. Try typing into Google (www.google.com) the words DSL, availability,
and your local phone company’s name. The search results will probably
include a Web site where you can type in your phone number to find out if
DSL is available for your home or office.

If DSL is available, you can look for the types of service — ADSL versus SDSL —
and the pricing. The price depends on the download and upload speeds you
want. Sometimes, phone companies offer a simple residential DSL (basically
the G.lite form of ADSL) with a 1500/128 speed rating — meaning you can
download at up to 1,500 Kbps and upload at 128 Kbps. Of course, these are
the maximums, and your mileage may vary.

After selecting the type of DSL service and provider you want, you can place
an order and have the provider install the necessary equipment at your home
or office. Figure 7-2 shows a sample connection diagram for typical residen-
tial DSL service.
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Here are some key points to note in Figure 7-2:

v Connect your DSL modem’s data connection to the phone jack on a
wall plate.

v Connect the DSL modem’s Ethernet connection to the Ethernet card on
your PC.

v When you connect other telephones or fax machines on the same phone
line, install a microfilter between the wall plate and each of these
devices.

Because the same phone line carries both voice signals and DSL data, you
need a microfilter to protect the DSL data from possible interference. You can
buy one at an electronics store or from the DSL provider.

When you connect your Linux PC to the Internet using DSL, the connection
is always on — which means a greater potential for outsiders to break into
the PC.
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P You can protect your Linux system from intruders and, as an added bonus,
share the high-speed connection with other PCs in a local area network (LAN)
by using a router that can perform Network Address Translation (NAT). Such
a NAT router translates multiple private Internet Protocol (IP) addresses from
an internal LAN into a single public IP address, which allows all the internal
PCs to access the Internet. The NAT router acts as a gateway between your
LAN and the Internet, and it isolates your LAN from the Internet — making it
harder for intruders to reach the systems on your LAN.

If you also want to set up a local area network, you need an Ethernet hub to

connect the other PCs to the network. Figure 7-3 shows a typical setup that
connects a LAN to the Internet through a NAT router and a DSL modem.

Phone jack

Ethernet cables (10BaseT)

—— Ethernet hub
Figure7-3: >=—S ~_ <«  ——" =\ (oo
A NAT
router 7 Ethernet cables
isolates DSL modem NAT router (10BaseT)
your PC
from the
Internet
and also lets
you share
the DSL
connection
with other
PCsina
local area PCs in a local area network (LAN).
network. Each PC must have a 10BaseT
— Ethernet card.

Here are the points to note when setting up a connection like the one shown
in Figure 7-3:

v You need a NAT router with two 10BaseT Ethernet ports (the 10BaseT
port looks like a large phone jack, also known as an RJ45 jack). Typi-
cally, one Ethernet port is labeled Internet (or External or WAN for wide
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area network), and the other one is labeled Local or LAN (for local area
network).

v You also need an Ethernet hub. For a small home network, you can buy a
4- or 8-port Ethernet hub. Basically, you want a hub with as many ports
as the number of PCs you intend to connect to your local area network.

v Connect the Ethernet port of the DSL modem to the Internet port of the
NAT router using a 10BaseT Ethernet cable. (These look like phone wires
with bigger RJ-45 jacks and are often labeled Category 5 or Cat 5 wire.)

v Connect the Local Ethernet port of the NAT router to one of the ports on
the Ethernet hub, using a 10BaseT Ethernet cable.

v Now connect each of the PCs to the Ethernet hub. (Of course, to do so,
you must first have an Ethernet card installed and configured in each PC.)

You can also buy a NAT router with a built-in 4- or 8-port Ethernet hub. With
such a combined router/hub, you need only one box to set up a LAN and con-
nect it to the Internet via a DSL modem. These boxes are typically sold under
the name Cable/DSL router because they work with both DSL and a cable
modem.

DSL providers typically use a protocol known as PPP over Ethernet (PPPoE) to
establish a connection between your PC and the equipment at the provider’s
central office. PPPoE requires you to provide a username and password to
establish the network connection over Ethernet. To set up your system for a
PPPoE DSL connection, all you have to do is run YaST. (Choose Main Menu>
System>YaST, click Network Devices on the left-hand window, and click DSL
from the different network devices shown on the right-hand window.) YaST
automatically detects the DSL modem and guides you through the configura-
tion process.

Connecting to the Internet
with a Cable Modem

Cable TV companies also offer high-speed Internet access over the same
coaxial cable that carries television signals to your home. After the cable
company installs the necessary equipment at its facility to send and receive
digital data over the coaxial cables, customers can sign up for cable Internet
service. You can then get high-speed Internet access over the same cable that
delivers cable TV signals to your home.
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How cable modems work

A box called a cable modem is at the heart of Internet access over the cable
TV network. (See Figure 7-4.) The cable modem takes digital data from your
PC’s Ethernet card and puts it in an unused block of frequency. (Think of it as
another TV channel, but instead of pictures and sound, this channel carries

digital data.)

Cable company To Internet

head end (the central backbone

distribution point)
Cable Modem
Termination System
(CMTS)

o Y

A neighborhood (one or more homes with cable modems)

Another neighborhood
(all homes with cable
modems share same

cable)
|

Figure 7-4:
Cable
modems
provide
high-speed
Internet
access over
the cable TV
network.
|

Cable Modem Your PC



114 Ppartii: Test-Driving SUSE

NBER
@“'
&

A\\S

The cable modem places upstream data — data that’s being sent from your
PC to the Internet — in a different channel than the downstream data that’s
coming from the Internet to your PC. By design, the speed of downstream
data transfers is much higher than that of upstream transfers. The assump-
tion is that people download far more stuff from the Internet than they
upload. (Probably true for most of us.)

The coaxial cable that carries all those hundreds of cable TV channels to
your home is a very capable signal carrier. In particular, the coaxial cable can
carry signals covering a huge range of frequencies — hundreds of megahertz
(MHz). Each TV channel requires 6 MHz — and the coaxial cable can carry
hundreds of such channels. The cable modem places the upstream data in a
small frequency band and expects to receive the downstream data in a whole
other frequency band.

At the other end of your cable connection to the Internet is the Cable Modem
Termination System (CMTS) — also known as the head end — that your cable
company installs at its central facility. (Refer to Figure 7-4.) The CMTS con-
nects the cable TV network to the Internet. It also extracts the upstream digi-
tal data sent by your cable modem (and by those of your neighbors as well)
and sends all of it to the Internet. The CMTS also puts digital data into the
upstream channels so that your cable modem can extract that data and pro-
vide it to your PC via the Ethernet card.

Cable modems can receive downstream data at the rate of about 30 Mbps

and send data upstream at around 3 Mbps. However, all the cable modems in
a neighborhood share the same downstream capacity. Each cable modem fil-
ters out — separates — the data it needs from the stream of data that the
CMTS sends out. Cable modems follow a modem standard called DOCSIS,
which stands for Data Over Cable Service Interface Specification. You can buy
any DOCSIS-compliant modem and use it with your cable Internet service; all
you have to do is call the cable company and give them the modem’s identify-
ing information so that the CMTS can recognize and initialize the modem.

In practice, with a cable modem you can get downstream transfer rates of
around 1.5 Mbps and upstream rates of 128 Kbps. These are maximum rates,
and your transfer rate is typically lower, depending on how many users in
your neighborhood are using cable modems at the same time.

If you want to check your downstream transfer speed, go to bandwidthplace.
com/speedtest and click the link to start the test. For my cable modem
connection (for example), the tests reported a downstream transfer rate of
about 1.4 Mbps.
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Typical cable modem setup

To set up cable modem access, your cable TV provider must offer high-speed
Internet access. If the service is available, you can call to sign up. The cable
companies often have promotional offers such as no installation fee or a
reduced rate for three months. Look for these offers. If you are lucky, a local
cable company may have a promotion going on just when you want to sign up.

The installation is typically done by a technician, who splits your incoming
cable into two — one side goes to the TV and the other to the cable modem.
The technician provides information about the cable modem to the cable
company’s head end for setup at its end. When all that is done, you can plug
in your PC’s Ethernet card to the cable modem and you’re all set to enjoy
high-speed Internet access. Figure 7-5 shows a typical cable-modem hookup.
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The cable modem connects to an Ethernet card in your PC. If you don’t have an
Ethernet card in your PC, the cable company technician often provides one.

Here are some key points to note about the cable modem setup in Figure 7-5:

v Split the incoming cable TV signal into two parts by using a two-way
splitter. (The cable company technician installs the splitter.) By the way,
the two-way splitter needs to be rated for 1 GHz; otherwise, it may not
let the frequencies that contain the downstream data from the Internet
pass through.

v Connect one of the video outputs from the splitter to your cable
modem’s F-type video connector using a coaxial cable.

v Connect the cable modem’s 10BaseT Ethernet connection to the
Ethernet card on your PC.

v Connect your TV to the other video output from the two-way splitter.

@“\NG! When you use a cable modem to directly connect your SUSE Linux PC to the
S

Internet, the connection is always on, so you run a greater risk that someone
may try to break into the PC than do dialup users. SUSE Linux includes a fire-
wall, which you may want to use to protect your PC from unwanted Internet
connections. See Chapter 19 for more information on how to enable the firewall.

P To isolate your SUSE Linux PC or local area network from the public Internet,
you may want to add a NAT (Network Address Translation) router between
your PC and the cable modem. One of the NAT router’s network interfaces
connects to the Internet and the other connects to your LAN — the router
then acts as a gateway between your LAN and the Internet. As an added
bonus, you can even share a cable modem connection with all the PCs in
your own local area network (LAN) by adding an Ethernet hub. Better yet,
buy a combination NAT-router-and-hub so you have only one box do the
whole job. By the way, the NAT router/hubs are typically sold under the name
Cable/DSL router because they work with both DSL and a cable modem.

The NAT router translates private Internet Protocol (IP) addresses into a
public IP address. When connected through a NAT router, any PC in the inter-
nal LAN can access the Internet as if it had its own unique IP address. Result:
You can share a single Internet connection among many PCs. (An ideal solu-
tion for an entire family of Net surfers!)

Figure 7-6 shows a typical setup with a cable modem connection being
shared by a number of PCs in a LAN.
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Here are the points to note when setting up a connection like the one shown
in Figure 7-6:

v You need a Cable/DSL NAT router with two 10BaseT Ethernet ports (the
10BaseT port — also known as an RJ-45 jack — looks like a large phone
jack). Typically, one Ethernet port is labeled Internet (or External or WAN
for wide area network), and the other one is labeled Local.

v If you plan to set up a LAN, you also need an Ethernet hub. For a small
home network, you can buy a 4- or 8-port Ethernet hub. Basically, you
want a hub with as many ports as the number of PCs you intend to con-
nect to your local area network.

v Consider buying a single box that acts as both a NAT router and a hub
with a number of Ethernet ports.
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v Connect the video cable to the video input port of the cable modem.

v Connect the Ethernet port of the cable modem to the Internet port of the
NAT router using a 10BaseT Ethernet cable. (These look like phone
wires, except that the Ethernet cables have bigger RJ-45 jacks and are
often labeled Category 5 or Cat 5 wire.)

v Connect the Local Ethernet port of the NAT router to one of the ports on
the Ethernet hub using a 10BaseT Ethernet cable.

v Now connect each of the PCs to the Ethernet hub. Of course, each PC
must have an Ethernet card.

In the next section, I explain how to configure the PCs in such a LAN so that
they can all access the Internet through the router.

Dialing Up the Internet

MBER
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If you don’t have DSL or a cable modem, you can always reach the Internet the
old-fashioned way — you can just dial up your ISP using your PC’s modem (you
need a modem and a phone line for this to work). Connecting your PC to the
Internet through a dialup modem is called dialup networking. In the following
sections, I show you how to set up a dialup network connection to your ISP.

To use a modem to dial up and connect to the Internet, you have to first get
an account with an ISP. Every ISP provides you a phone number to dial, a
username, and a password. Additionally, the ISP gives you the full names of
servers for e-mail and news. Typically, your system automatically gets an IP
address by using a protocol known as DHCP.

Connecting the modem

Modem is a contraction of modulator/demodulator — a device that converts
digital signals (string of 1s and 0s) into continuously varying analog signals
that transmit over telephone lines and radio waves. Thus, the modem is the
intermediary between the digital world of the PC and the analog world of tele-
phones. Figure 7-7 illustrates the concept of a modem.

Inside the PC, 1s and 0s are represented with voltage levels, but signals car-
ried over telephone lines are usually tones of different frequencies. The modem
sits between the PC and the telephone lines and makes data communication
possible over the phone lines. The modem converts information back and
forth between the voltage/no voltage representation of digital circuits and dif-
ferent frequency tones that are appropriate for transmission over phone lines.



Chapter 7: | Want My Internet, Now!

Figure 7-7:
A modem
bridges the
digital world
of PCs and
the analog
world of
telephones.
|

A\

Before you dial out using an external modem, make sure that the modem is
powered on and properly connected to one of the serial or USB ports of your
PC. You must also connect the modem to the telephone line.

Buy the right type of cable to connect the modem to the PC. You need a
straight-through serial cable to connect the modem to the PC. The connec-
tors at the ends of the cable depend on the type of serial connector on your
PC. The modem end of the cable needs a male 25-pin connector. The PC end
of the cable often is a female 9-pin connector. You can buy modem cables at
most computer stores. Often, you can find 9-pin-female-to-25-pin-male modem
cables sold under the label AT Modem Cable. Connect USB modems by using
a USB cable.

If your PC has an internal modem, all you have to do is connect the phone
line to the phone jack at the back of the internal modem card.

Whether your PC has an internal modem or you connect an external modem,
you have to configure the modem.

Configuring the modem

To configure the modem for dialup networking, follow these steps:
1. Choose Main Menu= System=YaST in KDE or Desktop Menu=>YaST in
GNOME.
The YaST Control Center runs, and its main window appears.

2. Click Network Devices on the left pane of the YaST Control Center and
then click Modem on the right pane (see Figure 7-8).
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YaST opens the Modem Configuration window and displays information
about the modem it detects.
3. Click the Edit button and enter any requested information (click Next
to move from one screen to the next).
On the ISP screen, click New and then type the ISP’s phone number as
well as the username and password of your Internet account with the ISP.
(You can guess where to enter these items; just look for the fields labeled
Username, Password, and Phone Number.) Aside from these fields, you
can accept the default settings from the rest of the configuration screens.
After you finish configuring the modem, the Kinternet tool starts, and a
plug icon should appear in the panel, as shown in Figure 7-9 (if the icon
does not appear, select Main Menu=Internet=>Dial-up from the KDE
desktop).
|
Figure 7-9:
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4. Click the KInternet tool’s plug icon to activate the dialup connection.

If the connection does not seem to come up, right-click the Kinternet
icon, select View Log, and look for clues about any problems.
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Setting Up an Ethernet LAN
with Wireless Access

In This Chapter
Setting up an Ethernet LAN
Connecting your LAN to the Internet

Extending your network’s reach with wireless

Checking whether your network is up and running

ou might use an Ethernet network for your local area network (LAN) —

at your office or even your home (if you happen to have several systems
at home). Even if you have a single PC, you may need to set up an Ethernet
network interface so that you can connect your PC to high-speed Internet
access that uses a DSL or cable modem. (I cover DSL and cable modems in
Chapter 7.) In this chapter, I explain how to set up an Ethernet network.

If you want to surf the Internet from anywhere in your home with your laptop
PC, you can do so by adding wireless to your network. In the last part of this
chapter, I show you how to set up wireless networking for connecting to an
Ethernet LAN and accessing the Internet.

Getting a Handle on Ethernet

Ethernet is a standard way to move packets of data between two or more
computers connected to a single hub. (You can create larger networks by
connecting multiple Ethernet segments with gateways.) To set up an Ethernet
local area network (LAN), you need an Ethernet card for each PC. Linux sup-
ports a wide variety of Ethernet cards for the PC.
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Ethernet is a good choice for the physical data-transport mechanism for the
following reasons:

v Ethernet is a proven technology that has been in use since the
early 1980s.

v Ethernet provides good data-transfer rates: Typically 10 million bits per
second (10 Mbps), although 100-Mbps Ethernet and Gigabit Ethernet
(1,000 Mbps) are now available.

v Ethernet hardware is often built in to the PC or can be installed at a rela-
tively low cost. (PC Ethernet cards cost about $10 to $20 U.S.)

v With wireless Ethernet, you can easily connect laptop PCs to your
Ethernet LAN — without having to run wires all over the place. [ explain
wireless Ethernet later in this chapter.

Connecting PCs to an Ethernet LAN

Any time you hear experts talking about Ethernet, you're also going to hear
some bewildering terms used for the cables that carry the data. Here’s a
quick rundown.

Nowadays, the most popular form of Ethernet cabling is unshielded twisted-
pair cable (UTP), known as 10BaseT or 100BaseT (because it can support
data rates up to 100 megabits per second). Other Ethernet cabling options
include 100BaseT4, 100BaseT2, and 100BaseTX for 100 Mbps Ethernet and
1000BaseT for Gigabit Ethernet. The Electronic Industries
Association/Telecommunications Industries Association (EIA/TIA) defines the
following categories of shielded and unshielded twisted-pair cables:

v Category 1 (Cat 1): Traditional telephone cable.
v Category 2 (Cat 2): Cable certified for data transmissions up to 4 Mbps.

v Category 3 (Cat 3): Cable that can carry signals up to a frequency of
16 MHz. Cat 3 is the most common type of wiring in old corporate net-
works and it normally contains four pairs of wire. Considered obsolete
nowadays.

v Category 4 (Cat 4): Cable that can carry signals up to a frequency of 20
MHz. Cat 4 wires are not that common. Considered obsolete nowadays.

v Category 5 (Cat 5): Cable that can carry signals up to a frequency of 100
MHz. Cat 5 cables normally have four pairs of copper wire. Cat 5 UTP is
the most popular cable used in new installations today. This category of
cable is being superceded by Category 5e (enhanced Cat 5).
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v Category 5e (Cat 5e): Similar to Cat 5, but with improved technical para-
meters such as near-end cross talk and attenuation. Cat 5e cables sup-
port 10BaseT, 100BaseT4, 100BaseT2, 100BaseTX, and 1000BaseT
Ethernet. Nowadays Cat 5e is the minimum acceptable wiring.

v Category 6 (Cat 6): Similar to Cat 5e, but capable of carrying signals up
to a frequency of 250 MHz. Cat 6 cables can support all existing Ethernet
standards and are expected to support Gigabit Ethernet standard
1000BaseTX that will use two pairs of wires in each direction as opposed
to all four pairs for 1000BaseT Ethernet over Cat 5e cables.

To set up a 10BaseT or 100BaseT Ethernet network, you need an Ethernet
hub — a hardware box with RJ-45 jacks. (These look like big telephone jacks.)
You build the network by running twisted-pair wires (usually, Category 5, or
Catb, cables) from each PC’s Ethernet card to this hub. You can get a 4-port
10/100BaseT hub for about $40 U.S. Figure 8-1 shows a typical small 10BaseT
or 100BaseT Ethernet LAN that you may set up at a small office or your
home.

Ethernet hub

TEIIEE

Category 5 cables

1

PCs with Ethernet card

When you install SUSE Linux from this book’s companion DVD on a PC that
has an Ethernet card, the Linux kernel automatically detects the Ethernet
card and installs the appropriate drivers. The SUSE Linux installer, YaST, also
lets you set up TCP/IP networking.
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The Linux kernel loads the driver for the Ethernet card every time it boots.
To verify that the Ethernet driver is loaded, type the following command in a
terminal window:

dmesg | grep eth0

On one of my PCs, I get the following output when I type that command:
eth0: RealTek RTL8139 at 0xf0d16000, 00:0c:76:f4:38:b3, IRQ 161
eth0: Identified 8139 chip type 'RTL-8101"'

ethO: link up, 100Mbps, full-duplex, lpa 0x45E1
eth0: no IPv6 routers present

You should see something similar, showing the name of your Ethernet card
and other related information.

Configuring the Ethernet Network

When you set up the network during SUSE Linux installation, the installation
program prepares all appropriate configuration files using the information
you provide. You therefore typically never have to manually configure the
network. However, SUSE Linux comes with GUI tools to configure the network
devices, just in case something needs changing.

To configure the Ethernet network interface, follow these steps:
1. Choose Main Menu~ System=YaST from the KDE desktop (choose
Desktop Menu=>YaST from the GNOME desktop).

This opens the YaST Control Center.

2. Select Network Devices on the left-hand pane of the YaST Control
Center window and Network Card on the right-hand pane.

YaST then brings up a window (shown in Figure 8-2) with information
about the already configured network card and any new network cards
that it detects.

3. Select your network card (assuming it’s not yet configured) and click
Configure. To change an already configured card, click Change.

Provide the requested information such as how the IP address is
obtained (typically, the answer is DHCP or dynamic).
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Connecting Your LAN to the Internet

If you have a LAN with several PCs, you can connect the entire LAN to the
Internet by using DSL or a cable modem. Basically, you can share the high-
speed DSL or cable modem connection with all the PCs in the LAN.

In Chapter 7, I explain how to set up a DSL or cable modem. In this section, I
briefly explain how to connect a LAN to the Internet so that all the PCs can
access the Internet.

The most convenient way to connect a LAN to the Internet via DSL or cable
modem is to buy a hardware device called DSL/Cable Modem NAT Router
with a 4- or 8-port Ethernet hub. NAT stands for Network Address Translation,
and the NAT router can translate many private IP addresses into a single
externally known IP address. The Ethernet hub part appears to you as a
number of RJ-45 Ethernet ports where you can connect the PCs to set up a
LAN. In other words, you need only one extra box besides the DSL or cable
modem.

Figure 8-3 shows how you might connect your LAN to the Internet through a
NAT router with a built-in Ethernet hub. Of course, you need a DSL or cable
modem hookup for this scenario to work (and you have to sign up with the
phone company for DSL service or with the cable provider for cable Internet
service).
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When you connect a LAN to the Internet, the NAT router acts as a gateway for
your LAN. The NAT router also dynamically provides IP addresses to the PCs
in your LAN. Therefore, on each PC, you have to set up the networking
options to obtain the IP address dynamically.

Your LAN can mix and match all kinds of computers — some may be running
Linux and some may be running Microsoft Windows or any other operating
system that supports TCP/IP. When configuring the network settings, remem-
ber to select the option that enables Linux to automatically obtain IP address
settings and DNS information with DHCP.

Extending Vour LAN with
a Wireless Network

If you have a laptop computer that you want to connect to your LAN — or if
you don’t want to run a rat’s nest of wires to connect a PC to the LAN — you
have the option of using a wireless Ethernet network. In a typical scenario,
you have a cable modem or DSL connection to the Internet, and you want to
connect one or more laptops with wireless network cards to access the
Internet through the cable or DSL modem. In the following sections, I explain
wireless networking and how to set it up on your network.
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Understanding wireless
Ethernet networking

You've probably heard about Wi-Fi. Wi-Fi stands for Wireless Fidelity network —
a short-range wireless network similar to the wired Ethernet networks. A
number of standards from an organization known as IEEE (the Institute of
Electrical and Electronics Engineers) defines the technical details of how Wi-Fi
networks work. Manufacturers use these standards to build the components
that you can buy to set up a wireless network, also known as WLAN for short.

Until mid-2003, there were two popular IEEE standards — 802.11a and
802.11b — for wireless Ethernet networks. These two standards were final-
ized in 1999. A third standard — 802.11g — was finalized by the IEEE in the
summer of 2003. All these standards specify how the wireless Ethernet net-
work works over the radio waves. You don’t have to fret over the details of
these standards to set up a wireless network, but knowing some pertinent
details is good so that you can buy the right kind of equipment for your wire-
less network.

The three wireless Ethernet standards have the following key characteristics:

+~ 802.11b: Operates in the 2.4 GHz radio band (2.4 GHz to 2.4835 GHz) in
up to three nonoverlapping frequency bands or channels. Supports a
maximum bit rate of 11 Mbps per channel. One disadvantage of 802.11b
is that the 2.4 GHz frequency band is crowded — many devices such as
microwave ovens, cordless phones, medical and scientific equipment, as
well as Bluetooth devices — all work within the 2.4 GHz frequency band.
Nevertheless, 802.11b is very popular in corporate and home networks.

v~ 802.11a: Operates in the 5 GHz radio band (5.725 GHz to 5.850 GHz) in
up to eight nonoverlapping channels. Supports a maximum bit rate of
54 Mbps per channel. The 5 GHz band is not as crowded as the 2.4 GHz
band, but the 5 GHz band is not approved for use in Europe. Products
conforming to the 802.11a standard are available on the market, and
wireless access points are designed to handle both 802.11a and 802.11b
connections.

v~ 802.11g: Supports up to 54 Mbps data rate in the 2.4 GHz band. (The
same band that 802.11b uses.) 802.11g achieves the higher bit rate by
using a technology called OFDM (orthogonal frequency-division multi-
plexing), which is also used by 802.11a. Although 802.11g was only
recently finalized, equipment that complies with it is already on the
market. That’s because 802.11.g has generated excitement by working in
the same band as 802.11b but promising much higher data rates and by
being backward-compatible with 802.11b devices. Vendors currently
offer access points that can support both the 802.11b and 802.11g con-
nection standards.
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There is a third standard — 802.11n — under development that would support
100-Mbps data rates in either the 2.4 GHz or the 5 GHz band, depending on
which of the two proposals garner the required membership approval. Two
equally matched groups of companies — known by the titles TGn Sync (Task
Group n Synchronization) and WWiSE (Worldwide Spectrum Efficiency) —
have each authored proposals for the 802.11n standard. TGn Sync proposes to
use the 5 GHz band, the same one used by 802.11a, whereas WWiSE’s proposal
is for the 2.4 GHz that’s used by 802.11b and g. Both groups agree that some
form of multiple input multiple output (MIMO, pronounced “my-mo”) antenna
technology would be needed to achieve the 100-Mbps data rate. (Some MIMO
access points are already becoming available on the market.) At a May 2005
balloting, the TGn Sync proposal obtained the majority votes, but it did not
receive the 75 percent votes required to be the basis for the first draft. You
can read the latest news about the IEEE 802.11n project at grouper.ieee.
org/groups/802/11/Reports/tgn_update.htm.

If you are buying a new wireless access point, get an 802.11g one. An 802.11g
access point can also communicate with older (and slower) 802.11b devices.
You can also consider a MIMO access point that supports multiple 802.11
standards and implements techniques for getting higher throughputs and
better range.

The maximum data throughput that a user actually sees is much less because
all users of that radio channel share the capacity of the channel. Also, the
data transfer rate decreases as the distance between the user’s PC and the
wireless access point increases.

To find out more about wireless Ethernet, visit www.wi-£fi.org, the home
page of the Wi-Fi Alliance — a nonprofit international association formed in
1999 to certify interoperability of wireless LAN products based on IEEE 802.11
standards.

Understanding infrastructure
and ad hoc modes

The 802.11 standard defines two modes of operation for wireless Ethernet
networks: infrastructure and ad hoc. Ad hoc mode is simply two or more wire-
less Ethernet cards communicating with each other without an access point.

Infrastructure mode refers to the approach in which all the wireless Ethernet
cards communicate with each other and with the wired LAN through an
access point. For the discussions in this chapter, | assume that you set your
wireless Ethernet card to infrastructure mode. In the configuration files, this
mode is referred to as managed mode.
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Understanding Wired Equivalent
Privacy (WEP)

The 802.11 standard includes Wired Equivalent Privacy (WEP) for protecting
wireless communications from eavesdropping. WEP relies on a 40-bit or 104-bit
secret key that is shared between a mobile station (such as a laptop with a wire-
less Ethernet card) and an access point (also called a base station). The secret
key is used to encrypt data packets before they transmit, and an integrity
check is performed to ensure that packets are not modified in transit. The
802.11 standard does not explain how the shared key is established. In prac-
tice, most wireless LANs use a single key that is shared between all mobile sta-
tions and access points. Such an approach, however, does not scale up very
well to an environment such as a college campus because the keys are shared
with all users — and you know how it is if you share a “secret” with hundreds
of people. That’s why WEP is typically not used on large wireless networks
such as the ones at universities. In such wireless networks, you have to use
other security approaches such as SSH (Secure Shell) to log in to remote sys-
tems. WEP, however, is good to use on your home wireless network.

WEP has its weaknesses, but it’s better than nothing. You can use it in smaller
wireless LANs where sharing the same key among all wireless stations is not
an onerous task.

Work is underway to provide better security than WEP for wireless networks.
A standard called 802.11i is in the works that provides better security
through public-key encryption. While the 802.11i standard is in progress, the
Wi-Fi Alliance — a multivendor consortium that supports Wi-Fi — has devel-
oped an interim specification called Wi-Fi Protected Access (WPA) that’s a
precursor to 802.11i. WPA replaces the existing WEP standard and improves
security by making some changes. For example, unlike WEP (which uses fixed
keys), the WPA standard uses something called the Temporal Key-Integrity
Protocol (TKIP), which generates new keys for every 10K of data transmitted
over the network. TKIP makes WPA more difficult to break. In 2004, the Wi-Fi
Alliance introduced a follow-on to WPA called the Wi-Fi Protected Access 2
(WPA2) — the second generation of WPA security. WPA2 is based on the final
IEEE 802.11i standard, which uses public key encryption with digital certifi-
cates and an authentication, authorization, and accounting RADIUS (Remote
Authentication Dial-In User Service) server to provide better security for
wireless Ethernet networks. WPA2 uses the Advanced Encryption Standard
(AES) for data encryption.
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Setting up the wireless hardware

To set up the wireless connection, you need a wireless access point and a
wireless network card in each PC. You can also set up an ad hoc wireless
network among two or more PCs with wireless network cards, but that is a
stand-alone wireless LAN among those PCs only. In this section, I focus on the
scenario where you want to set up a wireless connection to an established
LAN that has a wired Internet connection through a cable modem or DSL.

In addition to the wireless access point, you also need a cable modem or DSL
connection to the Internet, along with a NAT router/hub. Figure 84 shows a
typical setup for wireless Internet access through an existing cable modem or
DSL connection.

As Figure 8-4 shows, the LAN has both wired and wireless PCs. In this exam-
ple, either a cable or DSL modem connects the LAN to the Internet through a
NAT router/hub. Laptops with wireless network cards connect to the LAN
through a wireless access point attached to one of the RJ-45 ports on the
hub. To connect desktop PCs to this wireless network, you can use a USB
wireless network card (which connects to a USB port).

If you have not yet purchased a NAT router/hub for your cable or DSL con-
nection, consider buying a router/hub that has a built-in wireless access
point.

To Internet
Ethernet cable
(10BaseT)

"""""""""""""" Wireless aptop PC
Access with wireless
Point Ethernet card

=

Cable or DSL modem

Ethernet cables
(10BaseT)

PCsin a local area network (LAN).
Each PC must have a 10BaseT
Ethernet card.
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Configuring the wireless access point

Configuring the wireless access point involves the following tasks:

1~ Setting a name for the wireless network (the technical term is ESSID).

v Setting the frequency or channel on which the wireless access point
communicates with the wireless network cards. The access point and
the cards must use the same channel.

v Deciding whether to use encryption.

v~ If encryption is to be used, setting the number of bits in the encryption
key and the value of the encryption key. For the encryption key, 24 bits
are internal to the access point; you specify only the remaining bits. Thus,
for 64-bit encryption, you have to specify a 40-bit key, which comes to ten
hexadecimal digits (a hexadecimal digit is an integer from 0 through 9 or a
letter from A through F). For a 128-bit encryption key, you specify 104 bits,
or 26 hexadecimal digits.

v~ Setting the access method that wireless network cards must use when
connecting to the access point. You can opt for either open access
or shared key. The open-access method is typical (even when using
encryption).

v~ Setting the wireless access point to operate in infrastructure (managed)
mode (because that’s the way you connect wireless network cards to an
existing Ethernet LAN).

The exact method of configuring a wireless access point depends on the
make and model; the vendor provides instructions to configure the wireless
access point. You typically work through a graphical client application on a
Windows PC to do the configuration. If you enable encryption, make note of
the encryption key; you have to specify that same key for each wireless net-
work card on your laptops or desktops.

Configuring wireless networking

On your SUSE Linux laptop, the PCMCIA manager recognizes the wireless net-
work card and loads the appropriate driver for the card (PCMCIA or PC Card
is the name of the plug-in card devices). Linux treats the wireless network
card like another Ethernet device and assigns it a device name such as eth0
or ethl. If you already have an Ethernet card in the laptop, that card gets the
eth0 device name, and the wireless PC card becomes the ethl device.

When you plug in the wireless Ethernet PC Card, SUSE Linux detects the hard-
ware and prompts you if you want to configure the network card. Click Yes
and YaST prompts you for the root password. Then YaST opens the network
card configuration window. You should see the wireless Ethernet card listed,
as shown in Figure 8-5.
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From the screen shown in Figure 8-5, follow these steps:

1. Click Add (see Figure 8-5).

YaST displays the Manual Network Card Configuration screen. If the card
was not correctly detected, click Select from List and select the card
from the list that appears. Click Next to continue. YaST displays the
Network Address Setup screen. You can click Next to leave this at the
default setting of automatic address setup via DHCP (Dynamic Host
Configuration Protocol). YaST displays the Wireless Network Card
Configuration screen (see Figure 8-6).

. Enter the needed wireless network card parameters and click OK.

You can leave the Operating Mode as Managed, but you do have to enter
certain parameters to enable the wireless network card to communicate
with the wireless access point. For example, you have to specify the
wireless network name assigned to the access point — and the encryp-
tion settings must match those on the access point.

That should get the wireless card ready to go.

To check the status of the wireless network interface, type su - to become
root and then type the following command:

iwconfig
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Here’s a typical output from a SUSE Linux laptop with a wireless Ethernet PC

card:
lo no wireless extensions.
eth0 no wireless extensions.
ethl IEEE 802.11-DS ESSID:"HOME" Nickname:"linux"

Mode:Managed Frequency:2.437GHz Access Point: 00:30:AB:06:2E:50
Bit Rate:11Mb/s  Tx-Power=15 dBm Sensitivity:1/3

Retry limit:4 RTS thr:off  Fragment thr:off

Encryption key:AECF-AQ0F-03

Power Management:off

Link Quality:50/92 Signal level:-39 dBm Noise level:-89 dBm

Rx invalid nwid:0 Rx invalid crypt:0 Rx invalid frag:0

Tx excessive retries:0 Invalid misc:0 Missed beacon:0

Here the ethl interface refers to the wireless network card. I edited the
encryption key and some other parameters to hide those details, but the
sample output shows you what you’d typically see when the wireless link is
working.

Checking Whether Vour Network Is Up

Regardless of whether you use a dialup modem or a cable modem or DSL to
connect to the Internet, sometimes you need to find out whether the network
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is working. SUSE Linux includes several commands to help you monitor and
diagnose problems. These tasks are best done by typing commands in a ter-
minal window. I explain a few useful network commands.

Checking the network interfaces

Use the /sbin/ifconfig command to view the currently configured net-
work interfaces. The i fconfig command is used to configure a network
interface (that is, to associate an IP address with a network device). If you
run ifconfig without any command line arguments, the command displays
information about current network interfaces. The following is typical output
when you type /sbin/ifconfig in a terminal window:

eth0 Link encap:Ethernet HWaddr 00:08:74:E5:C1:60
inet addr:192.168.0.6 Bcast:192.168.0.255 Mask:255.255.255.0
inet6 addr: fe80::208:74ff:fee5:c160/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:93700 errors:0 dropped:0 overruns:1 frame:0
TX packets:74097 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:33574333 (32.0 Mb) TX bytes:8832457 (8.4 Mb)
Interrupt:10 Base address:0x3000

ethl Link encap:Ethernet HWaddr 00:02:2D:8C:F8:C5
inet addr:192.168.0.8 Bcast:192.168.0.255 Mask:255.255.255.0
inet6 addr: fe80::202:2dff:fe8c:f8c5/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:3403 errors:0 dropped:0 overruns:0 frame:0
TX packets:22 errors:1 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:254990 (249.0 Kb) TX bytes:3120 (3.0 Kb)
Interrupt:3 Base address:0x100

lo Link encap:Local Loopback
inet addr:127.0.0.1 Mask:255.0.0.0
inet6 addr: ::1/128 Scope:Host
UP LOOPBACK RUNNING MTU:16436 Metric:1
RX packets:3255 errors:0 dropped:0 overruns:0 frame:0
TX packets:3255 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:2686647 (2.5 Mb) TX bytes:2686647 (2.5 Mb)

This output shows that three network interfaces — the loopback interface
(10) and two Ethernet cards (eth0 and ethl) — are currently active on this
system. For each interface, you can see the IP address, as well as statistics on
packets delivered and sent. If the SUSE Linux system has a dialup link up and
running, you also see an item for the ppp0 interface in the output.
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Checking the 1P routing table

Another network configuration command, /sbin/route, provides status
information when it is run without any command line argument. If you're
having trouble checking a connection to another host (that you specify with
an [P address), check the IP routing table to see whether a default gateway is
specified. Then check the gateway’s routing table to ensure that paths to an
outside network appear in that routing table.

A typical output from the /sbin/route command looks like the following:

/sbin/route

Kernel IP routing table

Destination Gateway Genmask Flags Metric Ref Use Iface
192.168.0.0 @ 255.255.255.0 U 0 0 0 etho
192.168.0.0 & 255.255.255.0 U 0 0 0 ethl
169.254.0.0 @ 255.255.0.0 U 0 0 0 ethl
127.0.0.0 @ 255.0.0.0 U 0 0 0 lo
default 192.168.0.1 0.0.0.0 UG 0 0 0 etho

As this routing table shows, the local network uses the eth0 and ethl
Ethernet interfaces, and the default gateway is the eth0 Ethernet interface.
The default gateway is a routing device that handles packets addressed to
any network other than the one in which the Linux system resides. In this
example, packets addressed to any network address other than those begin-
ning with 192.168.0 are sent to the gateway — 192.168.0.1. The gateway for-
wards those packets to other networks (assuming, of course, that the
gateway is connected to another network, preferably the Internet).

Checking connectivity to a host

To check for a network connection to a specific host, use the ping command.
ping is a widely used TCP/IP tool that uses a series of Internet Control Message
Protocol (ICMP, pronounced eye-comp) messages. ICMP provides for an Echo
message to which every host responds. Using the ICMP messages and replies,
ping can determine whether or not the other system is alive and can compute
the round-trip delay in communicating with that system.

The following example shows how I run ping to see whether a system on my
network is alive:

ping 192.168.0.1

135
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Here is what this command displays on my home network:

PING 192.168.0.1 (192.168.0.1) 56(84) bytes of data.
64 bytes from 192.168.0.1: icmp_seqg=1 ttl=63 time=0.256 ms

64 bytes from 192.168.0.1: icmp_seg=2 ttl=63 time=0.267 ms
64 bytes from 192.168.0.1: icmp_seqg=3 ttl=63 time=0.272 ms
64 bytes from 192.168.0.1: icmp_seqg=4 ttl=63 time=0.267 ms
64 bytes from 192.168.0.1: icmp_seg=5 ttl=63 time=0.275 ms

--- 192.168.0.1 ping statistics ---
5 packets transmitted, 5 received, 0% packet loss, time 3999ms
rtt min/avg/max/mdev = 0.256/0.267/0.275/0.016 ms

In SUSE Linux, ping continues to run until you press Ctrl+C to stop it; then
it displays summary statistics showing the typical time it takes to send a
packet between the two systems. On some systems, ping simply reports
that a remote host is alive. However, you can still get the timing information
by using appropriate command line arguments.

The ping command relies on ICMP messages that many firewalls are config-
ured to block. Therefore, ping may not always work and is no longer a reli-
able way to test network connectivity. If ping fails for a specific host, do not
assume that the host is down or not connected to the network. You can still
use ping to successfully check connectivity within your local area network.
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In this part . . .

5) what’s this SUSE Linux thing good for? Can you do
anything useful with it? This part answers your ques-
tions about how to do some productive (and maybe even
entertaining) work in SUSE Linux. | cover a number of
things that you might want to do with a computer —
browse the Web, e-mail, read newsgroups, and do office
work (write reports, prepare spreadsheets, and make pre-
sentations). I also describe some fun things such as play-
ing music, burning CDs, and using digital cameras. Finally,
[ introduce you to the shell and the command line. (GUI
desktops are great, but in a pinch, you need to know what
to do at the command prompt.)




Chapter 9
Browsing the Web

In This Chapter
Discovering the World Wide Web
Understanding a URL
Taking stock of Web browsers in SUSE Linux
Web browsing with Konqueror in KDE
Web browsing with Mozilla in GNOME
Introducing Epiphany and Firefox in GNOME

ou probably already know about the Web, but did you know that the

Web, or more formally the World Wide Web, made the Internet what it is
today? The Internet has been around for quite a while, but it did not reach a
mass audience until the Web came along in 1993.

Before the Web came along, you had to use arcane UNIX commands to down-
load and use files, which were simply too complicated for most of us. With
the Web, however, anyone can enjoy the benefits of the Internet by using a
Web browser — a graphical application that downloads and displays Web
documents. A click of the mouse is all you need to go from reading a docu-
ment from your company Web site to downloading a video clip from across
the country.

In this chapter, I briefly describe the Web and introduce you to the Web
browsers in KDE and GNOME. In KDE, the primary Web browser is
Konqueror, which also doubles as a file manager. In GNOME, you have a
choice of three Web browsers — Mozilla, Firefox, and Epiphany. [ introduce
you to all of these Web browsers in this chapter, but after you have used one
Web browser, you can easily use any other Web browser.

Understanding the World Wide Web

If you have used a file server at work, you know the convenience of sharing
files. You can use the word processor on your desktop to get to any docu-
ment on the shared server.
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Now imagine a word processor that enables you to open and view a document
that resides on any computer on the Internet. You can view the document in its
full glory, with formatted text and graphics. If the document makes a reference
to another document (possibly residing on yet another computer), you can
open that linked document by clicking the reference. That kind of easy access
to distributed documents is essentially what the World Wide Web provides.

Of course, the documents have to be in a standard format, so that any com-
puter (with the appropriate Web browser software) can access and interpret
the document. And a standard protocol is necessary for transferring Web
documents from one system to another.

The standard Web document format is Hypertext Markup Language (HTML),
and the standard protocol for exchanging Web documents is Hypertext
Transfer Protocol (HTTP). HTML documents are text files and don’t depend on
any specific operating system, so they work on any system from Windows
and Mac to any type of UNIX and Linux.

A Web server is software that provides HTML documents to any client that
makes the appropriate HTTP requests. A Web browser is the client software
that actually downloads an HTML document from a Web server and displays
the contents graphically.

Links and URLs

Like the pages of real books, Web pages contain text and graphics. Unlike real
books, however, Web pages can include multimedia, such as video clips, sound,
and links to other Web pages that can actually take you to those Web pages.

The links in a Web page are references to other Web pages that you can
follow to go from one page to another. The Web browser typically displays
these links as underlined text (in a different color) or as images. Each link is
like an instruction to you — something like, “For more information, please
consult Chapter 4,” that you might find in a real book. In a Web page, all you
have to do is click the link; the Web browser brings up the referenced page,
even though that document may actually reside on a faraway computer
somewhere on the Internet.

The links in a Web page are referred to as hypertext links because when you
click a link, the Web browser jumps to the Web page referenced by that link.

This arrangement brings up a question. In a real book, you might refer the
reader to a specific chapter or page in the book. How does a hypertext link
indicate the location of the referenced Web page? In the World Wide Web,
each Web page has a special name, called a Uniform Resource Locator (URL).
A URL uniquely specifies the location of a file on a computer. Figure 9-1 shows
the parts of a URL.
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As Figure 9-1 shows, a URL has the following parts:

v Protocol: Name of the protocol that the Web browser uses to access the
data from the file the URL specifies. In Figure 9-1, the protocol is
http://, which means that the URL specifies the location of a Web
page. Here are some of the common protocol types and their meanings:

e file:// means the URL is pointing to a local file. You can use this
URL to view HTML files without having to connect to the Internet.
For example, file:///srv/www/html/index.html opens the
file /srv/www/html/index.html from your Linux system.

e ftp:// means that you can download a file using the File Transfer
Protocol (FTP). For example, ftp://ftp.purdue.edu/pub/
uns/NASA/nasa. jpg refers to the image file nasa. jpg from the
/pub/uns/NASA directory of the FTP server ftp.purdue. edu. If
you want to access a specific user account via FTP, use a URL in
the following form:

ftp://username: passwordeftp.somesite.com/

with the username and password embedded in the URL. (Note that
the password is in plain text and not secure.)

® http:// means that the file is downloaded using the Hypertext
Transfer Protocol (HTTP). This protocol is the well-known format
of URLs for all Web sites, such as http://www.novell.com for
Novell’s home page. If the URL does not have a filename, the Web
server sends a default HTML file named index.html. (That’s the
default filename for the popular UNIX-based Apache Web servers;
Microsoft Windows Web servers use a different default filename.)

https:// specifies that the file is accessed through a Secure
Sockets Layer (SSL) connection — a protocol designed by
Netscape Communications for encrypted data transfers across the
Internet. This form of URL is typically used when the Web browser
sends sensitive information (such as a credit card number, user-
name, and password) to a Web server. For example, a URL such as

https://some.site.com/secure/takeorder.html



142 Ppartint: Doing St with SUSE

may display an HTML form that requests credit card information
and other personal information (such as name, address, and phone
number).

emailto:// specifies an e-mail address that you can use to send an
e-mail message. This URL opens your e-mail program from where
you can send the message. For example, mailto:webmaster@
someplace. com refers to the Webmaster at the host
someplace.com.

® news: // specifies a newsgroup that you can read by means of the
Network News Transfer Protocol (NNTP). For example,

news://newsgroups.comcast.net/comp.os.linux.setup

accesses the comp.os.linux.setup newsgroup at the news
server newsgroups .comcast .net. If you have a default
news server configured for the Web browser, you can omit the
news server’s name and use the URL news : comp.os.linux.
setup to access the newsgroup.

v Domain name: Contains the fully qualified domain name of the com-
puter that has the file this URL specifies. You can also provide an IP
address in this field. The domain name is not case-sensitive.

v Port: Port number that is being used by the protocol listed in the first
part of the URL. This part of the URL is optional; all protocols have
default ports. The default port for HTTP, for example, is 80. If a site con-
figures the Web server to listen to a different port, the URL has to
include the port number.

v Directory path: Directory path of the file being referred to in the URL.
For Web pages, this field is the directory path of the HTML file. The
directory path is case-sensitive.

v Filename: Name of the file. For Web pages, the filename typically ends
with .htm or .html. If you omit the filename, the Web server returns a
default file (often named index.html). The filename is case-sensitive.

v HTML anchor: Optional part of the URL that makes the Web browser
jump to a specific location in the file. If this part starts with a question
mark (?) instead of a hash mark (#), the browser takes the text following
the question mark to be a query. The Web server returns information
based on such queries.

Web servers and Web browsers

The Web server serves up the Web pages, and the Web browser downloads
them and displays them to the user. That’s pretty much the story with these
two cooperating software packages that make the Web work.
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In a typical scenario, the user sits in front of a computer that’s connected to
the Internet and runs a Web browser. When the user clicks a link or types a
URL into the Web browser, the browser connects to the Web server and
requests a document from the server. The Web server sends the document
(usually in HTML format) and ends the connection. The Web browser inter-
prets and displays the HTML document with text, graphics, and multimedia
(if applicable). Figure 9-2 illustrates this typical scenario of a user browsing
the Web.

Web Server

— 1 0 Web server sends
'|$ back the requested
Web page

Web Browser

|
Figure 9-2:
The Web
browser
requests
documents,
and the
Web server
sends them.
|

Web browser connects
to the server and
requests a Web page

The Web browser’s connection to the Web server ends after the server sends
the document. When the user browses through the downloaded document
and clicks another hypertext link, the Web browser again connects to the
Web server named in the hypertext link, downloads the document, ends the
connection, and displays the new document. That’s how the user can move
from one document to another with ease.

SMBER

A Web browser can do more than simply “talk” HTTP with the Web server —

in fact, Web browsers can also download documents using FTP, and many

have integrated mail and newsreaders as well.
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Web Browsing in SUSE Linux

Web browsing is fun because so many of today’s Web pages are so full of graph-
ics and multimedia. Then there’s the element of surprise — you can click a link
and end up at an unexpected Web page. Links are the most curious (and
useful) aspect of the Web. You can start at a page that shows today’s weather
and a click later, you can be reading this week’s issue of Time magazine.

To browse the Web, all you need is a Web browser and an Internet connec-
tion. I assume that you've already taken care of the Internet connection (see
Chapter 7 if you haven’t yet set up your Internet connection), so all you need
to know are the Web browsers in SUSE Linux.

SUSE Linux comes with the Firefox Web browser. Firefox is Mozilla’s next-
generation browser that blocks popup ads, provides tabs for easily viewing
multiple Web pages in a single window, and includes a set of privacy tools. On
KDE desktops you can also use the Konqueror file manager as a Web browser.
Both Firefox and Konqueror are intuitive to use. I introduce them in the next
few sections.

Web Browsing with Konqueror

Konqueror is not only a file manager, but also a Web browser. Konqueror
starts with a Web browser view if you start Konqueror by clicking the Web
browser icon on the KDE panel (mouse over and read the help balloon to find
it). On the other hand, if you start Konqueror by clicking the home folder
icon (the second icon from left on the KDE panel), you can switch to a Web
browser view by choosing Settings=>Load View Profilec>Web Browsing from
Konqueror’s menu. Yet another way to start the Konqueror Web browser is to
select Main Menu=Internet=>Web Browser=>Web Browser (Konqueror) from
the KDE desktop.

To browse the Web using Konqueror, click the Web browser button on the
KDE panel. Konqueror starts with the initial Web browser view that shows
Konqueror’s About page — a Web page with information about Konqueror
itself, as shown in Figure 9-3.

To visit a specific Web page, simply enter the URL (the “link™) in the Location
bar (refer to Figure 9-3). You can type the URL without the http: // prefix.
For example, if the URL is http://www.irs.gov, you can simply type
www.irs.gov in the Location bar and then press Enter. Konqueror opens the
new Web page in a new tab.
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To open another tab to load a new Web page, choose Location=>New Tab
from the Konqueror menu. You can then type a new URL in the Location box,
and that Web page appears in the new tab. Figure 9-4 shows Konqueror’s Web
browser view with a few Web pages loaded in different tabs (notice the tabs
just below the Location field). This style of browsing is called tabbed Web
browsing and, as you can see, Konqueror can do tabs. By the way, you can
switch between Web pages by clicking the tabs.

Figure 9-4 shows the key parts of the Konqueror Web browser’s window. Here
is a quick rundown of some of the features:

v Search: You can perform a Google search by typing search words in the
text field on the right end of the Location bar.

v Font size: Click the magnifying glass icon to increase or decrease the
font size.

v Tabs: Click the button on the left end of the tabs to open a new tab, and
the one on the rightmost edge to close the current tab.

v Clone window: Click the K button on the top right to clone the current
Konqueror window, including all the tabs.

v Location: Type the URL in the Location bar and press Enter or click the Go
button (on the right end of the Location bar) to load that URL. To clear the
Location bar, click the button with an X at the left end of the Location bar.

Play around with Konqueror and you will realize that it’s more powerful than
it first appears.
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You can start Firefox by choosing Main Menu>Internetz>Web Browser=>
Web Browser (Firefox) from the GUI desktop.
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When Firefox starts, it displays a browser window with a default home page.
(The home page is a Web page that a Web browser loads when you first start it.)
You can configure Firefox to use a different Web page as the default home page.

Figure 9-5 shows a Web page from a U.S. government Web site (www.gao.gov),
as well as the main elements of the Firefox browser window. Note that Firefox
supports tabbed browsing, which means that you can open a new tab (by
pressing Ctrl+T or by selecting File>’New Tab) and view a Web page in that tab.
That way, you can view multiple Web pages in a single window.
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Getting familiar with Firefox

The Firefox Web browser includes lots of features in its user interface, but
you can master it easily. You can turn off some of the items that make it look
busy. You can also start with just the basics to get going with Firefox and then
gradually expand to areas that you haven’t yet explored.

Firefox toolbars

Starting from the top of the window, you see a menu bar with the standard
menus (File, Edit, and so forth), followed by the two toolbars — the
Navigation toolbar and the Bookmarks toolbar. The area underneath the
Bookmarks toolbar is where the current Web page appears.

Here’s what you can do with the buttons on the Navigation toolbar that
appear just below the menu bar, from left to right:

v Back: Move to the previous Web page.

v Forward: Move to the page from which you may have gone backward.
v Reload: Reload the current Web page.

v~ Stop: Stop loading the current page.

v Home Page: Open the home page (you can change the home page from
the Edit=>Preferences menu).

v Location text box: Show the URL of the current Web page. (Type a URL
in this box to view that Web page.)

v Go: Go to the URL typed in the Location text box.

v Google Search: Click to display search engines; type text and press
Enter to search using currently selected search engine (default search
engine is Google).

Immediately below the Navigation toolbar is the Bookmarks toolbar with but-
tons that take you to specific Web pages.

Status bar

You can think of the bar along the bottom edge of the Firefox window as the
status bar because the left part of that area displays status information as
Firefox loads a Web page.

In the right corner of Firefox’s status bar, a security padlock icon appears when
you access a secure Web site. Firefox supports a secure version of HTTP that
uses a protocol called Secure Sockets Layer (SSL) to transfer encrypted data
between the browser and the Web server. When Firefox connects to a Web
server that supports secure HTTP, a locked security padlock icon appears on
the right edge of the status bar. Otherwise the security padlock is open, signify-
ing an insecure connection. The URL for secure HTTP transfers begins with
https:// instead of the usual http: //. (Note the extra s in https.)
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Firefox displays status messages in the left part of the status bar. You can
watch the messages in this area to see what’s going on. If you mouse over a
link on the Web page, the status bar displays the URL for that link.

Firefox menus

[ haven’t mentioned the Firefox menus much. That’s because you can usually
get by without having to go to them. Nevertheless, taking a quick look through
the Firefox menus is worthwhile so you know what each one offers. In partic-
ular, you can use the Edit>Preferences menu to change settings such as your
home page.

Changing your home page

Your home page is the Web page that Firefox loads when you start it. By
default, Firefox displays a blank page. Changing the home page is easy.

First locate the page on the Web that you want to be the home page. You can
get to that page any way you want. You can search with a search engine to
find the page you want, you can type the URL in the Location text box, or you
may even accidentally end up on a page that you want to make your home
page. It doesn’t matter.

When you’re viewing the Web page that you want to make your home page in

Firefox, choose Edit=>Preferences from the Firefox menu. The Preferences
dialog box appears, as shown in Figure 9-6.
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On the right side of Figure 9-6, notice the Home Page section of preferences.
There you see a Location text box for the home page, and underneath the
address is a Use Current Page button. Click that button to make the current
page your home page.

You can set a lot of other options using the Preferences window. Although I
don’t explain all the options, you can click around to explore everything that
you can do from this window. For example, you can click the Use Bookmark
button to select a saved URL bookmark as the home page (you have to select
the bookmark from a dialog box).
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E-Mailing, IM-ing, and Using
IP Phone in SUSE

In This Chapter

Understanding electronic mail

Taking stock of mail readers and IM (instant messaging) clients
Introducing KMail

Introducing Evolution

Instant messaging with Kopete and GAIM

Making IP telephone calls

Eectronic mail (e-mail) is a mainstay of the Internet. E-mail is great
because you can exchange messages and documents with anyone on the
Internet. You can send messages anywhere in the world, and that message
typically makes its way to its destination within minutes, if not seconds —
something you cannot do with paper mail (also appropriately known as snail
mail). I love e-mail because | can communicate without having to play “phone
tag,” in which two people can leave telephone messages for each other with-
out ever successfully making contact.

SUSE Linux comes with several mail clients — also called mail readers — that
can download mail from your Internet service provider (ISP). You can also
read and send e-mail using these mail clients. In this chapter, | introduce you
to the primary mail clients for the KDE and GNOME desktops. When you
know one of these mail clients, you can easily use any of the mail readers.

There is another type of “keeping in touch” that’s more in line with the
twenty-first century. I'm talking about /M — instant messaging. IM is basically
one-to-one chat, and SUSE Linux includes IM clients that can work with many
instant messaging protocols such as AOL Instant Messenger (or AIM), MSN
Messenger, ICQ, Jabber, Yahoo!, Gadu-Gadu, IRC (Internet Relay Chat), and
SMS (Short Message Service or text messaging). I briefly describe the pri-
mary IM clients for KDE and GNOME desktops in this chapter.
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IP telephony is yet another method of communicating with others. SUSE
Linux comes with IP telephony applications such as KPhone and Linphone.
This chapter briefly introduces you to IP telephony and how to use Linphone
and KPhone to make voice phone calls over the Internet.

Understanding E-Mail

E-mail messages are addressed to a username at a host (host is just a fancy
name for an online computer). That means if John Doe logs in with the user-
name jdoe, e-mail to him is addressed to jdoe. The only other piece of infor-
mation needed to identify the recipient uniquely is the fully qualified domain
name of the recipient’s system. Thus, if John Doe’s system is named some
place.com, his complete e-mail address becomes jdoe@someplace.com.
Given that address, anyone on the Internet can send e-mail to John Doe.

How MUA and MTA work

The two types of mail software are

1 Mail-user agent (MUA) is the fancy name for a mail reader — a client
that you use to read your mail messages, write replies, and compose
new messages. Typically, the mail-user agent retrieves messages from
the mail server by using the POP3 or IMAP4 protocol. POP3 is the Post
Office Protocol Version 3, and IMAP4 is the Internet Message Access
Protocol Version 4. In SUSE Linux, the KDE desktop uses KMail as the
mail-user agent, and GNOME provides Evolution.

v Mail-transfer agent (MTA) is the fancy name for a mail server that actu-
ally sends and receives mail-message text. The exact method used for
mail transport depends on the underlying network. In TCP/IP networks,
the mail-transport agent delivers mail using the Simple Mail-Transfer
Protocol (SMTP). You need an MTA only if your system is going to be a
mail server. Specifically, you do not need an MTA if all you want to do is
read and send mail via your ISP’s mail server.

Figure 10-1 shows how the MUAs and MTAs work with one another when
Alice sends an e-mail message to Bob. (In case you didn’t know, using Alice
and Bob to explain e-mail and cryptography is customary — just pick up any
book on cryptography and you’ll see what I mean.) And you may already know
this, but the Internet is always diagrammed as a cloud — the boundaries of
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Figure 10-1:
How Alice
sends
e-mail to
Bob (or all
about MUAs
and MTAs).

the Internet are so fuzzy that a cloud seems just right to represent it. (Or is it
because no one knows where it starts and where it ends?)

The scenario in Figure 10-1 is typical of most people. Alice and Bob both con-
nect to the Internet through an ISP and get and send their e-mail through their
ISPs. When Alice types a message and sends it, her mail-user agent (MUA)
sends the message to her ISP’s mail-transfer agent (MTA) using the Simple
Mail-Transfer Protocol (SMTP). The sending MTA then sends that message to
the receiving MTA — Bob’s ISP’'s MTA — using SMTP. When Bob connects to
the Internet, his MUA downloads the message from his ISP’s MTA using the
POP3 (or IMAP4) protocol. That’s the way mail moves around the Internet —
from sending MUA to sending MTA to receiving MTA to receiving MUA.

Alice’s ISP’s
Alice’s mail user mail transfer
agent (MUA) < agent (MTA)
MTA
SMTP Bob’s ISP
MTA
Internet

POP3 or IMAP4
; Bob’s MUA

Bob
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Mail message enhancements

Mail messages used to be plain text (and most still are), but many messages
today have much more than text. Two typical new features of today’s mail are

v HTML messages: Mail messages can be in HTML (Hypertext Markup
Language), the language used to lay out Web pages. When you read an
HTML message on a capable mail reader, the message appears in its full
glory with nice fonts and embedded graphics.

v Attachments: Many messages today include attached files, which can be
anything from documents to images. The recipient can save the attach-
ment on disk or open it directly from the mail reader. Unfortunately,
attachments are one way hackers try to get viruses and worms into your
PC. (If it’s any consolation, most Windows-based viruses and worms do
not work in Linux.)

While HTML messages are nice, they are a perfect tool for hackers phishing
for information. As you might know, phishing is a new term for hackers trying
to coax personal information out of people. Often hackers send professional-
looking HTML messages that might claim to be from your bank, credit card
company, or eBay and ask you to click what looks like an authentic link to
update your personal information. If you click the link, you typically end up
at a Web site that’s a sophisticated fake of a bank or a credit card site that
then prompts you for information such as name, date of birth, address, bank
account number, credit card number, and so on. If you are reading HTML
mail, be careful of any messages that urge you to update personal informa-
tion. More than likely, it’s from a hacker on a phishing trip.

If you have an ISP account, all you need is a mail client (mail reader) to
access your e-mail. In this case, your e-mail resides on your ISP’s server, and
the mail reader downloads mail when you run it. You have to do some setup
before you can start reading mail from your ISP’s mail server. The setup
essentially requires you to enter information that you get from your ISP —
the mail server’s name, server type (POP3, for example), your username, and
your password.

E-Mailing in SUSE Linux

Each GUI desktop has a default e-mail client. The KDE desktop uses KMail, and
the GNOME desktop offers Evolution. In the following sections, I briefly intro-
duce you to KMail and Evolution. All mail clients are intuitive to use, so you
don’t need much more than an introduction to start using them effectively.
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Introducing KMail

KMail is a mail reader for KDE. To start KMail, choose Main Menu=Internet=
E-Mail. When you first run KMail, you get its main window, but you cannot
start using it to send and receive e-mail until you have configured the mail
accounts in KMail.

To configure KMail, follow these steps:

1. Choose Settings=>Configure KMail.
The Configure KMail window appears.
2. Click Accounts on the left pane of the window.

The Setup for Sending and Receiving Messages screen appears (see
Figure 10-2).
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Identities Receiving Sending
P’ Outgoing accounts (add at least one):
=S .
Accounts Name Type Add...
Appearance
¥
L8
Composer
Jra) ~Commaon Options
|_| Confirm before send
Security
Q Send messages jn outbox Telder: | Never Automatically |v
Default send method: Send MNow |v
Misc
Message property: MIME Compliant (Quoted Printable) |v
Default domain: lirux:
@ Hep || Defaults | Load Profile.. | |4 Beset || oK | % Cancel

3. Click the Sending tab for outgoing mail and then click the Add button.
A dialog box prompts you for the mail-transport agent.
4. Select the mail-transport agent and click OK.

Typically, for an ISP-provided mail account, you should select SMTP. A
dialog box prompts you for information about the mail server.
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5. Enter the mail server’s name and click OK.

This is the mail server that your ISP wants you to use when sending
messages (for example, smtp.comcast .net).

. Click the Receiving tab for incoming mail and click Add.
A dialog box prompts you for the mail protocol, such as POP3 or IMAP.
. Select the mail protocol and click OK.

Most ISPs want you to use POP3 or IMAP as the mail protocol. Make
your selection based on your ISP’s instructions. After you click OK, a
dialog box prompts for further information about your mail account.

. Enter the information about your ISP mail account and click OK.

You typically have to enter the mail server’s name (for example, mail.
comcast .net) as well as the username and password for your mail
account.

9. Click OK in the Configure KMail window.

After the e-mail account information is set up, you can start using KMail. The
user interface is intuitive, as shown in Figure 10-3. KMail periodically checks
and downloads messages from your incoming mail accounts. You can view

messages as they arrive in your Inbox.
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Introducing Evolution Mail

If you use the GNOME desktop, Evolution is the default e-mail client. To start
con on the GNOME desktop’s top panel (mouse over and

Evolution, click the i
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read the help balloon to locate the icon) or choose Main Menur>Officer>
Evolution.

When you start Evolution for the first time, the Evolution Setup Assistant
window appears, as shown in Figure 10-4.

Evolution Setup Assistant

Welcome to Evolution. The next few screens will allow
Evolution to connect to your emall accounts, and to import files
from other applications.

|
Figure 10-4:
Evolution
Setup
Assistant
guides you
through the
initial setup.
|

Please click the "Forward" button to continue,

| X Cancel 4 gack

Click Forward in the Welcome screen, and the Setup Assistant guides you
through the following steps:

1. Enter your name and e-mail address in the Identity screen and click
the Forward button.

For example, if your e-mail address is jdoe@someplace. com, that’s
what you enter.

2. Set up the options for receiving e-mail and click Forward.

Select the type of mail download protocol — most ISP accounts offer
either POP or IMAP. Then provide the name of the mail server (for exam-
ple, mail.comcast.net). You are prompted for the password when
Evolution connects to the mail server for the first time.

3. Provide further information about receiving e-mail — how often to
check for mail and whether to leave messages on the server — and
then click Forward.

Typically, you want to download the messages and delete them from the
server (otherwise the ISP complains when your mail piles up).
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4. Set up the following options for sending e-mail and click Forward
when you’re done:

e Select the server type as SMTP.
¢ Enter the name of the ISP’s mail server such as smtp.comcast .net.

e If the server requires you to log in, select the Server Requires
Authentication check box.

e If the server requires authentication, enter your username —
the same username you use to log in to your ISP’s mail server.
(Often you don’t have to log in to send mail; you only log in when
receiving — downloading — mail messages.)

5. Give this mail account a descriptive name; click Forward.
The default name is the same as your e-mail address.

6. Set your time zone by clicking a map; click Forward.

7. Click Apply to complete the Evolution setup.

After you complete the setup, Evolution opens its main window and displays
the e-mail view, as shown in Figure 10-5.
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The window has a menu bar and a toolbar. The main display area is vertically
divided into two panes: a narrow pane on the left (with a number of shortcut
icons at the bottom), and a bigger right pane where Evolution displays infor-

mation relevant to the currently selected shortcut icon. In Figure 10-5,
Evolution displays the Inbox.
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You can click the icons in the lower part of the left pane to switch to different
views. Here’s what happens when you click each of the four shortcut icons in
Evolution:

v Mail: Switches to mail display, where you can read mail and send mail.

v~ Contacts: Opens your contact list, where you can add new contacts or
look up someone from your current list.

v Calendars: Opens your calendar, where you can look up and add
appointments.

v Tasks: Shows your task (“to do”) list, where you can add new tasks and
check what’s due when.

As this icon summary shows, Evolution has all the necessary components of
a PIM — e-mail, contacts, calendar, and task lists.

To access your e-mail, click the Mail icon and then click Inbox on the left
pane. Evolution opens your inbox, as shown in Figure 10-5. If you turn on the
feature to automatically check for mail every so often, Evolution prompts you
for your mail password and downloads your mail. To manually download
mail, just click the Send/Receive button on the toolbar (if you haven’t asked
Evolution to store your password, it prompts you for your mail password).

The e-mail Inbox looks very much like any other mail reader’s inbox, such as
the Outlook Express Inbox. Most of the time, you can click the toolbar but-
tons to do most anything you want to do with the e-mail messages. If you
have used any GUI mail reader — from Microsoft Outlook Express to Novell
GroupWise — you find Evolution’s toolbar buttons familiar.

To read a message, click the message in the upper window of the Inbox and
the message text appears in the lower window.

To reply to the current message, click the Reply button on the toolbar (or
click Reply to All to send a reply to all the addressees). A message composi-
tion window pops up. You can write your reply and then click the Send
button on the message composition window’s toolbar to send the reply.
Simple, isn’t it?

To send a new e-mail, select New=>Mail Message on the Evolution toolbar. A
new message composition window appears; you can type your message in
that window, and when you're finished composing the message, click Send.

Evolution comes with extensive online help. Choose Helpr>Contents from the
Evolution menu, and the Evolution User Guide appears in a window. You can
then read the user guide in that window.
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Instant Messaging in SUSE Linux

Figure 10-6:
Enter
information
about your
messaging
accounts in
this window.
|

Instant messaging (IM) is kind of like a phone call in that you can communicate
with others in real-time. The difference is that instead of talking, you type your
messages in an IM client application. Both you and the person you are commu-
nicating with see each line of text right after you type it and press Enter. The IM
client also enables you to post an Away message that lets others know that you
are online but not available for conversation. Behind the scenes, instant mes-
saging needs a central server that keeps track of all the online users and that
facilitates sending the typed text between the parties engaged in messaging.
That central server comes from an IM service. Some popular IM services
include IRC, AIM, Yahoo! Messenger, MSN Messenger, and ICQ. You have to get
an account with one of these IM services and sign in before you can exchange
instant messages with others on that service. After you sign in, you can find
out if your friends are online and send messages via the IM client.

There are two major IM clients in SUSE Linux. In KDE desktops, you can use
Kopete, whereas GAIM is a commonly used IM client for the GNOME desktop.
[ briefly describe both IM clients in the following sections.

Using Kopete

Kopete — the KDE IM client — enables you to connect to many messaging
services including AIM, IRC, MSN Messenger, Yahoo!, Gadu-Gadu, and SMS.

To start Kopete, choose Main Menuw>Internet>Chat from the KDE desktop (if
you have more than one messaging program installed, you have to select
Kopete from a next-level menu). When you first run Kopete, you get the
Configure Kopete window (see Figure 10-6), where you can enter information
about your IM and other messaging service accounts.

T
X

ok # Cance
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Figure 10-8:
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For example, to add your AIM account information, click New and then
answer and respond to the prompts from the Account Wizard. The first step
is to select your messaging service. (See Figure 10-7.)

Step One: Select the Messaging Service(s)

select the messaging service(s) for which you would
like to add accounts from the list below.

Name | Description
mwum col to connect to AIM
[ FGaduGadu  Protocel to connect to Gadu-Gadu
@Gmupw.se Novell GroupWise Messsnger
gFico Frotocol to connect to ICQ
“glRC Protocel te connect to IRC
! Q Jabber Protocol to connect to |abber
il W' MSN Messenger Protocol to connect to MSKN Mess. ..
& sms Protocol to send SMS messages
¥ vahoo Protocel to connect o Yahoo
| # Help {3 Back | &) Next # Cancel

Select the appropriate messaging service, such as AIM if you use AOL’s instant
messaging service. Then provide the AIM screen name and the password. You
can also enable the option to have Kopete remember your password. If you
choose that option, you're prompted to set up KWallet — the KDE Wallet
System — that stores passwords and other information in an encrypted file.
Figure 10-8 shows the initial screen of the KWallet setup. Just click Next, con-
firm that you really want to use KWallet, and enter, guess what, another pass-
word. The idea is that you'd enter that single password to open your KDE
wallet that stores many more passwords and other sensitive information.

KDE Wallet Wizard -

Introduction

KWallet - The KDE Wallet System

Welcome to KWallet the KDE Wallet System. KWallet allows you to store your
passwords and other personal informatien on disk in an encrypted file, preventing
others fram viewing the information. This wizard will tell you about KWallet and help
you configure it for the first ime,

(@ Basic setup (recommended)

() Advanced setup

Lancel
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After you have set up your messaging service accounts, the Account Wizard
closes, and you get the regular Kopete window. To sign on with your messag-
ing services and begin using Kopete, click the Connect button — the leftmost
button on the toolbar — in the Kopete window. (See Figure 10-9.)

File Edit Settings Help

Q%P

E» Search:

= Buddies =™
= = Recent Buddies (1)
L momliea &

Click the magnifying glass icon to see your buddies. You see a solid smiley
face icon for buddies who are online. Click on an online buddy to start chat-
ting. Choose Filec>Add Contact to add more contacts.

Well, if you know AIM, you know what to do: Have fun IM-ing with Kopete!

Using GAIM

You can use GAIM to keep in touch with all of your contacts on many differ-
ent IM services such as AIM, ICQ, Yahoo!, MSN, Gadu-Gadu, and Jabber. If you
use any of the IM services, you'll be right at home with GAIM.

From the SUSE GNOME desktop, start GAIM by choosing Main Menu=>
Internet~>Chat=>GAIM Internet Messenger. The initial GAIM window appears
together with an Accounts window, as shown in Figure 10-10.
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Start by setting up your messaging accounts in the Accounts window. Click
the Add button, and then fill in the requested information in the Add Account
window, as shown in Figure 10-11, and click Save. Note that you have to select
the protocol for your IM service. For example, the protocol for AIM is
AIM/ICQ. Other protocol choices include Gadu-Gadu, Jabber, MSN, and
Yahoo!, among others.
[+ Add Account %]
Login Options
Protocol: A& AIM/ICQ S
Screen Name: |dadiea
Password: FEERT LN
Alias:
~ Remember password
— User Options
Fiqure 10-11 New mail notifications
igu -11: ]
9 Enter Buddy Icon: ngen == Remove
information v Show more options
about each
IM account. X cancel || [Elsave
|

After you enter account information, the Accounts window shows all cur-
rently defined accounts. You can then select an account from the GAIM main
window and click Sign On, as shown in Figure 10-12.
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Account:
— | | A& dadiea (AIM/ICQ) s
Figure 10-12: | p.coword:
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After GAIM logs you in, it opens the standard Buddy List window. (See
Figure 10-13.)

5 Buddytist  _JOIX
Buddies Tools Help
< Recent Buddies (1/1)
mom1liea
|
Figure 10-13:
A Buddy List
window
in GAIM. || GJ ® 2
M Get Info  Chat Away

To add buddies, choose Buddies=>Add Buddy. In the Add Buddy window that
appears, enter the screen name of the buddy and click Add. To create a new
group, choose Buddies=>Add Group. Type the name of the new group in the
Add Group window that appears and then click Add.

If any of your buddies are online, their names show up in the Buddy List
window. To send a message to a buddy, double-click the name, and a message
window pops up. If someone sends you a message, a message window pops
up with the message, and you can begin conversing in that window.
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Making 1P Telephone Calls in SUSE Linux
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You may have heard about VoIP (Voice over Internet Protocol) — a technol-
ogy that converts analog voice signals into digital data packets that can then
be sent over the Internet to its destination, where the data packets are con-
verted back to analog audio. VoIP, also known as IP telephony, enables voice
communications over the Internet, and applications are available to make
such IP telephone calls from your SUSE Linux system. As you might guess
from my rough description of VoIP, you need a way to get your voice into the
computer and listen to the voice signals from the person you are talking to.
Your system’s sound card (with a microphone plugged in for voice input) and
the speakers attached to the sound card can take care of the audio side of the
phone call. If you want to routinely make IP phone calls, you may want to buy
a headset with a built-in headphone and microphone.

Internet telephones use one of two protocols — H.323 and SIP (Session
Initiation Protocol) — for sending voice over IP networks. H.323 is an older
protocol that’s supported by Microsoft Netmeeting and GnomeMeeting (avail-
able in SUSE Linux’s GNOME desktop). SIP is an Internet standard protocol,
and many IP telephony devices and applications support it. For example,
KPhone and Linphone — two IP telephony programs included in SUSE Linux —
support SIP. For SIP-compliant IP telephony applications, you have to use a
SIP URL with the syntax sip: user@hostname or sip:user@IPaddress
(where IPaddress is an IP address) to identify the person you are calling.

A SIP phone application can call another directly, provided that both applica-
tions can reach each other on the IP network. For example, on my home LAN, I
can start KPhone on a Linux PC with the IP address 192.168.0.2 and use the
URL sip:naba@192.168.0.6 to call a user on another system on the LAN.
Similarly, you can call anyone else running a SIP phone application on a system
with a public IP address. To call other SIP phones on the Internet and receive
incoming calls without having to know everyone’s public IP address (or to do
so in cases in which the systems are behind firewalls or NAT routers), you need
to register with a registration service such as FreeWorldDialup, or FWD

(www . freeworlddialup.com), which is a free service. When you register
with FWD, you get a username, password, and a six-digit SIP number. That SIP
number is what others use to call you. For example, if your FWD number is
NNNNNN, your SIP URL is sip : NNNNNN@fwd.pulver.com.

For a list of other public SIP servers and information on how you can register
and what the SIP URL looks like, see www . 1linphone.org/doc/us/servers.
html and www.cs.columbia.edu/sip/servers.html. You can also find
lots of useful IP telephony links at www.cs.columbia.edu/sip/ and
www.voip-info.org/tiki-index.php.
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Typically many home LANs and PCs are behind a NAT router, so your PC does
not have a public IP address. To get over this problem, you can use STUN
(Simple Traversal of UDP over NAT), which is a protocol that enables an IP
phone to get information from a public STUN server about your NAT and
automatically modify the [Paddress and port so that the phone call works
through the NAT. If the IP telephony application does not support STUN, you
can use what is known as an outbound proxy — another public server that
enables IP telephone calls to work over a NAT. FWD provides a STUN server
at stun. fwdnet.net:3478 and an outbound proxy server at fwdnat .
pulver.com:5082. You need this information to configure IP telephony
applications such as KPhone and Linphone.

Using KPhone or Linphone

You can use the KPhone or Linphone application to make IP phone calls in
SUSE Linux. If either of these applications is not installed, you can install
each by running the YaST Control Center. Select the Software category and
click Software Management. Then search for the application’s name (for
example, Linphone), select the package, and click Accept.

To make IP phone calls with KPhone or Linphone, here are the general, high-
level steps:

1. Connect the microphone to the sound card and test it with the sound
recorder application.

If you are using a headset, test the headset as well by playing an audio CD.
2. Register with a public SIP server such as FreeWorldDialup (FWD).

[ use FWD as an example in this section.
3. Start KPhone or Linphone and configure them.

If you use FWD, click the appropriate KPhone link in the configu-
ration guide available at www. freeworlddialup.com/support/
configuration_guide. For Linphone, the configuration is similar.

4. Test the SIP phone application.

For example, if you are using FWD, first open the following URL in a Web
browser http://fwd.pulver.com/myicon.php?userid=NNNNNN
(where NNNNNN is your FWD number) and check that you are online.
Then dial 613 (just the numbers in KPhone or sip:613@fwd.pulver.
com in Linphone) to try the echo service — this service repeats back
whatever you say.
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5. Call anyone else who has a SIP URL.

Note that you can call U.S. toll-free numbers by dialing the number this
way: *1(8xx) xxx xxxx. For example, to dial 1-800-123-4567, enter *1(800)
123 4567 in KPhone or Linphone.

As a concrete example, here is how I configure and use Linphone to make IP
telephone calls after I registered at FreeWorldDialup:

1. I select Main Menu=>Internet=>Telephone=Linphone from the KDE
desktop.

The Linphone window appears. If everything were configured, I could
simply start making calls by entering a SIP URL in the text box. However,
I need to configure some SIP parameters first.

2. I select Go=>Preferences from Linphone’s main menu.

The Parameters dialog box appears (see Figure 10-14). I can configure
various parameters through the four tabs: Network, Sound device, SIP,
and Codecs. I leave most paramaters in their default setting, but I have
to configure some parameters in the SIP tab (refer to Figure 10-14)
before I can make any calls.

[ twe pulver com|

sip {59090

Remote services

Server adoress

o Add proxy/registrar

Authenticanon mrormaton

&l Ciear ol stared authentication infarmation (usermarn

of eely | X Close | Pox

e

3. I click the check box labeled Automatically guess a valid hostname and
make sure that there is no checkmark.

I can now enter my SIP URL in the Your sip address textbox.
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Figure 10-15:
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4. I type my 6-digit FWD number and fwd.pulver.com in the Your sip
address text box.

5. I click the Add proxy/register button.
The Proxy/Registrar configuration dialog box appears (see Figure 10-15).

% Proxy/Registrar configuration buxx_:’.-‘

Proxy/Reqistrar configuration box

Send registration: X

Registration Period: 300 .
SIP Identity: sip:123456i@fwd.pulver.col
SIP Proxy: sip:fwd.pulver.com

Route (optional):

Publish presence Information:

e &P ok

6. [ fill in the required information (see Figure 10-15). I make sure that the
Send registration check box is checked. I enter my SIP identity as
sip:NNNNNN@fwd.pulver.com, where NNNNNN is my FWD number. [
type sip:fwd.pulver.com in the SIP proxy field. Then I click OK.

After the Proxy/Registrar dialog box closes, [ am back at the Linphone
main window.

7. I enter the SIP URL for the person I want to call and click the Call or
Answer button.

Linphone displays a dialog box that prompts me for my FWD password
(the other fields are already filled in, and I leave the userid field blank).
After I type the password and click OK, Linphone starts the call (see
Figure 10-16).

Go Help

Sip address:

siprBl3@twd pulver.com | - %
Proxy to use: sip:fwd. pulver.com -
Call or Release or

Answer Refuse

] %D show more...

Contacting sip:613@fwd pulver.com

For example, I can enter the SIP URL sip:613@fwd.pulver.com to test
my setup. That number is FWD’s echo service that repeats back what-
ever [ say.
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Now I can make calls to anyone else with a SIP URL. For someone with

a public IP address, I could make the call with a URL of the form sip:
username@IPaddress, assuming that I know that person’s username and
the system’s IP address.

Another way to test Linphone on your own system (without having to call
anyone else) is to type sipomatic in a terminal window. The program starts
and prints some status messages. Then, type sip:robot@localhost:5064 in the
Linphone window and click the Call or Answer button. After a second, the
sipomatic program should answer, and you should hear a short audio
announcement over the speaker.

Using Skype

Skype is another popular IP telephony application that uses proprietary peer-
to-peer (P2P) protocol and has a large number of users. You can download
Skype for SUSE Linux from www . skype.com/products/skype/linux/.
What you download is an RPM file that you can install by typing rpm -ivh
skype-*-suse.i586.rpm in a terminal window (after typing su - to become
root). After that, you can start Skype by selecting Main Menu=Internet=>
More Programs=>Skype from the GUI desktop.

When you start Skype, Skype displays a dialog box that prompts you to log
in. If you don’t have a Skype account yet, click the New Users tab (see
Figure 10-17), fill in the required information, and click Next.

pu
Q’ Create a new Skype account

Mew Users - Create a Skype Account I Existing Users - Login to Skype

+ Choose Skype Name

Your E-mail Address

Xes, | have read and | acceptthe Skype End User Licence Agresment

Cancel
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Skype logs you in and displays its main window (see Figure 10-18). From then
on, whenever you run Skype, you can log in using the Skype username and
password. Skype works much the same way as instant messaging or chat
applications, such as AIM, that also require you to log in to a server, except
that you can make voice calls to other users currently logged in to Skype. Not
surprisingly, you can also chat with other Skype users.

S Skype ™ - nabaleha =

File WView Tools Call Help
Qe Q0ho R

& Contacts | /| Dial ,}-CuIIList

| ungrouped buddies (1/1)

Eyservices

o

3" 2 051 GB4 Users Online

To make phone calls, first add one or more contacts to the Contacts list. To
add a contact, click the plus sign on the toolbar and fill in your contact’s
Skype user Skype name and other requested information in the dialog box
that appears.

To call a contact, click the Skype name from the contact list and click the
phone. Skype then dials that user (that user’s PC should ring), and when that
user answers, you can talk using your headset or microphone.

You can call other Skype users for free, but to call normal telephone numbers
you have to use a fee-based service called SkypeOut, which enables you to
call normal telephone numbers at a reduced rate. To use SkypeOut, you have
to sign in to the Skype Web site and buy SkypeOut credits by using a credit
card. Then you can use the SkypeOut credits to make phone calls from Skype
to regular phone numbers.
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Reading Newsgroups
and RSS Feeds

In This Chapter

Understanding newsgroups

Reading newsgroups from your ISP using KNode and Pan
Reading and searching newsgroups at some Web sites
Reading RSS feeds

Internet newsgroups are like the bulletin board systems (BBSs) of the pre-
Web age or the forums offered on online systems such as AOL and MSN.
Essentially, newsgroups provide a distributed conferencing system that
spans the globe. You can post articles — essentially e-mail messages to a
whole group of people — and respond to articles others have posted.

Think of an Internet newsgroup as a gathering place — a virtual meeting
place where you can ask questions and discuss various issues (and best of
all, everything you discuss gets archived for posterity).

To participate in newsgroups, you need access to a news server — your
Internet service provider (ISP) can give you this access. You also need a
newsreader. SUSE Linux comes with software that you can use to read news-
groups. In this chapter, I introduce you to newsgroups and show you how to
read newsgroups with KNode and Pan newsreaders. I also briefly explain how
you can read and search newsgroups for free at a few Web sites.

Nowadays, another popular way to read summaries of Web sites and weblogs
is to use a program that can accept RSS feeds. At the end of this chapter, I
briefly describe what an RSS feed is and how you can use a program such as
the KDE Akregator to subscribe to RSS feeds and read them on your SUSE
Linux system.
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Understanding Newsgroups

Newsgroups originated in Usenet — a store-and-forward messaging network
that was widely used for exchanging e-mail and news items. Usenet works like
a telegraph in that news and mail are relayed from one system to another. In
Usenet, the systems are not on any network; the systems simply dial up one
another and use the UNIX-to-UNIX Copy Protocol (UUCP) to transfer text
messages.

Although it’s a very loosely connected collection of computers, Usenet works
well and continues to be used because very little expense is involved in con-
necting to it. All you need is a modem and a site willing to store and forward
your mail and news. You have to set up UUCP on your system, but you don’t
need a sustained network connection; just a few phone calls are all you need
to keep the e-mail and news flowing. The downside of Usenet is that you
cannot use TCP/IP services such as the Web, TELNET, or FTP with UUCP.

From their Usenet origins, the newsgroups have now migrated to the Internet
(even though the newsgroups are still called Usenet newsgroups). Instead of
UUCP, the Network News Transfer Protocol (NNTP) now transports the news.

Although (for most of the online world) the news transport protocol has
changed from UUCP to NNTP, the store-and-forward concept of news transfer
remains. Thus, if you want to get news on your SUSE Linux system, you have
to find a news server from which your system can download news. Typically,
you can use your ISP’s news server.

Newsgroup hierarchy

The Internet newsgroups are organized in a hierarchy for ease of mainte-
nance as well as ease of use. The newsgroup names help keep things straight
by showing the hierarchy.

Admittedly, these newsgroup names are written in Internet-speak, which can
seem rather obscure at first. But the language is pretty easy to pick up with a
little bit of explanation. For example, a typical newsgroup name looks like this:

comp.os.linux.announce
This name says that comp.os.linux.announce is a newsgroup for

announcements (announce) about the Linux operating system (os . 1inux)
and that these subjects fall under the broad category of computers (comp).
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Figure 11-1:
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As you can see, the format of a newsgroup name is a sequence of words sepa-
rated by periods. These words denote the hierarchy of the newsgroup. Figure
11-1 illustrates the concept of hierarchical organization of newsgroups.

H E B comp H B N socC
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Cable-tv

linux
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announce

setup
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I

ms-windows

]
| ]
| ]

To understand the newsgroup hierarchy, compare the newsgroup name with
the pathname of a file (for example, /usr/1ib/X11/xinit/Xclients) in
Linux. Just as a file’s pathname shows the directory hierarchy of the file, the
newsgroup name shows the newsgroup hierarchy. In filenames, a slash (/)
separates the names of directories; in a newsgroup’s name, a period (.) sepa-
rates the different levels in the newsgroup hierarchy.

In a newsgroup name, the first word represents the newsgroup category.
The comp . os.1inux.announce newsgroup, for example, is in the comp
category, whereas alt.books.technical is in the alt category.

Top-level newsgroup categories

Table 11-1 lists some of the major newsgroup categories. You find a wide vari-
ety of newsgroups covering subjects ranging from politics to computers. The
Linux-related newsgroups are in the comp. os.1inux hierarchy.
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Table 11-1

Major Newsgroup Categories

Category

Subject

alt

“Alternative” newsgroups (not subject to any
rules), which run the gamut from the mundane
to the bizarre

bionet

Biology newsgroups

bit

Bitnet newsgroups

biz

Business newsgroups

clari

Clarinet news service (daily news)

comp

Computer hardware and software newsgroups
(includes operating systems such as Linux and
Microsoft Windows)

ieee

Newsgroups for the Institute of Electrical and
Electronics Engineers (IEEE)

k12

Newsgroups devoted to elementary and sec-
ondary education

linux

Newsgroups devoted to Linux

misc

Miscellaneous newsgroups

news

Newsgroups about Internet news
administration

rec

Recreational and art newsgroups

sci

Science and engineering newsgroups

socC

Newsgroups for discussing social issues and
various cultures

talk

Discussions of currentissues (think
“talk radio”)

This short list of categories is deceptive because it doesn’t really tell you
about the wide-ranging variety of newsgroups available in each category. The
top-level categories alone number close to a thousand, but many top-level
categories are distributed only in specific regions of the world. Because each
newsgroup category contains several levels of subcategories, the overall
count of newsgroups runs over 50,000! The comp category alone has more

than 1,200 newsgroups.

Unfortunately, many newsgroups are flooded with spam, just like your e-mail
Inbox, only worse because anyone can post anything on a newsgroup. Some
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newsgroups, called moderated newsgroups, offer some relief. Anyone who
wants to post on a moderated newsgroup must first submit the article to a
moderator — a human being — who can then decide whether to post the
article or reject it. You can reduce the spam overload by browsing moderated
newsgroups whenever possible.

Some Linux-related newsgroups

Typically, you have to narrow your choice of newsgroups according to your
interests. If you're interested in Linux, for example, you can pick one or more
of these newsgroups:

V¥ comp.os.linux.admin: Information about Linux system administration.

v comp.os.linux.advocacy: Discussions about promoting Linux.

V¥ comp.os.linux.announce: Important announcements about Linux.
This newsgroup is moderated, which means you must mail the article to
a moderator, who then posts it to the newsgroup if the article is appro-
priate for the newsgroup. (This method keeps the riff-raff from clogging
up the newsgroup with marketing pitches.)

V¥ comp.os.linux.answers: Questions and answers about Linux. All the
Linux HOWTOs are posted in this moderated newsgroup.

v comp.os.linux.development: Current Linux development work.
v comp.os.linux.development.apps: Linux application development.

v comp.os.linux.development.system: Linux operating system
development.

V¥ comp.os.linux.hardware: Discussions about Linux and various
types of hardware.

v comp.os.linux.help: Help with various aspects of Linux.
V¥ comp.os.linux.misc: Miscellaneous Linux-related topics.
V¥ comp.os.linux.networking: Networking under Linux.
V¥ comp.os.linux.setup: Linux setup and installation.

V¥ comp.os.linux.x: Discussions about setting up and running the X
Window System under Linux.

You have to be selective about what newsgroups you read because keeping up
with all the news is impossible, even in a specific area such as Linux. When you
first install and set up Linux, you might read newsgroups such as comp.os.
linux.help, comp.os.linux.setup, comp.os.linux.hardware, and
comp.os.linux.x (especially if you run X). After you have Linux up and
running, you may want to find out about only new things happening in Linux.
For such information, read the comp. os.1inux.announce newsgroup.
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Reading Newsgroups from Your ISP
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If you sign up with an ISP for Internet access, it can provide you with access
to a news server. Such Internet news servers communicate by using the
Network News Transfer Protocol (NNTP). You can use an NNTP-capable
newsreader, such as KNode or Pan, to access the news server and read
selected newsgroups. Using a newsreader is the easiest way to access news
from your ISP’s news server.

My discussion of reading newsgroups assumes that you obtained access to a
news server from your ISP. The ISP provides you the name of the news server
and any username and password needed to set up your news account on the
newsreader you use.

To read news, you need a newsreader — a program that enables you to select
a newsgroup and view the items in that newsgroup. You also have to under-
stand the newsgroup hierarchy and naming conventions (which I describe in
the “Newsgroup hierarchy” section, earlier in this chapter). Now I show you
how to read news from a news server.

If you don’t have access to newsgroups through your ISP, you can try using
one of the many public news servers out there. For a list of public news
servers, visit NewzBot at www.newzbot . com. At this Web site, you can
search for news servers that carry specific newsgroups.

Taking stock of newsreaders in SUSE Linux

Depending on the desktop — KDE or GNOME — that you run, you get a differ-
ent default newsreader. Here are the two newsreaders you’d be using in SUSE
Linux:

v KNode: A GUI newsreader that the KDE desktop offers as the default
newsreader.

v Pan: A GUI newsreader that, according to the developer’s Web site (pan.
rebelbase.com),”. .. attempts to be pleasing to both new and experi-
enced users.” Pan is the default newsreader on the GNOME desktop.

Introducing KNode

The KDE desktop in SUSE uses KNode as its default newsreader. In SUSE,
choose Main Menu=Internet=>Usenet News Reader (if you have more than
one news reader installed, you have to select KNode from a next-level menu).
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When KNode runs for the first time, it brings up the Configure KNode dialog

box, shown in Figure 11-2, through which you can configure everything

needed to read newsgroups and post items to newsgroups. The left-hand side
of the dialog box shows all the items that you can configure, and the right-
hand side is where you enter the information for the item that you have cur-

rently selected on the right-hand side.
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Follow these steps to set up the news account:

1. Enter your identification information (refer to Figure 11-2).

Chapter 11: Reading Newsgroups and RSS Feeds

Your identification information such as name, e-mail address, and orga-
nization is used when you post a new item to a newsgroup. A dialog box
appears.

. Click Accounts on the left pane and then click Add on the Newsgroup

Servers tab.

The New Account dialog box appears, as shown in Figure 11-3.

. Enter information about your news server.

Your ISP should have provided you with the information needed to
access the news server. If the news server requires a login name and a
password, check the Server Requires Authentication box to enable the
User and Password fields, and enter your user information.

177
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4. Click OK.

The Configure KNode dialog box closes, and you can start using KNode.

After you set up the news account, the KNode window shows the name of the
news server in its left-hand side. Right-click on the server’s name and select
Subscribe to Newsgroups from the pop-up menu. If you have not yet sub-
scribed to any newsgroup, a dialog box asks if you want to download a list of
newsgroups. Click Yes, and then a dialog box appears where you can sub-
scribe to selected newsgroups (such as comp.os.linux.announce), as

shown in Figure 11-4.
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After you finish selecting newsgroups, click OK. The KNode window now
shows the list of subscribed newsgroups. If you click on a newsgroup, KNode
downloads the list of messages for that newsgroup and displays the list. You
can then read the messages one by one. Just click on the subject line, and the
message appears in the lower pane (see Figure 11-5).
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Figure 11-5 shows a typical view of the KNode window while reading an arti-
cle from one of the subscribed newsgroups. The KNode user interface is simi-
lar to many other mail and newsreaders, including the Pan newsreader in
GNOME.

Introducing Pan

If you have installed the GNOME desktop, Pan is your default newsreader. To
start Pan, choose Main Menu=Internet=>Usenet News Reader=>Pan
Newsreader from the GNOME desktop’s top panel.

When you first run Pan, the Pan Setup Wizard starts and prompts you for
information. Follow these steps to complete the setup:
1. Click Forward at the welcome message.

The Pan Setup Wizard prompts you for identifying information about
yourself.
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2. Enter your name and e-mail address, and then click Forward.

The Pan Setup Wizard prompts you for information about the news
server, as shown in Figure 11-6.
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3. Enter the requested information (refer to Figure 11-6) and click
Forward.

Your ISP should provide you with the news server’s name as well as any
username or password you need to access the newsgroups. After you
click Forward, the Pan Setup Wizard prompts you for your mail server.

4. Enter the name of the mail server that you use to send mail through
your ISP account and click Forward.

Pan uses the mail server when you want to reply to news items.
5. Click Save.

The Pan Setup Wizard saves the settings and returns to Pan.

The Pan window appears, and a dialog box asks if you want to download a
list of groups. Click Yes.

Pan downloads the list of newsgroups and displays it in the left-hand side of
its main window, as shown in Figure 11-7. An easy way to get to your desired
newsgroup is to enter the first part of the newsgroup name (for example,
comp .news . linux) in the Find box in the toolbar and press Enter. Pan dis-
plays the newsgroups that contain the text you entered.
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You can then click a newsgroup to download the headers from that group.
Pan displays the headers in the upper-right side of the window. You can click
a header, and Pan displays the contents of that news item in the lower-right
part of the window. (Refer to Figure 11-7.)

Newsgroup subscriptions

Unlike magazines or newspapers, newsgroups don’t require that you sub-
scribe to them; you can read any available newsgroup on the news server.
The news server’s administrator may decide to exclude certain newsgroups,
however; if they aren’t included, you cannot read them.

The only thing that can be called “subscribing” is when you indicate the
newsgroups you routinely want to read. The news server does not receive
any of this subscription information — the information is used only by the
newsreader to determine what to download from the news server.

Posting news

You can use any newsreader to post a news article (a new item or a reply to
an old posting) to one or more newsgroups. The exact steps for posting a
news item depend on the newsreader, but posting to a newsgroup is similar
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to writing an e-mail message except that you are sending it to a newsgroup
instead of an individual.

In KNode, click the leftmost icon on the toolbar (refer to Figure 11-5) to post
to a newsgroup. To post a follow-up to the item you are currently reading,
click the leftmost toolbar icon that shows an envelope with a left-pointing
green arrow. If you mouse over each icon on the toolbar, a balloon help tells
you what each one does.

In Pan, click the Post buttons on the left side of the toolbar (refer to Figure 11-7)
to post an item to a newsgroup or post a follow-up to a message you are read-
ing. If you mouse over the toolbar icons, a Help balloon gives you hints about
each item. That should help you locate the correct buttons. When you click
one of the Post buttons, a new window appears where you can compose your
message and post it.

If you post an article and read the newsgroup immediately, you should see
the new article, but that does not mean the article has reached other sites on
the Internet. After all, your posting shows up on your news server immedi-
ately because that’s where you posted the article. Because of the store-and-
forward model of news distribution, the news article gradually propagates
from your news server to others around the world.

The misc.test newsgroup provides a way to see whether your news post-
ing is really getting around. If you post to that newsgroup and don’t include
the word ignore in the subject, news servers acknowledge receipt of the arti-
cle by sending an e-mail message to the address listed in the Reply To field of
the article’s header.

Reading and Searching Newsgroups
at Web Sites

If you don’t have access to newsgroups through your ISP, you can still read
newsgroups and post articles to newsgroups at a number of Web sites. Some
of them archive old news articles and provide good search capabilities, so
you can search these for articles related to some question you may have.

The best parts about reading newsgroups through a Web site are that you
don’t even need access to a news server and you can read news from your
Web browser.

Here are some Web sites that offer free access to Usenet newsgroups:

v Google Groups — groups.google.com

v InterBulletin — news . interbulletin.com
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v Mailgate — www.mailgate.org
v News2Web — www . news2web . com

v~ Usenet Replayer — www.usenet-replayer.com

Some sites offer a Usenet newsgroup service for a fee. I don’t list them here,
but you can search for them with Google (www.google.com) — type the
search words usenet newsgroup access to get a list of all Web sites that offer
newsgroup access (including the ones that charge a fee).

One of the best places to read newsgroups, post articles, and search old news-
group archives is Google Groups — Google’s Usenet discussion forum — on the
Web at groups . google.com. At that Web site, you can select a newsgroup to
browse and you can post replies to articles posted on various newsgroups.

The best part of Google Groups is the search capability. You already know how
good Google’s Web search is; you get that same comprehensive search capabil-
ity to locate newsgroup postings that relate to your search words. To search
newsgroups, fill in the search form at groups.google.com and press Enter.

To browse newsgroups in Google Groups, ignore the search box and look at
the list of high-level newsgroup categories such as alt, comp, and soc. Click
the category, and you can gradually drill down to specific newsgroups. When
viewing an article in Google Groups, you can click a link that enables you to
post a follow-up to that article.

Reading RSS Feeds

RSS stands for Really Simple Syndication. RSS is a format for syndicating —
gathering and making available — content of Web sites, primarily news-
oriented sites and blogs. A blog is short for weblog — a frequently updated
journal with thoughts, comments, and opinions of the blog’s creator. RSS
can be used to provide any kind of information that can be broken down into
discrete items and put into RSS format. Such RSS-formatted content is called
an RSS feed, and an RSS-aware program can check the feed periodically for
changes, download new items, and make them available to the user.

Nowadays, RSS feeds are also known as web feeds or simply feeds.

The RSS format is a dialect of XML (extensible markup language). All RSS files
conform to XML 1.0 specification. There are many versions of RSS, but three
versions — 0.91, 1.0, and 2.0 — are in widespread use. RSS version 0.90 was
designed by Netscape for gathering and displaying headlines from news sites.
A simpler version, 0.91, was proposed, and UserLand Software picked up that
version to use it for its blogging product. At the same time, another noncom-
mercial group had evolved RSS 0.90 into RSS 1.0, which is based on resource
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description format, or RDF (see www.w3 . org/RDF/). UserLand did not accept
RSS 1.0 but instead continued evolving RSS 0.91 through versions 0.92, 0.93,
0.94, finally settling on RSS 2.0 (skipping 1.0 because that version number was
already taken). Currently, many blogs and Web sites use RSS 0.91 for basic
syndication (title, URL, and description), RSS 1.0 for readers who use RDF, and
RSS 2.0 for advanced syndication with more metadata. (Think of metadata as
“data about data,” which is what the RSS format provides — data about other
information such as blogs and news.) RSS 1.0 files have an . rdf extension,
whereas RSS 0.91 and 2.0 files have .xml extension. However, all RSS files are
text files that use XML tags.

Examining an RSS feed

An RSS feed is a text file with XML tags that describe a Web site’s content. You
typically use an automated program to periodically generate the RSS feed file,
but you can prepare the RSS feed file using a text editor. It’s good to know
what an RSS feed looks like so that you can debug problems with the feed.

The specific details of an RSS feed depend on the version of RSS. The sim-
plest feed is RSS 0.91; here’s a typical RSS 0.91 feed:

<?xml version="1.0" ?>

<!-- A comment line --->
<rss version="0.91">
<channel> <!--- This tag specifies general information about the feed--->

<title>Title of this feed</title>
<1ink>URL of this feed, for example, http://naba.typepad.com/</link>
<description>Brief description of feed</description>
<language>en-us</language>
<item>
<title>Title of this item</title>
<1link>URL for this item</link>
<description>Description of this item</description>
</item>
. more items ...
</channel>
</rss>

As you can see from this listing, an RSS feed includes a channel with a title,
link, description, and language, followed by a series of items, each of which
has a title, link, and description.
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The format is more verbose for RSS 1.0, which uses the RDF format. RSS 1.0
essentially provides the basic information that’s in RSS 0.91 and adds more
details such as item-level authors, subject, and publishing dates, which RSS
0.91 does not support.

Reading RSS feeds

There are many GUI programs available for subscribing to RSS feeds and
reading items from a feed. These programs are called RSS aggregators
because they can gather information from many RSS feeds and make every-
thing available in a single place.

There are two types of RSS aggregators — Web browser plugins and stand-alone
programs. Browser plugins such as NewsMonster (www . newsmonster.org/)
run in a Web browser so that the feeds appear in the Web browser. Stand-
alone programs such as Imendio Blam for GNOME (developer. imendio.
com/wiki/Blam) and KDE Akregator (akregator.sourceforge.net/)
are complete GUI applications and usually look similar to other mail and
newsreader programs.

In SUSE Linux, the KDE desktop uses Akregator as the RSS reader, whereas
GNOME provides Imendio Blam. You can find them in the Internet applica-
tions category in the menu. I briefly describe how Akregator works; you can
use Blam in a similar way.

To start Akregator, select Main Menu=Internet=>RSS Reader~Akregator. When
Akregator first runs, it displays its main window without any RSS feeds. To sub-
scribe to a feed, select Feed=>Add Feed from the menu or right-click All Feeds
in the left pane of the window (see Figure 11-8) and select Add Feed from the
pop-up menu. Then type the URL for the feed in the Add Feed dialog box and
click OK. For example, to read Slashdot’s RSS feed, [ type http: //slashdot.
org/index.rss. The feed’s title then appears on the left pane of the window.
Click the feed title to view the items in this feed. Then you can click an item in
the upper-right pane, and that item appears in the lower-right pane, as shown
in Figure 11-8. You can add many different RSS feeds, organize them into fold-
ers, and browse them in Akregator.
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Chapter 12

Preparing Documents

and Spreadsheets
in SUSE Linux

In This Chapter

Preparing documents in OpenOffice.org Writer

Working with spreadsheets in OpenOffice.org Calc

preparing documents and spreadsheets are the staples of the modern
office. SUSE Linux comes with the OpenOffice.org (often shortened as
00.0 or Ooo) suite of office applications that includes very capable word pro-
cessing and spreadsheet software to help you with these tasks. Both KDE and
GNOME desktops use OpenOffice.org as the primary office application suite.

In this chapter, | describe two OpenOffice.org applications — Writer for prepar-
ing documents and Calc for working with spreadsheets — in considerable
detail. Writer is similar to Microsoft Word, and Calc is like Microsoft Excel.

Besides Writer and Calc, OpenOffice.org also includes Impress, a presentation
software package that’s similar to Microsoft PowerPoint. [ describe Impress
in Chapter 13.

Writing with OpenOffice.org Writer

Face it: The whole world, or so it seems, uses Microsoft Office, especially
Microsoft Word, to write stuff. You have to work with the world to get your job
done. Until recently, the lack of a freely available and good Microsoft Office-
compatible office suite may have been holding you back from using SUSE
Linux as your primary desktop operating system. Well, your troubles are over.
SUSE Linux comes with the OpenOffice.org office suite — a set of office pro-
ductivity applications comparable to Microsoft Office and compatible with



]88 Partill: Doing Stuff with SUSE

\NG/
s

Microsoft Office as well. OpenOffice.org is installed on your system when you
installed SUSE Linux.

OpenOffice.org Writer, or Writer for short, is at the heart of the OpenOffice.org
office suite. Writer is a word processor that makes it easy for you to prepare
many different types of documents on your SUSE Linux system and, best of all,
share files with others who use Microsoft Word.

Typically you might work with Microsoft Word files that your coworkers and
friends (and maybe even family) send you. All you have to do is save the file
in a folder and open it in Writer. I provide an overview of how to open a docu-
ment, work on it, and save it to a folder. Along the way, [ summarize how to
perform common word processing tasks with Writer.

Before your expectations go sky-high, let me caution you that if you share
files between Microsoft Word and Writer, you may run into some conversion
problems; some Word features may not convert fully into equivalent Writer
features. However, if you share only simple documents with Microsoft Word
users (or if you simply want to prepare your own nicely formatted docu-
ments), Writer should work well for you.

By the way, if you're already a proficient Microsoft Word user, you should be
able to start using Writer without much trouble because much of Writer
works very much like Word.

Taking stock of OpenOffice.org Writer

Before you begin using Writer, [ want to give you a quick overview of its
major features. When you know what you can do with Writer, you can read
the subsequent sections to find out how to perform specific tasks in Writer,
such as formatting tables, printing documents, and tracking changes.

You can do the following with Writer:

v Open and edit Microsoft Word files or convert Microsoft Word files to
Writer format. One advantage of converting to Writer format is that Writer
files are much smaller in size than corresponding Microsoft Word files.

v Save documents in many different formats including Microsoft Word
97/2000/XP, Word 95, Word 6.0, Rich Text Format (RTF), StarWriter 5.0
(as well as 4.0 and 3.0), plain text, Adobe PDF, and Web page (HTML).

v Insert graphics files of many different formats, including JPEG, GIF, ZSoft
Paintbrush (PCX), TIFF, Windows BMP, Macintosh PICT, Encapsulated
PostScript (EPS), Adobe Photoshop (PSD), AutoCAD DXF, and many more.
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v Create tables that can include calculations and add charts that update
when the table contents change.

v Perform complex page layouts with desktop publishing features such as
text frames and floating frames.

v Easily create and organize multiple files that make up a large project
such as a book or a large report.

v Create a mail merge where you write a single document with generic
fields and have Writer automatically create many different customized
documents by filling in the specific fields (such as name, address, and
phone number) from a database.

v Save versions of a document as you continue to change it, and revert to
an older version if necessary.

v Compare changes and work collaboratively using the Versions system.
Not only can you see what has changed and who changed it, but you can
also accept or reject those changes individually (or in groups) according
to certain criteria.

A note of caution here: The versioning information doesn’t export per-
fectly to some other formats, in particular, Microsoft Word.

v E-mail your documents directly from Writer.

v If you like, Writer can automatically complete the word you’re typing by
making a best guess, and you can accept the choice by pressing Enter. (If
this feature drives you crazy, you can simply turn it off, just as you can
configure many other features in Writer.)

Writer enables you to print a Writer document directly to an Adobe Portable
Document Format (PDF) file. To electronically share a document in its final
form, you can print the document to a PDF file and distribute that file.
Anyone can easily view and print PDF files by using the free Adobe Reader
(available at www . adobe . com/products/acrobat/readstep2.html).

Getting started with Writer

The best way to learn to use Writer is to simply start using it. To start Writer,
click the Writer icon on the panel (the icon showing some pieces of paper
with a pen) or choose Main Menu=Officem>Word Processor in KDE or GNOME
(if you have more than one word processing application installed, you have
to select OpenOffice.org Writer from a submenu).

Writer displays its main window (Figure 12-1) with an empty document.
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Using Writer is simple because it’s so similar to other word processors that
you’ve probably used, such as Microsoft Word. For example, you can type
text into the blank document, format it, and save it when you’re done. If you
want to work on an existing document (for example, a Microsoft Word file)
that you've saved on your hard drive, choose File=>Open and then pick the
document from the Open dialog box. Then you can work on that document
and save it in Word format, another word processing format, or in the default
OpenDocument Text format in a file with the . odt extension.

As Figure 12-1 shows, you can view the Writer window in terms of the follow-
ing major parts:

v Menu bar: Provides the standard pull-down menus: File, Edit, Help, and
so forth. Use these menus to perform all the tasks that Writer can do.

v Function bar: Shows the full pathname or the URL of the currently open
file and also provides buttons for performing tasks, such as opening,
saving, and printing a document. You can also click icons on the func-
tion bar to open the Stylist (a list of paragraph, character, and page
styles), the Navigator (a list of document parts such as headings, tables,
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and bookmarks), and the Gallery (a collection of predefined graphic
objects such as 3D shapes, backgrounds, and bullets).

1 Object bar: Enables you to format the document by applying styles,
selecting fonts, or changing text attributes such as bold, italic, and
underline. This bar changes depending on the type of object (such as
plain text or graphics) that you've clicked.

+ Ruler: Shows the page dimensions and the tab stops.

1 Toolbar: Located along the left side of the window, it provides buttons
that you can use to perform common document-preparation tasks, such
as insert tables, create forms, check spelling, and show the drawing
functions.

v~ Status bar: Displays the usual information about the open document,
including the current page number and the total page count. You can
also click elements in the status bar to change certain settings, such as
the text selection mode and the zoom factor for viewing the document.

In addition to these parts, the largest part of the Writer window is the work
area where your document appears. That’s where you focus most of your
attention.

Use tooltips to get a clue about what a particular field or button does. Hover
the mouse cursor over a field or a button, and Writer displays a small tooltip
window with a brief help message. If you want more information in the tooltips,
turn on extended tooltips by choosing Tools=>Options=>OpenOffice.orgr>
General->Help—~Extended tips (when the check shows, the option is turned on).

If you need it, help is available in Writer. Choose Help=>OpenOffice.org Help
from the Writer menu. This action brings up the OpenOffice.org Help window
with help information about Writer. Click the links to view specific help
information.

Setting up Writer

You don’t really have to do any special setups to start using Writer. Even
tasks such as printing should work right away provided you have set up a
printer using the procedure described in Chapter 3. You may want to tinker
with some settings, however, so that Writer works to your liking. For exam-
ple, you might want to turn off AutoCorrect so that it doesn’t suggest word
completion, or you might want to hide some toolbars to get more workspace.
You can set up most of these options from the View and Tools menus, which
are located on the Menu bar (refer to Figure 12-1). In particular, you perform
many of the setup tasks from the dialog box (Figure 12-2) that appears when
you choose Tools=>Options.
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Preparing documents in Writer

You’ll have no problem preparing documents using Writer. Typically, you can
simply click to position a cursor and then type your text. To format text,
select a style for the paragraph or select text and then apply formatting such
as boldface or italics. In the following sections, [ provide some quick tips on
how to perform specific document-preparation tasks in Writer. I organize the
tips into the following categories of tasks:

v Editing and reviewing documents
v Using styles and templates

v Performing page layout

v Creating and inserting graphics
v~ Using fields

v Working with large documents

Editing and reviewing documents

To edit a document, you have to open the file, move around within the docu-
ment, insert and delete text, and save the file. You can perform most of these
tasks intuitively because these steps are similar in most word processors. For
that reason, I don’t discuss in detail how to perform each of these tasks.
Instead, in the following paragraphs, I highlight just a couple of features that
you'll find particularly useful in your work.
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Typically, you review changes when you collaborate with others on a docu-
ment and several of you make revisions to the document. To review changes,
the changes have to be tracked. Writer has features to enable change track-
ing (or redlining, as it’s commonly called). With Writer, you can examine the
changes, accept or reject each change, and make more editing changes —
even adding comments to explain why you made a change.

Writer has other features for easily editing a document. For example, you can
search and replace text — even find all occurrences of text with a specific for-
matting style and change each occurrence.

Most of Writer’s editing and change-tracking functions are in the Edit menu
(shown in Figure 12-3). Some toolbar icons provide shortcuts to the menu.

You can perform many editing tasks by clicking the toolbar icons. Just mouse
over each icon and read the tooltips to see which ones enable you to make
specific editing and reviewing changes.
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Using styles and templates

In Writer, you can format pages, paragraphs, and blocks of text manually. For
example, you can place the cursor on a paragraph, choose Format=>Paragraph,
and then format various characteristics of the paragraph (such as indenta-
tion, spacing, and borders). This paragraph-by-paragraph formatting is okay
for a short document, but it can be tedious and time-consuming if you have
to format hundreds of paragraphs one by one. A better approach is to define
a style — a collection of formatting characteristics stored under a particular,
usually descriptive, name. Then you can simply apply that style to all para-
graphs. If you need to change any aspect of the paragraphs, simply edit the
style and voila — all paragraphs with that style get the new formatting.

You may be familiar with paragraph and character styles in Microsoft Word,
but Writer relies more on styles than Microsoft Word. Writer supports five
types of styles:

1 Paragraph style: Controls the look of a paragraph, such as the font,
paragraph spacing, borders, bullets, numbering, and the style of the fol-
lowing paragraph.

v Character style: Controls the font style of selected text in a paragraph.

+ Frame style: Controls the size and position of the frame and the text-
wrapping options.

1 Page style: Controls the page layout, including the margins, number of
columns, headers, and footers.

v Numbering style: Controls the number or bullet character and spacing
that are used for numbered or bulleted lists.

You can conveniently access and use all the document’s styles in a floating
window called the Stylist (Figure 12-4). Writer displays the Stylist by default,
but you can show and hide it by pressing F11 (or choosing Format=Stylist).
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The Stylist makes it very easy to organize and use the styles. The five icons
along the top part of the Stylist refer to the five types of styles — paragraph,
character, frame, page, and numbering — from left to the right. You can click
an icon to see all styles of that type. To apply a style, position the cursor
where you want to apply the style and double-click the style from the Stylist.
For character styles, select the text and then double-click the character style.

Writer also supports templates, just as Microsoft Word does. A template is a
special document with a collection of styles for the kinds of layouts that the
document needs. You can think of a template as a model for a specific type of
document. For example, you might have templates for documents such as
memos, letters, fax cover sheets, envelopes, and many more.

Writer does not come with any templates, but you can create or download
templates from Web sites. A Writer template for writing manuscripts using the
Modern Language Association (MLA) style (see owl .english.purdue.edu/
handouts/research/r_mla.html for more information on the MLA style),
for example, is available from www.cc.mie-u.ac.jp/~1g20106/eg5000/
templates/dl/MLA-Template.stw. You have to install the template file —
MLA-Template.stw — before you can create documents using that tem-
plate. Note that the . stw extension is used for OpenOffice.org template files.

To install a template file to use in Writer, follow these steps:

1. Choose File>Template=>Organize.

The Template Management dialog box (shown in Figure 12-5) appears
with the Default folder of templates on the left side and the current list
of documents on the right.

[=fy Temalates 7 Unptitled Clase

[ Presentation  Mew Insert

[0 Presentation  pajete Delete Commands =
Import Template... Help

Printer Gettings...

Update

Address Book..,

Templates * |Documents

2. Right-click the My Templates folder icon and select Import Template
from the pop-up menu, as shown in Figure 12-5.

The Open dialog box appears.
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3. Navigate to the directory where you saved the template file, select the
template file, and click Open.

The Open dialog box closes; the template now appears in the My
Templates folder in the Template Management dialog box.

4. Click Close to close the Template Management dialog box.
To create a new document from a template you've installed, follow these steps:

1. Choose File=>"Newr>Templates and Documents.
A dialog box appears.

2. Click Templates on the left pane and then double-click the Default
folder on the right pane.

You should see the templates that you have installed.
3. Select the template you want to use and click Open.

A new document appears, typically with some text illustrating the
selected template’s styles.

4. Erase the text in the new document and start typing what you want.

To view the styles in that template, open the Stylist window by pressing
F11 and apply styles by double-clicking them in the Stylist.

Writer also enables you to perform many other tasks related to styles and
templates. For example, you can create a style, apply a style to text, copy
styles from one template to another, and so on.

Doing page layout

In Writer, page styles control the page layout, and each page can have its
own style. The usual approach is to define three page styles: First Page, Left
Page, and Right Page. Define the First Page style with whatever applies to the
first page such as a special header and no page number. The Left Page style
is the style for the even-numbered pages, and the Right Page style is for odd-
numbered pages. For each page style, you can also define the page style that
applies to the following page. The idea would be to define Left Page as the
next page style for First Page and Right Page as the style of the page that
follows the Left Page style. That way, the page styles are correct for all the
pages as long as you start with the First Page style. You may also want to
define a Landscape page style so you can use it for pages that have to be in
landscape orientation.
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@"N\BER If you are familiar with Microsoft Word, you know that the page setup —

& paper size, orientation, margins, and so on — applies to all pages in the docu-
ment. In Writer, a page style does not automatically apply to the entire docu-
ment. Instead, each page has its own page style. Of course, you can choose to
apply the same page style to all the pages. Essentially, you have more fine-
grained control over page layouts in Writer.

A typical page layout task is to insert objects created in other OpenOffice.org
applications, such as a Calc spreadsheet, an Impress slide, or a Draw draw-
ing. You can insert such objects by choosing Insert=>Object>OLE Object.
Incidentally, OLE stands for Object Linking and Embedding, which is just a
fancy term for the ability to create a document by adding objects like charts
and drawings that are created in different applications.

When you add objects to a document, keep this caveat in mind: You can edit
an object directly in the document only by using the application that origi-
nally created the object.

One object that you can insert into a Writer document is a mathematical for-
mula, and I mean serious formulas with integral signs and Greek letters like
alpha and sigma. If you're writing a scientific paper with complex equations,
you'll really appreciate this feature of OpenOffice.org. Here’s a typical
sequence of steps to insert a formula into a Writer document (this process is
similar for inserting other objects):

1. Position the cursor and choose Insert=>Object->Formula.

The user interface changes to that of OpenOffice.org Math — an applica-
tion for writing mathematical formulas — and a small frame for the for-
mula appears in the document. The formula is typeset in that frame.

2. Select a formula type from the top two rows of the Selection window.

The lower rows in the Selection window show available formulas of that
type. For example, the summation category (denoted by an uppercase
Greek letter sigma) includes integral signs.

3. Click a specific formula, such as an integral.

The Math command for this formula appears in the Commands window,
and parts of the formula appear in the document.

4. Fill in the arguments for the formula.

As you construct the formula with commands in the Commands window,
the formatted formula appears in the document (Figure 12-6).
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5. To change the font size of the formula, choose Format->Font Size and
specify the font size.

6. Click anywhere else in the Writer document to return to the Writer
user interface.

7. Double-click the formula to edit it again.

Of course, Writer has many page layout features. You can use tables, num-
bered and bulleted lists, and columns. Writer also supports frames — rectan-
gular boxes in which you can place text, graphics, and even other frames.
Using frames, you can place just about anything anywhere on the document.

Creating and inserting graphics

Writer includes a drawing toolbar with tools that you can use to draw in the
document. You can also insert into your document both line drawings and
images from files in many different formats.

To create simple diagrams in your document, click the Show Draw Functions
icon (on the function bar along the top edge of the Writer window) and hold
down the mouse button for a moment. The Drawing toolbar appears along
the bottom of the window, as shown in Figure 12-7. You can toggle this
Drawing toolbar on or off by choosing View=>Toolbars=Drawing.
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Click in the document where you want to add a diagram. Select a tool from
the Drawing toolbar (Figure 12-7) and start drawing. To change the drawing
tool, select another tool.

To keep the Drawing toolbar visible while you create a diagram, open the

toolbar as usual, drag the toolbar’s left part, and tear it away. The toolbar
then turns into a tearoff menu (a small window that floats in the document
window) from which you can easily select and use different drawing tools.

Writer also comes with a gallery of predefined graphics. To view the Gallery
(shown in Figure 12-8), choose Tools=>Gallery or click the Gallery icon (the
rightmost icon on the Function bar). Select from the themes along the left
side of the gallery. If you see a graphic you’d like to use, drag and drop it from
the gallery to the location on the document where you want to insert it. Click
the Gallery icon again to hide the graphics gallery.
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Using fields

Think of fields as bits of information that might change, but you want to call
them by a name and use them in your document. For example, you might want
to insert the current date and the page numbers into the header of a document.
You can do so by inserting fields that refer to the date and page numbers. Some
of the predefined fields (such as date and page numbers) are easy to use. Simply
choose Insert>Fields and then select the field you want to insert.

In addition to the fields you see in the Insert menu, you can pick from many
more fields. Choose InsertFields=>Other to open the Fields dialog box
(Figure 12-9) where you can browse and pick other fields to use in your docu-
ment. From the Fields dialog box, you can also change the format for a field.
For example, you can select how the date field is shown in the document.

o= =

Document | References | Functions | Docinformation | Variables | Database |

Type Select Format

Author 12/31/99 =]
Chapter Date 12(31/1999

Dec 31, 99

File name Dec 31, 1999

Fage 31, Dec. 1999

Sender
Statistics 31. December 18999
Templates Fri, Dec 31, 99

Time Fri 31/Dec 59

Fri, December 31, 1999
Friday, December 31, 1995
12-31

§9-12-31

1998-12-31

12/95 =
Dec 31 b/
Offset in days

0 [+
Insert | Close Help

Another type of useful field is a reference or a bookmark. The idea is to mark a
location in the document by a name and then refer to that location elsewhere
by that assigned name. For example, you can insert a cross-reference to the
page where that location occurs.

Working with large documents

What'’s a large document? Well, I consider a large document any document over
a hundred pages or so. Anything that might have a couple of chapters and need
a table of contents and an index definitely qualifies as a large document — for
example, a book. Writer includes features to do the “usual things” you’d want to
do when working with these larger, more cumbersome documents, such as cre-
ating tables of content, inserting indexes, and adding entries to indexes.
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Writer also enables you to tie together several Writer files into a single large
document — what Writer refers to as a master document. Master documents
are ideal for books, for example. You can keep the chapters in separate files
and then organize these files into a book by using the master document fea-
ture. For a large project involving a master document, you have to plan a
little and take care of the following key steps:

1. Create a template with the styles you need as well as any fields you
plan to use.

For more about styles and templates, see the appropriately named sec-
tion “Using styles and templates,” earlier in this chapter.

2. Create the individual files and the master document by using the
same template.

3. Insert the files into the master document — that’s how you combine
all the individual parts into the final product.

4. Add a table of contents and index and a bibliography, if needed.
5. Work on the component files.

6. Update the table of contents and index.

Preparing Spreadsheets with
OpenOffice.org Calc

Does the name VisiCalc mean anything to you? What about Lotus 1-2-3? 'm
sure you have heard of Lotus 1-2-3, but maybe not VisiCalc — the first spread-
sheet program that turned the IBM PC into a business tool. (Believe it or not,
you can download and run VisiCalc even on today’s PCs. Curious? For more
information, visit Dan Bricklin’s Web site at www.bricklin.com/history/
vcexecutable.htm.)

Spreadsheet programs continue to be a staple of the office suite, and the
OpenOffice.org suite is no exception. OpenOffice.org Calc, or just Calc for
short, is the spreadsheet program in the OpenOffice.org suite.

All the spreadsheet programs that came after VisiCalc — from Lotus 1-2-3 to
Microsoft Excel and Calc — still follow that visual model of a spreadsheet laid
out in rows and columns. Of course, the newer spreadsheets (such as Excel
and Calc) have many more bells and whistles, including fancy GUIs.

If you have used any other spreadsheet program, such as Microsoft Excel,
you’ll be right at home when you start using Calc. Therefore, [ don’t try to
give you detailed instructions on how to use Calc; instead, I provide a quick
overview and some tips on how to perform some common tasks in Calc.
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Taking stock of OpenOffice.org Calc

Before describing the types of tasks you can perform in Calc, I want to highlight
the key features of Calc. Calc can do all the basic spreadsheet functions you
expect in a spreadsheet program. Here are some things you can do with Calc:

v Open and edit Microsoft Excel files or convert Microsoft Excel files into Calc
format. Calc uses an XML format and saves files with the .SXC extension.

v Save documents in many different formats including Microsoft Excel
97/2000/XP, Excel 95, Excel 5.0, dBASE, StarCalc 5.0 (as well as 4.0 and
3.0), SYLK (an old Microsoft format), comma-separated values (CSV),
and Web page (HTML).

v Use charting tools to visualize data in 2D or 3D plots.

v Insert graphics files of many different formats, including JPEG, GIF, ZSoft
Paintbrush (PCX), TIFF, Windows BMP, Macintosh PICT, Encapsulated
PostScript (EPS), Adobe Photoshop (PSD), AutoCAD DXF, and many more.

v Save versions of a spreadsheet as you continue to change it, allowing
you to revert to an older version if necessary.

v Use styles and templates to format your spreadsheet.

v Define cells to dynamically change format depending on the value in
the cell.

v Easily exchange — import and export — data with existing databases by
using the DataPilot.

v Set up cells to accept values from a set of specific values or ranges of
valid values.

v Lock cells so data cannot be changed inadvertently.

v Perform scenario analysis by storing multiple values in the same block
of cells — and define scenarios so you can select a set of values for a
specific scenario.

v Use the Goal Seek feature to determine the value of a cell that would give
you a result you want from a formula.

Getting started with Calc

The best way to learn to use Calc is to simply start using it. To start Calc,
choose Main Menu=>Office>Spreadsheet in KDE (in GNOME, choose Main
Menu=>Officer>Spreadsheet>OpenOffice.org Calc). The Calc window opens
with a blank spreadsheet. You can then begin typing text and numbers into
the cells and use formulas to calculate whatever you want.

To familiarize yourself with Calc, take a moment to examine the tools and
icons packed into Calc’s main window (shown in Figure 12-10).
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Notice the following major parts in the main Calc window (refer to Figure 12-10):

v Menu bar: Provides the standard pull-down menus: File, Edit, Help, and
so forth. Use these menus to perform all the tasks that Calc can do.

v Function bar: Shows the full pathname or the URL of the currently open
file and also provides buttons for performing routine tasks: opening,
saving, and printing a document. You can also click icons on the func-
tion bar to open the Stylist (a list of cell and page styles), the Navigator
(alist of spreadsheet items such as sheets and graphics), and the
Gallery (a collection of predefined graphic objects such as 3D shapes,
backgrounds, and bullets).

v Object bar: Enables you to format the document by applying styles,
selecting fonts, or changing text attributes (such as boldface, italics, and
underlining). This bar changes depending on the type of object (such as
plain text or graphics) you’ve clicked.
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v Formula bar: Provides a field where you can enter formulas, create
sums, and launch the Function Wizard.

v Toolbar: Located along the left side of the window, it provides buttons
that you can use to perform common tasks, such as inserting graphics,
sorting cells, checking spelling, and grouping cells.

v~ Tabs: Located along the bottom of the spreadsheet, they enable you to
work with different sheets in the same file.

v~ Status bar: Displays information about the current sheet (the current
sheet number, the page style, and so on). You can also click various ele-
ments in the status bar to change settings, such as the text selection
mode and the zoom factor for viewing the spreadsheet.

In addition to these tool and icon bars, the largest part of the Calc window is
the work area where your spreadsheet appears and where you focus most of
your attention.

Use the tooltips to find out what an icon or menu option does. Mouse over a
toolbar icon or a menu item, and Calc displays a small tooltip window with a
brief help message.

Note: Curious about that Function Wizard icon that’s pointed out in Figure
12-10? Check out the section “Calculating and charting data,” later in this
chapter, where [ show you how to use that handy little feature.

You can configure Calc through the Tools=>Options dialog box. On the left
side of the dialog box, click the plus sign (+) next to Spreadsheet. The plus
sign turns to a minus sign (-), and a number of different categories of options
appear (as shown in Figure 12-11). You can then click each category to config-
ure various aspects of Calc.
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Preparing spreadsheets with Calc is a straightforward affair. Typically, you
can enter text and numbers into the cells, resize the columns by dragging the
vertical lines, and enter formulas to calculate the answers you need. To help
you perform some common tasks in Calc, I provide some quick tips for two
broad categories of tasks:

v~ Entering and formatting data
v Calculating and charting data

Entering and formatting data

When entering and formatting data, use Calc in the same way you use Microsoft
Excel. You can type entries in cells, use formulas, and format the cells (such as
specifying the type of value and the number of digits after the decimal point).
The Format menu contains many of the options for formatting the spreadsheet.

After you're done entering data into a spreadsheet, save it by choosing Filem>
Save As. A dialog box appears, from which you can specify the file format, the
directory location, and the name of the file. You've seen similar Save As dialog
boxes a thousand times before. OpenOffice.org Calc can save the file in a
number of formats, including Microsoft Excel 97/2000/XP, Microsoft Excel 95,
Microsoft Excel 5.0, and text file with comma-separated values (CSV).

If you want to exchange files with Microsoft Excel, save the spreadsheet in
Microsoft Excel format (choose an appropriate version of Excel). Then you
can transfer that file to a Windows system and open it in Microsoft Excel.

After you've saved the spreadsheet once, you can also save intermediate ver-
sions of a spreadsheet. To save a new version, choose Filem>Versions and
then click Save New Version in the next dialog box.

To share a spreadsheet with people who don’t use Calc or Excel, you can
print the spreadsheet to a PDF file and then send that to others because
anyone can easily view and print PDF files by using the free Adobe Reader
(see www.adobe.com/products/acrobat/readstep?2.html).

Calculating and charting data

To perform calculations, use formulas you normally use in Microsoft Excel.
For example, use the formula SUM(D2:D6) to add up the entries from cell D2
to D6. To set cell D2 as the product of the entries A2 and C2, type =A2*C2 in
cell D2.
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To learn more about the functions available in OpenOffice.org Calc, choose
Help=>OpenOffice.org Help. This opens the OpenOffice.org Help window, from
which you can browse the functions by category and click a function to read
more about it.

One interesting feature of Calc is the support for scenarios. A scenario is
simply a collection of values for one or more cells. Scenarios are useful when
you compare the effect of some cells on other calculations in the spreadsheet.
For example, the monthly payment on a loan would depend on the principal,
the interest rate, and the duration of the loan. You can use Calc’s scenario fea-
ture to compare the monthly payments for a number of different scenarios
where each scenario has a certain combination of interest rate and loan dura-
tion in months. To use scenario for this comparison, follow these steps:

1. Set up the spreadsheet cells with labels and values for the principal,
annual interest rate in percentage, and loan duration in months (refer
to Figure 12-12). Calculate the monthly payment using this formula:

-PMT (MONTHLY_RATE ; MONTHS ; PRINCIPAL)

Figure 12-12 illustrates this example. The cells in the range B5:C7 specify
the principal, annual rate, and the number of months. Cell C6, with the
annual interest rate, is formatted to show a percentage. Cell C11 com-
putes the payment using the formula that you see in the formula bar.
Notice that the annual rate in cell C6 has to be divided by 12 to get the
monthly rate.

2. Select the cells that you want to include in the scenario and choose
Tools=>Scenarios. For example, in Figure 12-12, select the cells in the
range B5:C7.

The Create Scenario dialog box appears.
3. Fill in the scenario name, and then click OK.

For example, the scenario shown in Figure 12-12 is named
Rate_6_5_PCT (that’s my name for the 6.5% rate scenario).

4. Enter values into the cells — principal, interest rate, and months to
repay loan.

The scenario name appears in a drop-down list above the cells that con-
stitute the scenario (as shown in Figure 12-12). The cell values define
what that scenario means.
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5. Repeat Steps 2, 3, and 4 for other scenarios where each scenario has a
combination of principal amount, rate, and loan duration in months.

6. Select a scenario from the drop-down list (refer to Figure 12-12) to see
the monthly payment for that scenario.

To figure out where a particular cell is being used in some calculation, click
the cell and then choose Tools>Detectiver>Trace Dependents. Calc draws
arrows to show where that cell is being used.

If you cannot remember a function, use the Function Wizard to build the for-
mula in a cell. To use the Function Wizard, follow these steps:

1. Click the Function Wizard icon (refer to Figure 12-10) on the
Formula bar.
The Function Wizard dialog box appears.
2. Scroll down the list of functions and double-click the function you want.

Doing so causes the formula and its arguments to appear (see Figure
12-13), waiting for you to specify the values to be used as arguments.
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3. Click each argument and identify the cell that should be used as that
argument.

When you specify all the arguments, the Result field (shown in Figure
12-13) shows the result of that formula.
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4. Click OK.

The formula appears in the spreadsheet cell.



Chapter 13

Doing Even More Office Stuff
In SUSE Linux

In This Chapter

Keeping track of appointments and tasks
Making calculations
Preparing presentations in OpenOffice.org Impress

Besides word processing and spreadsheets that [ cover in Chapter 12,
what else do you do in an office? Hmmm . . . let me see. How about keep-
ing track of appointments and tasks? Calculating how much profit you made?
And making sales pitches or some sort of presentation? In this chapter, I cover
SUSE Linux applications for some of these other office tasks. The chapter
begins with a quick summary of the calendar applications in KDE and GNOME.
Then I describe OpenOffice.org Impress — a Microsoft PowerPoint-like pre-
sentation software package.

Keeping Track of Appointments
and Tasks

If you installed KDE as your desktop, you can use Kontact — a new KDE appli-
cation that integrates existing KDE applications such as the KMail mail reader
and the KOrganizer calendar program into a single graphical personal infor-
mation manager. To start Kontact, click the Personal Information Manager
icon on the KDE panel (see Figure 13-1) or choose Main Menu=>Officer>
Personal Information Manager (Kontact).
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When Kontact starts, it usually displays the Summary view. You can, how-
ever, switch to other views by clicking the icons on the left pane of the
Kontact window (refer to Figure 13-2). For example, Figure 13-2 shows
Kontact after you click the Calendar icon. In this case, Kontact displays the
output of KOrganizer — the KDE calendar program. The KOrganizer program
displays a calendar view where you can click a date to set or view that day’s
schedule. Figure 13-2 shows a typical calendar.
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You can go to a different month or year by clicking the arrows next to the
month and the year. To add a to-do item for a specific date, select the date
from the calendar, click the To-do Items text box, and type the description of
the task.

To add appointments for a specific time, double-click the time and type a
brief description of the appointment in the dialog box that appears. Click OK
when you're done. After you finish adding events and appointments, choose
Filem>Save to save the calendar.

If you installed the GNOME desktop, you can use Evolution to keep track of
your calendar and tasks. Start Evolution by clicking its icon on the GNOME
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desktop’s top panel (or choose Main Menu=>Officer>Evolution). After the
Evolution window appears, click Calendars on the left pane to use the calen-
dar. Evolution’s calendar is intuitive to use. Simply select a date and double-
click a time to open the Appointment dialog box where you can type in the
details of the appointment.

Making Calculations

You have a choice of the KDE calculator or the GNOME calculator, depending
on which desktop you installed. Both are scientific calculators, and you can
do the typical scientific calculations, such as square root and inverse, as well
as trigonometric functions, such as sine, cosine, and tangent.

To use the calculator on a KDE desktop, choose Main Menu=Utilities=>
Calculator=>KCalc. Figure 13-3 shows the KDE calculator in SUSE Linux.

O —

File Edit Constants Settings Help
Inv 29.99
| Mod x10%(| s X = C AC
Figure13-3: || [ 7 |[s ]| |l
f +
Do your x_' 4 ||s |l s MR || M5
' =
ca_lculatlons 15 ol
inthe KDE |9 " -
e 0 . Mc (| £
calculator.
NORM
|

You can display additional buttons by selecting options from the Settings
menu. For example, choose Settings=>Trigonometric Buttons to show buttons
that enable you to perform trigonometric calculations with the calculator.

If you installed the GNOME desktop, choose Main Menu=>Utilities=
Calculator=>Calculator to get a calculator.

Making Presentations with
OpenOffice.org Impress

It seems the business world, or should I say the whole world, is full of
PowerPoint rangers — those dedicated souls who live by their PowerPoint
briefing packages (slide presentations). It’s hard to imagine a meeting or a
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conference where someone isn’t vigorously making points on-screen with
PowerPoint. Face it: Slide presentations are here to stay. Making presenta-
tions is a fact of life; businesspeople have come to expect office-application
suites to include some sort of presentation software.

Like Microsoft Office, the OpenOffice.org office application suite comes with
its own PowerPoint-like presentation software — OpenOffice.org Impress (or
Impress for short). If you have used Microsoft PowerPoint and you're already
familiar with its nuts and bolts — the concept of a slide, how to add text and
graphics to a slide, how to organize the slides, and how to run a slide show —
then you'll find it easy to get started with Impress. Because some details of
how you perform basic Impress tasks may differ from the way they’re done in
PowerPoint, I provide some quick tips to point you in the right direction. I
start with an overview of Impress and then cover some categories of
common tasks that you’ll likely perform in Impress.

Taking stock of OpenOffice.org Impress

You'll find that Impress can do all the usual things that presentation soft-
ware such as Microsoft PowerPoint can do. For example, you can create
professional-looking slide shows in Impress, using capabilities like these:

1 Open and edit Microsoft PowerPoint files or convert Microsoft PowerPoint
files to Impress format. One advantage of converting to Impress format
is that Impress files are smaller in size than corresponding Microsoft
PowerPoint files. Presentation files stored in Impress format are assigned
filenames with the . sxi extension.

v Save documents in many different formats, including Microsoft PowerPoint
97/2000/XP, StarDraw 5.0 and 3.0, and StarImpress 5.0 and 4.0.

v Insert graphics and clip art from files of many different formats, includ-
ing JPEG, GIF, ZSoft Paintbrush (PCX), TIFF, Windows BMP, Macintosh
PICT, Encapsulated PostScript (EPS), Adobe Photoshop (PSD), AutoCAD
DXF, and many more.

v Insert other OpenOffice.org documents (from programs such as Writer,
Calc, and Draw) into a presentation.

v Use Presentation Wizard to quickly create a presentation.
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v Use all the drawing tools from OpenOffice.org Draw to add drawings to
the slides.

v Export a presentation to a Web Page (HTML) with or without frames. You
can also export the slides in any of the supported graphics file formats.

v Use layers to separate parts of the slide so that each part can be edited
or viewed separately.

v Use special effects such as animated text and graphics, sound, and slide
transition effects.

v Use FontWork (Format=>FontWork) to create various text effects such as
aligning text along a curve.

v Render text in 3D.

v Save versions of a presentation as you continue to change it and revert
back to an older version, if necessary.

v Add speaker’s notes to each slide and create handouts.

Getting started with Impress

The best way to get comfortable using Impress is simply to start using it. To
start Impress, choose Main Menu=>Office=>Presentation=>OpenOffice.org
Impress in KDE or GNOME.

The Presentation Wizard dialog box appears and guides you through the
steps of starting a new presentation. From the Presentation Wizard dialog
box, you can create an empty presentation, create a presentation from a tem-
plate, or open an existing presentation. If you select an empty presentation
and click Next, the Presentation Wizard asks you to select the slide design.
Then you can click Create to open the Impress window, where you can select
the layout of your first slide. After you finish laying out a slide, you can pro-
ceed to insert new slides. For each slide, you can select the layout you want.

You can open and edit Microsoft PowerPoint files in Impress. To open an
existing file, choose File>Open and then select the file to open.

Before you start creating slides with Impress, take a moment to examine the
Impress window (shown in Figure 13-4).
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In Figure 13-4, note the major parts of the Impress window:

v Menu bar: Provides the standard pull-down menus such as File, Edit,
and Help for performing all the tasks that Impress can do.

+ Function bar: Shows the full pathname or the URL of the currently open
file and also provides buttons for performing tasks such as opening,
saving, and printing a document. You can also click icons on the func-
tion bar to open the Stylist, the Navigator, and the Gallery.

v Object bar: Enables you to format the document by applying styles,
selecting fonts, or changing text attributes such as bold, italic, and
underline. This bar changes according to the type of object you've
clicked (for example, plain text or graphic image).

v Drawing toolbar: Located along the bottom of the window, it provides
buttons that you can use to perform drawing tasks, such as inserting
graphics, drawing lines and curves, and inserting text.
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v~ Status bar: Displays information about the current slide such as the cur-
rent slide number and the total count of slides. You can also click ele-
ments in the status bar and change settings such as the zoom factor for
viewing the slide.

In addition to these tool and icon bars, you can turn on many more toolbars
from the View=>Toolbars menu.

The largest part of the Impress window is the work area where you work on
the current slide and where you focus most of your attention.

Use the tooltips to find out what an icon or menu option does. Hover the
mouse cursor over a toolbar icon or a menu item, and Impress displays a
small tooltip window with a brief help message.

You don’t have to set up anything to start using Impress. However, if you ever
need to configure some aspects of Impress, you can do so through the Tools=>
Options and Tools>Configure menus. In particular, the Presentation category
of the Tools=>Options window contains the options for Impress (Figure 13-5).
You should go through each of the Presentation options to see what you can
configure from this window.
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Using Impress

When you start Impress, the Presentation Wizard prompts you for the type of
presentation you want. If Impress is already running, you get the Presentation
Wizard when you choose File>Newr>Presentation. If you want a blank presen-
tation, simply click Create in the first step of the Presentation Wizard (as in
Figure 13-6). Impress then displays an empty slide along with a gallery of
slide layouts from which you can change the slide’s layout.
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Typically, a slide layout might have a title area and some text bullets. You can
click and add the text to each of these areas. To insert any graphic image,
choose Insert=>Graphics and pick the graphics file you want to insert. You
can draw directly on the slide by using the drawing tools from the vertical
toolbar along the left side of the Impress window. To see which tool does
what, move the mouse over any icon, and a tooltip gives you a hint.

After you finish working on a slide, you can insert another slide by choosing
Insert=>Slide. Impress displays an Insert Slide dialog box (similar to the
Modify Slide dialog box shown in Figure 13-6), and you can select the layout
for the next slide.

To save a presentation, choose Filem>Save from the menu. For new documents,
you have to provide a filename and select the directory to save the file.

That, in a nutshell, is how you create presentations in PowerPoint. In the fol-
lowing sections, I provide some quick tips for performing the following tasks
with Impress:

v Preparing presentations

v Adding graphics and special effects

v Delivering presentations

Preparing presentations

Typically, you start with a blank slide with a specific layout. For example, the
slide has a title area and a bulleted list for the points you want to make with
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the slide. You can click the title area, type the title, and then click the bul-
leted text area to start entering text. Then you add another slide and con-
tinue with the process until you finish the presentation.

If you're going to present information that’s already in a Writer document,
you can use the outline of that Writer document to start a presentation. The
Writer document does have to follow one rule — it must use the heading styles
Heading 1, Heading 2, and so on for the major sections in the document.

To create a presentation from the outline of a Writer document that uses the
heading styles, open the document in Writer and choose Send=>Outline to
Presentation from the Writer menu. You should see an Impress window open
up with a new presentation that has slides based on the headings in the Writer
document. Each Heading 1 style becomes a new slide, and the Heading 2 and
Heading 3 styles appear as bulleted text in the slides.

After working on the set of slides, you may want to rearrange the slides. To
rearrange slides in a different order, choose View=Slide Sorter. Impress dis-
plays an array of miniature-sized slides, arranged in a rectangular grid in the
work area (as in Figure 13-7). Think of this as the slide sorter view because
you can move the slides around and sort them in this view.
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In the slide sorter view shown in Figure 13-7, you can drag and drop slides
into different positions and rearrange them in the order you want. To delete a
slide in this view, click the slide to select it and press Delete (or choose
Edit=>Delete). When prompted to confirm the deletion, you can click Yes if
you really want to delete the slide. Double-click a slide to return to the usual
single-slide view.

As you work on the presentation, keep in mind these concepts:

1 Master slide: You can think of the master slide as the background of
every slide. If you put text or other fields (such as date and page
number) on the master slide, those elements appear on every slide in
the presentation.

v Master notes: The idea is the same as that for the master slide. You can
define some fields and text on the master notes; these become part of
the background for your notes. The notes refer to the explanatory text
you add to the bottom of each slide.

Well, I could go on and on, but you can discover its capabilities best by
simply starting to use Impress.

Adding graphics and special effects

To jazz up your presentation, you might want to add graphics, charts, and
other special effects to the slides. With Impress, you can do nearly every-
thing you can think of — all you have to decide is how many bells and whis-
tles your presentation needs. It’s your call, but I recommend using these
features judiciously lest they detract from your presentation’s main message.

If you want to add some simple drawings to the slide, you can pick from the
drawing tools on the drawing toolbar on the bottom of the Impress window
(refer to Figure 13-4) and start drawing on the slide. To insert an image into
the slide, choose Insert=>Graphics and then select the image file you want to
insert.

You can also insert charts to graphically depict data. You start by inserting a
chart with dummy data, and then you edit the data as well as other features
of the chart. To add a chart and edit the data, follow these steps:

1. Choose Insert~>Chart.
A chart with the default chart type and dummy data appears.
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2. Resize the chart by dragging the handles around the border of the
chart; then right-click the chart and select Chart Data from the pop-up
menu that appears (see Figure 13-8).

A mini-spreadsheet appears with the dummy chart data.
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3. Edit the row and column labels and enter the data you want the chart
to display.

4. When you’re done editing the chart, click the green checkmark over a
small chart icon, located to the right of the toolbar, to apply the
changes. Then click the check box in the upper-right corner to close
the Chart Data window.

5. To change the chart type, right-click the chart and select Chart Type
from the pop-up menu that appears; choose a new type and click OK.

You can do a lot more than just add graphics and charts to your slide presenta-
tions. You can insert spreadsheets and Writer documents into a slide, add text
that runs along a curve, and add special effects to various elements in a slide.
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Delivering presentations

After you prepare a spectacular set of slides, you have to deliver it to your
audience. This typically involves tasks such as preparing speaker’s notes,
running a slide show, converting the presentation into HTML for delivery via
the Web, and printing handouts.

You can also print an Impress presentation directly to an Adobe Portable
Document Format (.pdf) file. This feature makes it easy to electronically
share a presentation with everyone because anyone can easily view and print
.pdf files by using the free Adobe Reader.



Chapter 14
Playing Music and Burning CDs

In This Chapter
Playing audio CDs

Playing digital music
Burning CDs and DVDs

SUSE Linux comes with several audio and video applications. You can

listen to audio CDs, MP3 music (as well as other digital music files), and
watch MPEG video (provided you have the decoders installed). You can also
rip audio CDs and burn new CDs — both audio and data CDs. In this chapter,

[ introduce some of the audio applications that you can find in either KDE or
GNOME desktops.

“‘gN\BEI? The video applications lack the decoders necessary to play video such as
& MPEG or DVD. In particular, commercial DVDs use an encryption method
called Content Scrambling System (CSS) to prevent the DVD data from being
copied. The open source Linux video players do not include the software to
decrypt CSS and therefore cannot play DVDs. Open source SUSE Linux also
does not include the MP3 decoders needed to play MP3 music files. You can,
however, use YaST to download the MP3 decoders from an online repository.

Playing Audio CDs

SUSE Linux comes with both the GNOME or KDE CD player applications. To
play an audio CD, you need a sound card, and that sound card must be con-
figured to work in SUSE Linux. All of that should happen when you install
SUSE Linux following the steps outlined in Chapter 2.

In KDE, if you insert an audio CD into the drive, a dialog box appears (see
Figure 14-1) and asks whether you want to play the CD with the CD player.
Click Yes.
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The KDE CD Player (KsCD) starts and displays the title of the CD and the
name of the current track. The CD Player gets the song titles from http://
freedb. freedb.org — a free, open source CD database on the Internet.
You need an active Internet connection for the CD Player to download song
information from the CD database. After the CD Player downloads informa-
tion about a particular CD, it caches that information in a local database for
future use. The CD Player user interface is intuitive, and you can figure it out
easily. One nice feature is that you can select a track by title. Figure 14-2
shows the KDE CD Player (KsCD) playing a track from an audio CD. To select
a track by title, click the track title at the top edge of the KDE CD Player.
Then select the track from the drop-down list that appears.
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Playing audio CDs is simple in GNOME as well. Insert the audio CD into the
drive, and the GNOME CD Player should start automatically. If it does not,
choose Main Menu=>Multimedia=>CD Player=>CD Player. Click the Play/Pause
button in the toolbar along the bottom (see Figure 14-3) and you should be
off and running. Figure 14-3 shows the GNOME CD player in action. As with
the KDE CD Player, you can click the track title for a drop-down list of all the
tracks and select one that you want to play.
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Playing Music Files

Typically, digital music files are stored in MP3 format, and the filenames have
an .mp3 extension. Both KDE and GNOME desktops include several applica-
tions for playing digital music.

The music players can also play digital music in other formats besides MP3
such as Ogg Vorbis, FLAC (Free Lossless Audio Codec, an audio file format that
is similar to MP3), and Windows WAV. Unfortunately, the versions of music
players included with SUSE Linux on the companion DVD do not include the
MP3 decoders. If you want to play MP3 music files, you have to install the MP3
decoders from an online repository such as packman. To perform that task,
follow the steps outlined in the “Adding a Software Source to YaST” section in
Chapter 18 to add packman as a software source in YaST. After that, you can
install the MP3 support by following these steps:

1. Select Main Menu=System=Control Center (YaST).

If you are not logged in as root, YaST prompts you for the root pass-
word, and then the YaST Control Center starts.

2. Click Software on the left side and then click Software Management
on the right.

The YaST package manager window appears.
3. Type mad in the Search box and click Search.

The packages with mad in the package name appear in the search results
on the right side.

4. Select the mad, kdemultimedia3-mad, and kdemultimedia3-arts-mad
packages. Then click Accept.

YaST downloads and installs the packages.

Now you should be able to play MP3 music files in the music players.
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In KDE, you can use amaroK to play music. To start amaroK, choose Main
Menur>Multimediac>Audio Player in KDE. You can create a playlist in amaroK
by searching music files on your hard drive. To play music, you can double-
click a music file in the playlist.

Burning a CD/DVD

|
Figure 14-4:
You can
burn CDs
and DVDs
with the K3b
application.
|

Nowadays, GUI file managers often have the capability to burn CDs. For
example, GNOME'’s Nautilus File Manager has built-in features to burn CDs.
The KDE desktop comes with K3b, which is a popular CD/DVD burning
application.

Most CD burning applications are simple to use. You basically gather up
the files that you want to burn to the CD or DVD and then start the burning
process. Of course, for this to work, your PC must have a CD or DVD burner
installed.

Burning CD/DVDs with K3b

Figure 14-4 shows the initial window of the K3b CD/DVD burning application in
SUSE Linux. The upper part of the K3b window is for browsing the file system
to select what you want to burn onto a CD or DVD. The upper-left corner
shows the CD writer device installed; in this example, it’'s a CD-RW/DVD drive
so that the drive can read DVDs and CDs, but burn CDs only.
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To burn a CD or DVD using K3b, you follow these high-level steps:

1. Start K3b by choosing Main Menu>Multimedia=>CD/DVD Burning.

2. Start a new project by clicking one of the project icons shown in the
lower part of the K3b window — New Audio CD Project, for example, or
New Data DVD Project.

3. Add files to the project. For an audio CD, you can drag and drop MP3
files as well as audio tracks.

4. Burn the project to the CD or DVD by choosing Project=>Burn or press-
ing Ctrl+B (or by clicking the Burn button in the project pane of the K3b
window). Doing so opens a dialog box in which you can set some more
options and click Burn to start burning the CD or DVD.

As a specific example, here is how you can burn an audio CD using K3b:

1. Click the New Audio CD Project icon on the lower pane of the K3b
window — that’s the project pane of K3b.

A project tab appears in the lower pane of the K3b window, and a mes-
sage tells you to drag and drop files and then click the Burn button (the
leftmost button on the project toolbar located near the middle of the
window, as you can see in Figure 14-5).

2. If you want to copy tracks from an audio CD, put the CD in the drive
and select the CD drive from the drop-down list on the toolbar (see
Figure 14-5).

K3b displays the titles of the tracks from the audio CD.
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Figure 14-6:
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3. Select the tracks you want and click the Start Ripping button —

the leftmost button on the toolbar above the list of tracks (see
Figure 14-5).

K3b then displays a CD Ripping dialog box.

4. Click Start Ripping in the CD Ripping dialog box. When finished, click

Close and eject the audio CD.

K3b extracts the tracks into separate files and stores them in a folder in
your home directory. The folder name is based on the title of the audio
CD album.

5. Click the Home folder on the top-left pane and click the folder with

the ripped audio files (look for the audio CD album’s name). Select the
files (they appear in the top-right pane) and drag and drop them in the
lower pane.

. Repeat Steps 2 through 5 with other audio CD tracks. To add MP3
files, go to the folder with the MP3 files and drag and drop them in
the lower pane of K3b.

Figure 14-6 shows a typical audio CD project with two ripped tracks and
an MP3 file.

. When you are ready to burn the audio CD, insert a blank CD-R into
the CD burner and click the Burn button.

K3b displays the Audio Project dialog box.
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8. Click Burn in the Audio Project dialog box.

K3b displays the Audio Project dialog box, in which you can set further
options for the CD and then click Burn to start burning the audio CD.
When everything is done, click Close to dismiss th